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A COSA SERVE ADOBE PHOTOSHOP LIGHTROOM?
Domanda legittima visto che Adobe Photoshop consente di fare “qualsiasi cosa”.

Negli ultimi anni, con il diffondersi 

delle fotocamere digitali, il mondo della 

fotografia ha vissuto un cambiamento 

epocale, una rivoluzione che non si è 

fermata alla semplice sostituzione del-

l’attrezzatura, ma, come tutte le rivolu-

zioni che si rispettino, ha trasformato nel 

profondo l’intero sistema fotografico, dal 

modo di scattare al modo di gestire le 

immagini, dalla vendita delle foto alla 

loro fruizione. In pratica oggi i fotografi 

continuano a fare i fotografi, ma den-

tro e fuori di loro tutto è cambiato. 

Ecco perché, tra le tante novità, si è 

anche affermata la tendenza da parte di 

diverse software house a sviluppare 

programmi dedicati ai fotografi. Tutta-

via viene legittimo chiedersi a cosa pos-

sano servire altri software dal momento 

che con Photoshop si può fare pratica-

mente “qualsiasi cosa”. Bene, la risposta 

a questa domanda va ricercata non tan-

to nella semplice diffusione delle foto-

camere digitali, quanto piuttosto nelle 

conseguenze che la diffusione delle 

fotocamere digitali ha portato con sé, 

soprattutto per quanto riguarda il meto-

do e il flusso di lavoro. Tra i tanti aspetti 

coinvolti in questa rivoluzione basta fo-

calizzarsi su uno soltanto: l’eliminazione 

del rullino. Innanzitutto ha indotto i foto-

grafi a realizzare molti più scatti: lad-

dove prima si facevano 2 o 3 foto, oggi 

se ne scattano almeno 10. In secondo 

luogo, la consapevolezza da parte del 

mercato dell’annullamento dei tempi di 

sviluppo ha imposto tempi di consegna 

sempre più serrati: ora i clienti si aspet-

tano di vedere e avere le immagini subi-

to o quasi. In sintesi il fotografo di oggi 

si ritrova a gestire almeno il triplo del-

le foto rispetto a prima, pur disponen-

do di molto meno tempo… e in più 

deve anche occuparsi della  post-produ-

zione, elaborando le immagini digital-

mente!

Con Photoshop Lightroom non si è 

di fronte ad un “Adobe Photoshop killer”, 

come qualcuno ha sospettato in prima 

istanza, quanto piuttosto ad un software 

bene integrato con il fratello maggiore e 

che tuttavia nasce per svolgere un ruolo 

complementare rispetto a esso. Se in-

fatti Photoshop è un software dedicato 

all’image editing, e cioè al fotoritocco, 

con Photoshop Lightroom si è di fronte a 

un prodotto pensato per il photo edi-

ting, che non è la stessa cosa. Il mestie-

re del photo editor esiste infatti da ben 

prima della diffusione della fotografia 

digitale ed è il lavoro di chi, ad esempio, 

all’interno di una redazione si occupa di 

esaminare grandi quantità di immagini 

che arrivano quotidianamente, per poi 

selezionare quelle più adatte ai vari sco-

pi.

Oggi la fase di photo editing è parte 

integrante del flusso di lavoro di ogni 

fotografo, il quale realizza spesso centi-

naia di immagini e in post-produzione si 

ritrova a doverle confrontare, seleziona-

re, gestire e archiviare ancora prima di 

doverle ritoccare, quando necessario, 

con appositi software.

Photoshop Lightroom non serve 

dunque a fare fotoritocco (questo lo fa 

già egregiamente Photoshop) ma ha lo 

scopo di fornire ai fotografi uno strumen-

to completo per la gestione  veloce del 

flusso di lavoro, consentendo, attraverso 

un’omogenea interfaccia a pieno scher-

mo, lo svolgimento di tutte le quotidiane 

operazioni dedicate alla selezione, ar-

chiviazione, correzione, ottimizzazione, 

condivisione, stampa  e pubblicazione 

sul web.

Si tratta in pratica di un’autentica 

“camera chiara” dove eseguire tutto 

quello che serve prima ancora di do-

ver aprire Photoshop.
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Breve Storia di un grande 

progetto collettivo: 

da Shadowland a Adobe 

Photoshop Lightroom 1.2

I l software Adobe Photoshop Li-

ghtroom rappresenta l’atteso risultato 

finale di un progetto nato intorno alla 

metà del 2002 per volontà di Mark 

Hamburg, il quale già allora, analizzan-

do le grandi trasformazioni che il modo 

della fotografia stava vivendo, si era reso 

conto che stava nascendo sempre più 

forte tra i fotografi la necessità di un 

software che consentisse di gestire ve-

locemente grandi quantità di immagini. 

Per questa ragione lo scopo primario 

che il team di sviluppo di Photoshop 

Lightroom si è posto nel progettare il 

software è stato quello di semplificare 

la complessità del flusso di lavoro 

fotografico professionale rendendolo il 

più possibile pratico, fluido, facile, flessi-

bile e veloce.

Fino al 10 gennaio del 2006, giorno 

in cui è avvenuto il lancio pubblico della 

versione Beta del software, questo pro-

getto è stato sviluppato con il nome in 

codice di Shadowland.

Insieme a Mark Hamburg, a questo 

progetto hanno collaborato nel tempo 

grandi nomi del digital imaging: Thomas 

Knoll, Andrei Herasimchuk, Sandy Alves, 

Jeff Schewe, Troy, Melissa Gaul, George 

Jardine, Katrin Eismann, Bruce Fraser, 

Seth Resnik, Martin Evening. Inoltre  

diversi milioni di fotografi da ogni par-

te del mondo, dopo il lancio della Beta 

pubblica, hanno potuto prendere parte a 

questo progetto in qualità di beta tester, 

scaricando e utilizzando gratuitamente 

la versione non ancora terminata del 

software per provarla e fornire feedback 

su tutte le possibili implementazioni. 

E’ proprio sulla base delle specifi-

che richieste da un numero così signifi-

cativo di fotografi che la Adobe ha dato 

alla luce, il 19 febbraio 2007, ad  Pho-

toshop Lightroom 1.0: un software, per 

la prima volta, davvero - ed esclusiva-

mente - “fotografico”.

A giugno 2007 è uscito un prezioso 

aggiornamento gratuito, con significative 
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implementazioni che hanno determinato 

un rilevante miglioramento nelle perfor-

mance, l’inserimento di molte nuove 

funzioni, una totale integrazione con la 

Adobe Creative Suite 3, un cambiamento 

significativo nella gestione della libreria e 

del database. A settembre 2007 è uscito 

l’aggiornamento alla versione 1.2 che ha 

principalmente potenziato le performan-

ce in relazione alla scrittura dei dati XMP.

A chi si rivolge questa Guida

Questa Guida non intende essere 
esaustiva, ma ha lo scopo princi-
pale di offrire ai fotografi profes-
sionisti una panoramica su 
Adobe Photoshop Lightroom 
1.2 utile sia per coloro che non 
hanno mai provato ad utilizzare 
questo software sia per coloro 
che, già da qualche tempo, lo 
hanno scelto come elemento es-
senziale del proprio flusso di la-
voro quotidiano.

In questa Guida alcune informa-
zioni ricorrono volutamente in 
modo ridondante risultando 
utili sia a coloro che la leggeran-
no integralmente, sia anche e 
soprattutto a tutti coloro che, 
sommersi dal lavoro, avranno a 
malapena il tempo di consultarla 
velocemente, attraverso le im-
magini e i titoli principali, alla 
ricerca della soluzione immediata 
al loro problema.
Un altro scopo di questa guida è 
anche quello di fornire spunti 
stimolanti per sfruttare al meglio 
le potenzialità di questo straordi-
nario software.

Dal momento che Photoshop 
Lightroom 1.2 non è disponibile 
in lingua italiana, questa guida 
offre la traduzione della mag-
gior parte dei termini inglesi.

Per chiarire velocemente dubbi 
sulle funzioni del software o sui 
termini inglesi utilizzati è sufficien-
te digitare il nome della funzione, 
del messaggio di errore o della 
finestra di dialogo nella casella 
di ricerca di Adobe Acrobat.

A chi rivolgere ulteriori 
dubbi su Lightroom?

Per tutte le informazioni tecni-
che e commerciali consultare 
la pagina:
http://www.adobe.com/products/
photoshoplightroom/

Per ricevere assistenza tecnica 
consultare la pagina: 
www.adobe.com/go/support/

Per parlare direttamente con il 
servizio clienti ufficiale Adobe 
comporre il numero:
800 833 6687
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PUNTI DI FORZA: VELOCITA’ PRATICITA’ QUALITA’ LIBERTA’

Una velocità produt-
tiva del tutto nuova 
dovuta alla comodità 
di un’unica inter-
faccia full screen 
(a schermo pieno) 
che con sen t e d i 
gestire il flusso di 
lavoro fotografico in 
modo estremamente 
logico e fluido. 

La praticità di poter 
gestire diversi formati 
di f i le (RAW, JPG, 
TIFF, PSD, DNG) 
anche s imul tanea-
mente con i medesimi 
strumenti e cursori.

Una qualità di ela-
borazione dei file 
“garantita Adobe” 
e quindi analoga a 
quella di Adobe Pho-
toshop, ma con una 
marcia in più data 
da l l ’edi t ing non 
distruttivo. Grazie a 
questo i file originali 
non vengono ma i 
alterati e la versione 
modif icata occupa 
pochissima memoria 
su disco.

La libertà di un appli-
cativo che ha requisi-
ti minimi di sistema 
davvero bassi e che 
non fa alcuna discri-
minazione di piatta-
forma, offrendo con 
l’acquisto del software 
sia l’installer per Mac 
sia quello per Win-
dows. 

http://www.adobe.com/products/photoshoplightroom/
http://www.adobe.com/products/photoshoplightroom/
http://www.adobe.com/products/photoshoplightroom/
http://www.adobe.com/products/photoshoplightroom/
http://www.adobe.com/go/support/
http://www.adobe.com/go/support/
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INTRODUZIONE ALL’USO DI LIGHTROOM
CARATTERISTICHE ESSENZIALI DEL FLUSSO DI LAVORO

Principali componenti dell’interfaccia:
1 - La  Barra dei Menu.
2 - Il  Nome dell’applicativo, accompagnato dal numero della versione 
di Photoshop Lightroom correntemente installata. Quest’area è inoltre 
destinata alla visualizzazione delle informazioni sullo stato del Progess.
3 - I pulsanti principali che dividono le competenze dell’applicativo in 5 
Moduli: una sorta di percorso sequenziale che scandisce il flusso di la-
voro fotografico attraverso un’autentica procedura guidata: dall’importa-
zione e archiviazione delle immagini alla loro elaborazione; dalla crea-
zione di presentazioni fino alla stampa e al web. Ad ogni Modulo sono 
associati specifici Pannelli e Barra dei menu.
4 - L’ Area del contenuto destinata all’anteprima dell’immagine o al 
gruppo di immagini selezionate.
5 - La  Barra degli Strumenti con i pulsanti per le diverse modalità di 
visualizzazione.
6 - I Pannelli dedicati al Modulo selezionato. A sinistra ci sono tutti i 
comandi, i Presets e i Templates che servono a velocizzare le operazioni 
di routine. A destra ci sono invece gli strumenti e le regolazioni che con-
sentono di intervenire sulle foto manualmente con il massimo controllo.
7 - Il  Filmstrip che visualizza l’intera sequenza di foto presenti nel grup-
po selezionato dalla Library. Il Filmstrip rimane sempre disponibile nel-
l’area inferiore dell’interfaccia con qualunque Modulo selezionato.
8 - La  Barra delle opzioni del Filmstrip che consente di filtrare le im-
magini, scorrerle una ad una con le due frecce o cambiare modalità di 
visualizzazione.

6 6

IN QUESTO CAPITOLO:

CONCETTI DI BASE 
• L’interfaccia
• Il flusso di lavoro attraverso i 5 Moduli
• La gestione multi-formato
• Il Catalog e l’editing non distruttivo
• Editing su un unico livello
• Salvataggio istantaneo
• Gestione del colore

REQUISITI MINIMI DI SISTEMA
• Come ottimizzare le performance di Pho-
toshop Lightroom
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Requisiti minimi di 

sistema

Requisiti minimi di sistema

I requisiti minimi sotto elencati 
forniscono buone performance su  
flussi di lavoro incentrati su im-
magini con risoluzione intorno ai 
5-6 Megapixel. Per file di gran-
dezza superiore è sicuramente 
consigliabile utilizzare computer 
più potenti dotati di più RAM.

MACINTOSH

Sistema operativo:
Mac OS X 10.4 o superiore.

Processore:
PowerPC G4, G5 con una veloci-
tà minima di 1 GHz, oppure pro-
cessore Intel.

Ram:
768 Megabyte (almeno 1 Giga-
byte consigliato).

Hard disk:
almeno 1 GB di spazio libero (si 
consiglia più spazio).

Risoluzione:
almeno 1024x768 (si consiglia 
una risoluzione superiore).

WINDOWS

Sistema operativo:
Microsoft Windows XP con Service 
Pack 2 (SP2) o Windows Vista 
Home Premium, Business, Ultima-
te o Enterprise Edition

Processore:
Intel Pentium 4 (o compatibile).

Ram:
768 MB (1 GB consigliato).

Hard disk:
almeno 1 GB di spazio libero (si 
consiglia più spazio).

Risoluzione:
almeno 1024x768 (si consiglia 
una risoluzione superiore).

Concetti di base per 

lavorare con Lightroom

I paragrafi che seguono sono un’in-

troduzione ad alcune delle caratteristi-

che più peculiari di questo software.

Alcuni di questi argomenti saranno 

poi meglio sviluppati nei successivi capi-

toli di approfondimento.

L’interfaccia come una 

procedura guidata

Adobe Photoshop Lightroom è con-

cepito in un’unica interfaccia che con-

sente di affrontare il flusso di lavoro 

fotografico in modo organico, intuitivo 

e sequenziale, senza interruzioni, come 

se si stesse seguendo una procedura 

guidata. 

Inoltre, l’interfaccia full screen (a 

pieno schermo), consente sempre una 

visualizzazione comoda e accurata delle 

immagini, vere protagoniste di questo 

software.

Per muoversi agilmente attraverso 

Photoshop Lightroom c’è un’unica sem-

plice regola da seguire: “leggere” e uti-

lizzare l’interfaccia muovendosi da sini-

stra verso destra e dall’alto verso il 

basso.

In alto a destra si trova il Module 

Picker dal quale si accede di volta in 

volta ad ognuno dei 5 Moduli disponibili: 

Library, Develop, Slideshow, Print e 

Web. 

Questi Moduli scandiscono il flusso 

di lavoro all’interno di Photoshop Li-

ghtroom in 5 fasi sequenziali e ben di-

stinte, accompagnando il fotografo at-

traverso l’intera post-produzione fotogra-

fica. Selezionando uno di questi 5 pul-

santi si accede alle funzioni specifiche di 

ogni Modulo, disponibili attraverso la 

Barra dei Menu posta in alto, i Pannelli 

laterali disposti in colonna sulla destra e 

sula sinistra dell’interfaccia, la Barra de-

gli Strumenti collocata in basso.

I Pannelli sono l’elemento più im-

portante dell’interfaccia perché offrono a 

portata di clic tutte le principali funziona-

lità specifiche di ogni Modulo. Nei Pan-

nelli di sinistra si trovano generalmente 

i comandi che aiutano ad impostare il 

proprio lavoro e a sgrossarlo veloce-

mente. I Pannelli di destra invece forni-

scono tutte le funzioni per intervenire 

sulle immagini in modo manuale ed ac-

curato, con il massimo controllo.

In generale, il ricorso alla Barra dei 

menu è limitato esclusivamente alle 

operazioni meno frequenti, perché l’in-

terfaccia è strutturata ampiamente intor-

no al concetto del drag & drop (fai clic e 

trascina).

In ogni Modulo è sempre disponibile 
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in basso il Filmstrip che mostra, come 

su un nastro di pellicola, le miniature del 

gruppo di immagini preso in considera-

zione, consentendo di monitorarle velo-

cemente passando dall’una all’altra sen-

za interrompere il flusso di lavoro.

Di Modulo in Modulo l’interfaccia 

mantiene sempre la stessa coerenza. 

Dal momento che Photoshop Lightroom 

presenta i comandi nell’ordine ideale in 

cui le regolazioni andrebbero eseguite, è 

in questo modo che si consigl ia di 

esplorarle ed utilizzarle. Per questa ra-

gione, diversamente da quanto avviene 

in Photoshop, la posizione dei Pannelli e 

degli altri elementi dell’interfaccia non è 

alterabile.

Inoltre è importante ricordare che  

l’interfaccia di Photoshop Lightroom 

si adatta automaticamente alle carat-

teristiche del nostro archivio, del tipo 

di file che si sta elaborando, dei file 

selezionati o del Modulo nel quale ci 

si trova. Per via di questa caratteristica 

alcune funzioni,  pulsanti o voci di menu 

vengono automaticamente nascoste o 

appaiono disattivate, in alcune condizio-

ni. Ad esempio, nel Modulo Library, la 

Barra dei Menu mostra il menu Metada-

ta, che scompare non appena si sele-

ziona un altro Modulo. Oppure, all’inter-

no del Modulo Develop, se è selezionata 

una sola immagine, in fondo ai Pannelli 

di destra compare il pulsante Previous, 

che si sostituisce automaticamente con 

il tasto  Sync non appena vengono sele-

zionate due o più immagini. E’ quindi 

importante ricordare che a causa di 

questa caratteristica, in questa Guida, 

potrebbero essere menzionati menu o 

funzioni temporaneamente non attivi a 

causa delle caratteristiche specifiche del 

proprio archivio e dei propri file.

Il flusso di lavoro attraverso i 5 

Moduli

Il flusso di lavoro in Photoshop Li-

ghtroom inizia sempre con l’importazio-

ne delle immagini nella Library del soft-

ware. Prosegue poi attraverso i 5 Moduli 

che guidano il fotografo attraverso i di-

versi step della post-produzione. Termi-

na infine con l’esportazione dei file che 

salva le immagini elaborate in uno speci-

fico formato adatto all’uso cui sono de-

stinate.

Nel primo Modulo, chiamato Libra-

ry, il fotografo può visualizzare le imma-

gini, organizzarle, selezionarle, confron-

tarle, catalogarle, archiviarle ed eseguire 

ricerche accurate.

Nel secondo Modulo Develop il 

fotografo può effettuare tutti i principali 

interventi di regolazione per ottimizzare 

l’aspetto delle proprie immagini (lumino-

sità, colore, nitidezza, ritaglio...).

I l te rzo Modulo , ch iamato Sl i-

deshow, serve a creare e personalizzare 

presentazioni animate con foto in dissol-

venza e sfondo musicale.

Dal Modulo Print  è possibile prepa-

rare le immagini per la stampa grazie a 

diverse opzioni per l’impaginazione e  la 

gestione del colore.

L’ultimo Modulo, Web, permette di 

realizzare velocemente accattivanti gal-

lerie fotografiche da pubblicare su Inter-

net.

Photoshop Lightroom supporta 
il secondo monitor?

Al momento il doppio monitor 
può essere utilizzato per visualiz-
zare lo slideshow su un monitor 
mentre si lavora sull’altro con 
Lightroom.
E’ anche possibile trascinare i 
Pannelli di destra sul secondo 
monitor, ma è di scarsa utilità 
data l’alta ottimizzazione dell’in-
terfaccia.

Nessuna discriminazione di 

formato di file

All’interno di Photoshop Lightroom 

tutte le funzioni disponibili possono es-

sere utilizzate indistintamente su imma-

gini in formato RAW, JPG, PSD o TIFF. 

Questo implica che anche regolazioni 

come il bilanciamento del bianco, legate 

per loro natura al formato RAW, possono 

essere applicate anche su file in formato 

JPG, PSD o TIFF, perfino simultanea-

mente! Naturalmente va tenuto conto 

che la risposta di un’immagine agli inter-

venti di post-produzione è strettamente 

correlata al formato con il quale è stata 

salvata e il RAW è l’unico formato a ga-

rantire il più alto livello qualitativo. Tutta-

via poter usare i medesimi comandi su 

file di formati diversi offre un’indubbia 

praticità che semplifica il flusso di lavoro 

accorciando sensibilmente i tempi pro-

duttivi. In questo modo la lavorazione 

delle immagini è davvero fluida e non 

viene mai interrotta dalla necessità di 

utilizzare diversi applicativi, plug-in o 

specifiche finestre di dialogo.

Il concetto di Catalog e l’editing 

non distruttivo

Una delle caratteristiche più peculia-

ri di Photoshop Lightroom è rappresen-

tata dal modo in cui vengono salvate le 

modifiche alle immagini.

In pratica all'interno del software le 

immagini originali e le modifiche ap-

plicate vengono sempre tenute sepa-

rate. In questo modo i file originali pos-

sono risiedere ovunque, anche su diver-

si supporti di memoria, mentre le corre-

zioni vengono salvate automaticamente, 

sotto forma di semplici istruzioni, all’in-

terno del database di Photoshop Li-

ghtroom chiamato Catalog.

Grazie a questo sistema qualunque 

intervento sulle foto è sempre rever-

sibile e l’editing non causa alcuna 

perdita progressiva dei dati dell’im-

magine perché non altera in alcun 

modo i file originali. 

Inoltre i cursori delle diverse regola-

zioni rimangono sempre esattamente 

come sono stati posizionati, anche dopo 

che il programma è stato chiuso e riav-

viato, permettendo di ritornare in qua-

lunque momento sui propri passi.

Editing su un unico livello

Adobe Photoshop Lightroom è pro-

gettato per svolgere tutte le principali 

regolazioni e modifiche alle immagini in 

un non-layered editing (modifica su un 

unico livello). Per questa ragione non 

consente di elaborare le immagini su 
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livelli né su singoli canali né di utiliz-

zare maschere, selezioni o filtri. Se si 

importa quindi un file in formato PSD o 

TIFF a livelli Photoshop Lightroom lo 

gestisce come se fosse ad un unico 

livello.

Salvataggio istantaneo

Come tutti i software che sfruttano la 

logica del Catalog (generalmente chia-

mato Libreria) anche Photoshop Li-

ghtroom salva in modo immediato qua-

lunque modifica venga eseguita sui file. 

Questo significa che non occorre mai 

preoccuparsi di salvare il proprio lavoro, 

provvede lui a farlo automaticamente. 

Qualora avvenga un’interruzione di cor-

rente tale da spegnere improvvisamente 

il computer tutte le modifiche risultereb-

bero salvate fino all’ultima.

Gestione del colore

Avere cura della gestione del colore 

durante ogni processo di creazione, 

lavorazione o stampa delle proprie im-

magini è essenziale per ottenere una 

soddisfacente coerenza cromatica tra le 

diverse periferiche (fotocamera, monitor, 

stampante, ecc).

Innanzitutto, per osservare corret-

tamente i colori delle immagini ed evita-

re che appaiano incongruenze tra la 

visualizzazione a monitor e la stampa è 

indispensabile util izzare monitor di 

buona qualità accuratamente calibrati. 

In secondo luogo occorre tenere pre-

sente che un’immagine digitale do-

vrebbe sempre incorporare un profilo 

colore. In questa sede non approfondi-

remo questo argomento, che richiede-

rebbe semmai una Guida dedicata, ma 

si invita ad approfondirlo attraverso vali-

de fonti di studio quali il manuale utente 

di Photoshop e lo splendido sito di uno 

dei massimi esperti sull’argomento, 

Mauro Boscarol, www.boscarol.com.

In generale la gestione del colore 

non è né qualcosa di costoso, né di par-

ticolarmente difficile, tuttavia le proble-

matiche e la teoria ad essa legate sono 

complesse e a volte scarsamente appro-

fondite da chi opera nel settore delle 

immagini.

Fortunatamente in Photoshop Li-

ghtroom si è trovato il modo di semplifi-

care la gestione del colore automatiz-

zando, con buon senso, la maggior par-

te delle scelte “critiche” normalmente 

delegate all’utente. In linea di massima il 

grande vantaggio di questo approccio 

deriva dal fatto che il fotografo deve 

preoccuparsi della gestione del colore e 

scegliere le impostazioni che preferisce 

solo quando le foto sono pronte per 

l’output. Il fattore più rassicurante risiede 

nel fatto che, all’interno di Photoshop 

Lightroom, è molto difficile compiere 

errori legati alla gestione del colore, 

perché è il software stesso a guidare 

l’utente verso le scelte più adatte o ad 

automatizzare le scelte più opportune.

In generale non occorre preoccu-

parsi delle impostazioni colore fino a 

quando non si esportano i file.

In generale, occorre tenere presente 

che Adobe Photoshop Lightroom impor-

ta tutte le immagini in RGB, in Scala di 

Grigio, o in Metodo LAB sia a 8 bit sia 

a 16 bit, ma è fondamentale ricordare 

che le gestisce sempre e comunque 

come immagini in RGB. Alcune impor-

tanti eccezioni legate a tipi di immagini 

non compatibili, come ad esempio i file 

in CMYK, sono trattate nel capitolo se-

guente.

Le anteprime delle immagini ven-

gono conservate nel database nel soft-

ware nello spazio colore Adobe RGB 

1998, a prescindere dal formato dei file 

originali e dal profilo colore in essi in-

corporato. Questo è quindi lo spazio 

utilizzato di default quando si stampa in 

draft mode printing dal Modulo Print.

I file in formato TIFFF, .JPEG, e i 

PSD) vengono visualizzati all’interno di 

Photoshop Lightroom nel profilo colore 

incorporato. Anche l’istogramma e i va-

lori cromatici si fondano su questo profi-

lo. Se l’immagine non ha un profilo in-

corporato Photoshop Lightroom assegna 

automaticamente il profilo sRGB e i colo-

ri delle immagini potrebbero assumere 

un aspetto diverso.

Per tutti i file in formato RAW il 

Modulo Develop utilizza uno spazio co-

lore molto ampio basato sui valori cro-

matici dello spazio colore ProPhoto 

RGB. Questo spazio offre il vantaggio di 

incorporare la maggior parte dei colori 

che i sensori delle fotocamere sono in 

grado di catturare, evitando eventuali 

perdite di sfumature.

Nei Moduli Slideshow e Web viene 

automaticamente assegnato alle imma-

gini il profilo sRGB in modo che i colori 

delle foto possano avere un buon aspet-

to sulla maggior parte dei monitor.

Nel Modulo Print invece è possibile 

convertire i colori delle immagini attra-

verso funzioni dedicate alla gestione del 

colore.

Durante l’esportaizione dei file trami-

te il comando Export si può scegliere di 

convertire le immagini in AdobeRGB 

(1998), in sRGB o in ProPhoto RGB.

Quando si utilizza il comando dal 

menu Photo > Edit in per esportare le 

immagini da Photoshop Lightroom diret-

tamente in Photoshop o in un altro soft-

ware, lo spazio colore può essere modi-

ficato dal menu Preferences > External 

Editing.

Dove si trova il menu Prefe-
rences di Lightroom?

Su Windows menu Edit > Prefe-
rences.
Su Macintosh menu Adobe Adobe 
Photoshop Lightroom > Preferen-
ces.
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Come ottimizzare le 

performance di 

Photoshop Lightroom

Diversi fattori influiscono sulla velo-

cità di un programma. 

Quelli che seguono sono alcuni 

suggerimenti per ottimizzare al massimo 

le performance di Photoshop Lightroom.

Requisiti del computer

I requisiti minimi di sistema di Pho-

toshop Lightroom offrono prestazioni 

soddisfacenti in flussi di lavoro con im-

magini di massimo 5-6 Megapixel.

Per ottimizzare le performance del 

software si consigliano dunque un pro-

cessore più potente e un espansione 

RAM ad almeno 2 GB.

Va inoltre tenuto conto che in molte 

circostanze, Photoshop Lightroom può 

essere installato anche su computer con 

requisiti inferiori ai minimi richiesti, tutta-

via ciò può determinare significativi e 

rischiosi malfunzionamenti. Pertanto è 

sempre opportuno verificare la propria 

configurazione ed attenersi a quanto 

indicato dalla Adobe.

Localizzazione dei Catalogs

In generale si ottengono maggiori 

performance spostando i Catalogs e gli 

altri file contenuti nella cartella Lightroom 

(localizzata di default all’interno della 

cartella Immagini) su un hard disk di-

verso da quello di sistema, sia esso 

interno al computer oppure collegato 

esternamente, preferibilmente in Firewire 

800.

Importazione

Il processo di importazione risulta 

molto più veloce utilizzando l’opzione 

Import photos at their current location. 

Pertanto se le immagini non sono anco-

ra state trasferite nella loro posizione 

definitiva e ad esempio, risiedono anco-

ra nella memory card, è preferibile che 

vengano trasferite sul computer e poi 

importate all’interno di Adobe Photos-

hop Lightroom.

Visualizzazione delle anteprime

Per velocizzare la visualizzazione 

delle anteprime all’interno di Adobe Pho-

toshop Lightroom è opportuno attivare 

l’opzione Render standard-sized pre-

views nella finestra di dialogo Import. Se 

le immagini sono già state importate non 

utilizzando questa opzione è possibile 

renderizzare tali anteprime attraverso il 

comando dal menu Library > Previews 

> Render standard-sized previews.

Visualizzazione dell’immagine al 

100%

Per velocizzare al massimo la visua-

lizzazione delle immagini al 100% (ridu-

cendo il tempo di persistenza del mes-

saggio Working) è opportuno:

- renderizzare tutte le anteprime 1:1 

selezionando le immagini e utilizzando il 

comando del menu  Library > Previews 

> Render 1:1 Previews.

- conservare in memoria l’anteprima 

1:1 per la durata media del tempo di 

consegna dei propri lavori fotografici. 

Tale impostazione può essere modificata 

dal menu File > Catalog Settings > File 

Handling > Automatically Discard 1:1 

Previews: After One Day / After One 

Week / After 30 Days / Never. Grazie a 

questa funzione si può quindi scegliere 

se conservare in memoria le anteprime 

1:1 per un giorno, una settimana, 30 

giorni o di conservarle per sempre.

Scrittura automatica dei dati 

XMP

Per incrementare le performance del 

programma disattivare dal menu: File > 

Catalog Settings > Metadata > Auto-

matically write changes into XMP ed 

eseguire semmai l’esportazione dei dati 

XMP manualmente, solo quando neces-

sario. Questo argomento sarà meglio 

approfondito nel prossimo capitolo.

Stampa in Draft Mode

In fase di stampa si può velocizzare 

il render delle immagini attivando l’op-

zione Draft Mode Printing nel pannello 

Print Job. Tuttavia è bene tenere conto 

che questa opzione non consente di 

gestire il colore, e quindi utilizza lo spa-

zio AdobeRGB (1998) automaticamente 

incorporato nelle anteprime, per cui se 

ne consiglia l’uso solo per stampe di 

scarso valore, come ad esempio i provi-

ni.

Antivirus

Al pari di altri software che compio-

no attività costante sui dischi, le perfor-

mance di Photoshop Lightroom potreb-

bero decadere con alcuni programmi 

antivirus.
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LA LOGICA DEI CATALOGS
LA GESTIONE DEI FILE ATTRAVERSO L’IMPORTAZIONE E L’ESPORTAZIONE

La logica dei Catalogs di Photoshop Lightroom si fonda sul concetto di 
Libreria, già utilizzato da tempo in diverse applicazioni, e offre una con-
sistente serie di vantaggi. 

In sostanza, grazie ai Catalogs, qualunque intervento si esegue sulle 
immagini non modifica mai i file originali, che rimangono inalterati. Le 
modifiche vengono invece registrate sotto forma di istruzioni in un data-
base SQLite, opensource. 

Questo database è localizzato di default nella cartella Immagini > Li-
ghtroom ma può essere spostato (o creato ex novo) in una qualunque 
posizione all’interno dell’hard disk interno o di un supporto di memoria 
esterno (ad esclusione dei server).

Ogni modifica viene quindi realmente applicata al file solo quando si 
effettua l’esportazione delle immagini che, costituendo una sorta di Salva 
con Nome avanzato, crea una nuova copia dei file nel formato prescelto.

IN QUESTO CAPITOLO:

PRO E CONTRO LEGATI AI CATALOGS 

FILE COMPATIBILI CON LIGHTROOM
• File compatibili con la versione 1.2
• File non compatibili con la versione 1.2

IMPORTARE LE IMMAGINI 
• Il comando Import
• Importazione di nuove immagini in un 
Folder
• Importazione dalla fotocamera 
in fase di scatto
• Importazione da Photoshop Elements

ESPORTARE LE IMMAGINI 
• Il comando Export
• Esportare il solo codice XMP
• Esportare un Catalog
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Pro e contro del 

sistema dei Catalogs

Il principale lato negativo causato 

dal sistema dei Catalogs è l’attesa per 

l’inevitabile importazione delle immagini 

che si esegue ogni volta che un nuovo 

gruppo di file deve essere visualizzato e 

elaborato con Photoshop Lightroom.

Fortunatamente però, i vantaggi che 

derivano da questo nuovo approccio 

all’archiviazione e alla post-produzione 

fotografica ripagano ampiamente il tem-

po di attesa dedicato a questa operazio-

ne.

Uno dei vantaggi più rilevanti cui si è 

già accennato consiste nell’editing non 

distruttivo. In pratica gli interventi ese-

guiti sui file all’interno di Photoshop Li-

ghtroom non vanno mai ad alterare le 

immagini originali, ma vengono memo-

rizzati nel database chiamato Catalog. 

Questo aspetto è essenziale sia per la 

qualità del risultato sia per la modularità 

e reversibilità delle proprie regolazioni. 

Photoshop Lightroom, infatti, consente di 

effettuare infinite correzioni all’immagine 

che vengono applicate, in un unico pas-

saggio e in modo irreversibile, soltanto 

in fase di esportazione, con la creazione 

di una copia dell'originale.

Tutte le operazioni eseguite all’inter-

no di Photoshop Lightroom vengono 

memorizzate nel database del pro-

gramma in modo automatico. Questo 

significa che non occorre mai salvare il 

file. Tra l’altro, anche a seguito di una 

chiusura inaspettata del sistema operati-

vo o di una interruzione di corrente, tutte 

le correzioni svolte vengono memorizza-

te nel database fino all’ultima operazio-

ne.

A fronte di questo è però importante 

tenere conto che, come ogni tipo di file, 

anche i l database di Photoshop Li-

ghtroom potrebbe danneggiarsi. E’ per 

questo che è sicuramente saggio ese-

guire con regolarità backup del databa-

se, come consigliato dalla finestra di 

dialogo che compare periodicamente 

all’avvio del software.

Sempre grazie alla logica dei Cata-

logs, non si corre mai il rischio di so-

vrascrivere o danneggiare i file origi-

nali, avendo la possibilità di creare mol-
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Cosa implica la conversione delle Library di Photoshop Lightroom 1.0 ai 
Catalogs della versione 1.1 o 1.2?

Fino alla versione 1.0 di Photoshop Lightroom il termine Library non faceva rife-
rimento solo al Modulo omonimo, ma anche al database nel quale questo soft-
ware memorizzava tutti gli interventi sulle immagini. 
L'aggiornamento di Photoshop Lightroom alla versione 1.1 (o successive) conver-
te le Libraries (.Irdb) in Catalogs (.Ircat). Prima della conversione è necessario 
tenere presente che i Catalogs di Adobe Photoshop Lightroom 1.1 o 1.2 non 
possono più essere aperti con la versione 1.0.

Perché l’editing in Adobe Photoshop è distruttivo e come si può evitare?

Tutti i programmi che, come Photoshop, lavorano con immagini digitali costi-
tuite da pixel, utilizzano generalmente un approccio cosiddetto distruttivo. 
Ogni regolazione, infatti, modifica in modo permanente i pixel stessi 
del file che, perdendo alcune informazioni, causano un degrado progressivo 
e irreversibile alla qualità dell’immagine; questo si traduce in genere in una 
perdita di dettagli, nitidezza, sfumature...
In Adobe Photoshop, quando si interviene sul livello stesso dell’immagine, le 
modifiche possono essere annullate solo tornando indietro nel Pannello Storia. 
Non appena l’immagine viene salvata e chiusa qualunque intervento diventa 
permanente e l’immagine perde definitivamente alcune delle sue caratteristi-
che originali. 
Per ovviare a questo problema, già dalle precedenti versioni di Photoshop sono 
state sviluppate funzioni atte a separare i pixel dalle modifiche loro applicate.
Alcune di queste funzioni sono: le regolazioni di livello, le maschere, gli 
oggetti avanzati, i nuovi filtri avanzati di Adobe Photoshop CS3...

Quali operazioni di Photoshop Lightroom intervengono direttamente sui 
file originali?

E’ importante tenere presente che le operazioni segnalate di seguito intervengo-
no direttamente sui file originali.

Folders
Se si sposta un Folder o si spostano uno o più file in esso contenuti tali modifiche 
vengono fisicamente eseguite anche sulle cartelle all’interno dell’hard disk.

Renaming
Se attraverso Photoshop Lightroom si modifica il nome delle immagini o dei Fol-
ders che le contengono, vengono fisicamente rinominati anche i file e le cartelle 
originali.

Edit in Adobe Photoshop
Se si aprono i file da Photoshop Lightroom direttamente in Photoshop utilizzando 
l’opzione Photo > Edit in Adobe Photoshop > Edit Original disponibile per il 
comando dal menu Photo > Edit in Adobe Photoshop il JPG dell’immagine ori-
ginale viene sovrascritto;

XMP
I dati XMP vengono scritti direttamente sui metadati dell’immagine in tutti i file 
che non sono in formato RAW. Quindi in tutti i file DNG, TIF, JPG, PSD.

Delete from Disk
Quando si cancella un file da Photoshop Lightroom scegliendo l’opzione Delete i 
file originali vengono fisicamente cancellati e quindi spostati nel cestino del com-
puter.
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teplici versioni della stessa immagine 

senza gravare sull’hard disk (come ad 

esempio attraverso le Virtual Copies). In 

pratica le correzioni e le diverse versioni 

vengono memorizzate nel Catalog e, per 

quanto lunghe ed elaborate possano 

essere, occupano solo pochi kilobyte: 

un peso minimo se paragonato al salva-

taggio di un’intera immagine.

Inoltre, sempre grazie ai Catalogs, è 

stato finalmente possibile realizzare con 

Adobe Photoshop Lightroom un deside-

rio comune a molti utenti di Adobe Pho-

toshop: la possibilità di conservare nel 

Pannello History un registro virtualmen-

te illimitato ed eterno di tutte le opera-

zioni svolte sull’immagine. La Storia di 

Photoshop Lightroom, infatti, non solo è 

in grado di “ricordare” un numero vir-

tualmente illimitato di stadi, ma li con-

serva “per sempre” in memoria, perfino 

dopo che l’applicativo è stato chiuso. Lo 

stesso vale anche per gli Snapshots 

(istantanee).

Infine, il database di Photoshop Li-

ghtroom tiene in memoria le anteprime 

di tutte le immagini importate nel tem-

po (che possono comunque essere ri-

mosse manualmente) consentendo di 

visualizzarle anche se sono fisicamen-

te archiviate in un supporto di memo-

ria momentaneamente non disponibile 

(come ad esempio hard disk esterni o 

DVD) e perfino se le immagini originali 

sono state cancellate o sono andate 

perse. E’ proprio grazie a questa caratte-

ristica che Photoshop Lightroom è in 

grado di generare anteprime di stampa 

di migliaia di immagini praticamente in 

tempo reale.
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Quando e perché eseguire il backup?

Il backup è la procedura che si esegue per creare una copia di riserva nel 
caso in cui i dati originali si danneggino, vadano persi o vengano accidental-
mente cancellati.
Dal momento che qualunque tipo di file o supporto di memoria può danneg-
giarsi è di fondamentale importanza eseguire regolarmente dei Backup. 
In Photoshop Lightroom questa operazione può essere svolta in diversi modi.

Backup delle immagini
Per un fotografo professionista è del tutto irragionevole correre il rischio che i 
propri lavori vadano persi ed è pertanto fondamentale prevedere nel proprio 
flusso di lavoro un momento destinato alla creazione dei Backup.
Con Photoshop Lightroom il backup delle immagini può essere eseguito conte-
stualmente all’importazione dei file anche su hard disk esterni o server utilizzan-
do il comando Backup To disponibile nella finestra Import per le opzioni Copy 
e Move del menu File Handling. Naturalmente questa opzione allunga sensibil-
mente i tempi di importazione delle immagini.

Backup del database
Eseguire regolarmente il backup del database di Photoshop Lightroom è di fon-
damentale importanza. Qualora andasse perso o si danneggiasse andrebbero 
perdute tutte le operazioni svolte sulle immagini all’interno di Photoshop Li-
ghtroom. 
Si consiglia quindi di eseguire regolarmente il Backup di questo database atti-
vando la funzione dal menu File > Catalog Settings > General > Back up 
catalog. A intervalli regolari, in base all’arco temporale scelto, appare una 
finestra di dialogo che chiede di avviare il backup. Come impostazione predefi-
nita i backup vengono salvati nella cartella Immagini > Lightroom > Backups. 
Tuttavia è più prudente salvarli in un supporto di memoria diverso da quello nel 
quale è archiviato il database principale.

Backup di Presets, Templates, Sets...
Anche tutte le impostazioni preconfigurate o personalizzate nel tempo, come 
ogni altro tipo di file, potrebbero danneggiarsi o peggio andare perse.
E’ quindi saggio eseguire backup manualmente anche di questi file localizzati in:
• Mac: utente/Libreria/Application Support/Adobe/Adobe Lightroom;
• Windows: C:\Documents and setting\utente\Dati applicazioni\Adobe\Li-
ghtroom.

Il database di Adobe Photoshop Lightroom può risiedere su un server per 
essere accessibile da diversi computer?

Attualmente Photoshop Lightroom 1.2 è concepito per un flusso di lavoro indivi-
duale e il suo database chiamato Catalog (.Ircat) non è progettato per funziona-
re su un server. E’ invece possibile che i file immagine originali, cui il database fa 
riferimento, risiedano su un server.
Il database con tutte le correzioni deve comunque essere locaalizzato su un hard 
disk (interno o esterno, ma collegato fisicamente al computer dove è installato 
Photoshop Lightroom).

Se i Catalogs vengono localizzati su un hard disk esterno è possibile 
condividerlo, dando l'opportunità a più utenti di intervenire sulle stesse immagini. 
In questo le modifiche fatte da un utente ad una singola immagine, risultano tali 
per tutti gli altri utenti, e così via.

In alternativa è possibile procedere in modo diverso: l'intero archivio delle 
immagini viene depositato su un hard disk esterno (o volendo anche 
un server), e i singoli utenti mantengono i Catalogs sui propri computer. In 
questo modo, più utenti possono modificare personalmente le immagini, senza 
che queste risultino modificate per tutti gli altri.
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Compatibilità di for-

mati e tipologie di file

File compatibili con la versione 1.2

Adobe Photoshop Lightroom con-

sente l’importazione e la gestione di tutti 

i principali formati per le immagini foto-

grafiche: JPG, TIFF, PSD, DNG e, at-

tualmente, oltre 150 diversi tipi di formati 

RAW (la lista aggiornata è disponibile 

alla pagina:

http://www.adobe.com/products/Adobe 

Photoshop/cameraraw.html).

I fi le possono essere in RGB, in 

Scala di Grigio, o in Metodo LAB sia a 

8 bit sia a 16 bit, ma Photoshop Li-

ghtroom gestisce le regolazioni sempre 

e comunque in RGB.

Se si importa un PSD a livelli è ne-

cessario che questo sia stato salvato 

attivando l'opzione Massimizza Compati-

bilità. In caso contrario il file non viene 

importato.

File non compatibili con la versio-

ne 1.2

Non sono supportati:

- Tutti i formati di file non espressa-

mente specificati sopra (che vengono 

automaticamente ignorati in fase di im-

portazione) come i file in formato EPS, 

GIF... ecc;

• Tutti i file con metodo di colore 

CMYK;

• I file PSD a livelli salvati senza 

l’opzione Massimizza Compatibilità;

• Tutte le immagini con un lato su-

periore ai 10.000 pixel;

• Tutti i file video, anche quelli ac-

quisiti con fotocamere digitali.
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Quanto spazio occupa il database di Photoshop Lightroom? 
Come si può “alleggerire”?

Dal momento che le istruzioni memorizzate nel database di Photoshop Li-
ghtroom sono estremamente contenute le sue dimensioni sono principalmente 
determinate dalle anteprime dei file presenti al suo interno.
Queste anteprime sono in JPG e la loro risoluzione e compressione può essere 
personalizzata attraverso il comando dal menu File > Catalog Settings > 
File Handling > Preview Cache. Tanto più sono grandi le anteprime salvate 
in memoria tanto più il database cresce. Tuttavia, grazie a queste anteprime, 
Adobe Photoshop Lightroom non deve ogni volta attingere ai file originali per 
visualizzare le immagini e le regolazioni ad esse applicate e quindi si riduce al 
minimo il tempo di attesa per la visualizzazione di ogni modifica. Quando ap-
pare il messaggio Working, Photoshop Lightroom sta generando l’anteprima ad 
una dimensione che non era stata precedentemente salvata nel suo archivio.

La dimensione ottimale di queste anteprime va trovata in un giusto compromes-
so tra:
• la capienza del supporto di memoria che conserva i Catalogs;
• la velocità del proprio computer;
• il genere di utilizzo delle immagini importate;
• il grado di urgenza insita nel proprio flusso di lavoro.

Ad esempio, se si è soliti consegnare un servizio fotografico nell’arco 
di una settimana e, successivamente le foto rimangono nella Library solo per 
un eventuale consultazione, è consigliabile impostare le opzioni Preview Cache 
nel seguente modo:
• Standard Preview Size: 1024;
• Preview Quality: Medium;
• Automatically Discard 1:1 Previews: After One Week.

Se invece si ha poco spazio su disco è importante che il database rimanga 
il più leggero possibile, impostando le opzioni nel seguente modo:
• File Management > Standard Preview Size: 1024;
• Preview Quality: Low;
• Automatically Discard 1:1 Previews: After One Day.

Se invece si ha un hard disk molto capiente e un computer potente è 
preferibile impostare le opzioni nel seguente modo:
• File Management > Standard Preview Size: 2048;
• Preview Quality: High;
• Automatically Discard 1:1 Previews: Never.
In questo modo il database di Photoshop Lightroom occupa un maggiore spazio 
su disco, ma il software risulta più performante perché le anteprima sono sem-
pre disponibili in memoria e non devono mai essere ricreate al momento.

E’ possibile che file con i giusti requisiti non vengano importati all’inter-
no della Library?

Può verificarsi una situazione simile nei seguenti casi:

• Si sta importando un’immagine già precedentemente inserita all’in-
terno della Library. Ogni file può essere importato una sola volta e, in casi 
come questo, una finestra di dialogo segnala che il file è già presente all’interno 
della Library permettendo di visualizzarlo. Qualora si desideri importarlo co-
munque è necessario rinominarlo.

• Si sta importando una cartella che contiene scatti salvati simultaneamen-
te in formato RAW e JPG. In questi casi, come impostazione predefinita, vie-
ne importato soltanto il file in formato RAW. Se si desidera invece importare an-
che il file JPG oltre al RAW è necessario attivare l’opzione dal menu Preferences 
> Import > Treat JPG files next to raw files as separate photos.
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Importare le immagini 

nella Library

Per poter visualizzare ed elaborare 

le immagini all’interno di Photoshop Li-

ghtroom la prima operazione da compie-

re è l’importazione.

Le immagini possono essere impor-

tate da diversi supporti:

• Dall’hard disk del proprio compu-

ter;

• Da un server;

• Da qualsiasi supporto di memo-

ria esterno (hard disk esterno, chiave 

USB) collegato via USB o FireWire;

• Da una qualunque memory card;

• Da CD o DVD;

• Direttamente da fotocamera an-

che mentre si sta scattando o da qual-

siasi periferica collegata tramite la tecno-

logia Twain.

Per quanto concerne l’importazione, 

una problematica conosciuta per Pho-

toshop Lightroom 1.2 è l’incapacità di 

gestire file in formato RAW direttamente 

da alcune fotocamere Canon su Win-

dows XP. In caso di problemi di questo 

tipo è bene consultare il supporto tecni-

co Canon.

Il comando Import

Per eseguire l’importazione basta 

fare clic sul pulsante Import oppure 

trascinare la cartella contenente le im-

magini dalla Scrivania del computer al-

l’interno del Modulo Libray. La cartella 

selezionata può anche essere ramificata 

in sottocartelle, queste saranno a loro 

volta incluse nell’operazione. Se sono 

presenti altri tipi di file non compatibili 

con Photoshop Lightroom, il software li 

ignora automaticamente. Facendo clic 

sul pulsante Choose si accede alla fine-

stra di dialogo Import Photos.

Grazie alle opzioni relative al menu 

File Handling si può scegliere la modali-

tà di importazione più adatta al proprio 

metodo di lavoro. 

Di seguito le opzioni disponibili:

• Import photos at their current 

location: crea un semplice collegamen-

to tra Photoshop Lightroom e la posizio-

ne in cui si trovano i file originali (siano 

essi all’interno dell’hard disk o di una 

memoria esterna). Questa opzione non 

crea duplicati, ma solo una sorta di col-

legamento ai file originali ed è pensata 

per chi deve lavorare su immagini che 

sono già state archiviate su uno specifi-

co supporto di memoria. 

• Copy photos to a new location 

and import: copia i file in una nuova 

posizione e contemporaneamente ne 

esegue l’importazione. Questa modalità 

è generalmente consigliata quando si 

importano immagini da un CD, DVD o 

direttamente da una card senza averle 

prima trasferite sull’hard disk. Tuttavia le 

performance del software traggono no-

tevole vantaggio se si esegue l’importa-

zione dei file dopo averli già trasferiti 

nella loro posizione definitiva. 

• Move photos to a new location 

and import: sposta i file in una nuova 

posizione, cancellandoli quindi dal loro 

supporto di memoria originale, e con-

temporaneamente li importa.

• Copy photos as Digital Negative 

(DNG) and Import: crea una copia in 

formato DNG di tutti i file RAW che si 
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Come si evita l’esecuzione automatica della finestra di importazione di 
Photoshop Lightroom?

Ogni volta che si accende una periferica come ad esempio uno scanner o viene 
inserita una memory card su un lettore collegato al computer, Photoshop Li-
ghtroom lancia automaticamente la finestra di importazione.
Il comando per modificare questa funzione si trova nel menu Preferences > 
Import > Show import dialog when a memory card is detected.

Nei sistemi operativi Windows è anche necessario fare clic con il tasto destro del 
mouse sull’icona dell‘Adobe Photo Downloader, posta nella barra dell’orologio, 
e selezionare dal menu a comparsa l’opzione Disable.

Qual è il modo più semplice e veloce per importare tutto il proprio archi-
vio fotografico all’interno di Adobe Photoshop Lightroom?

Il modo più pratico per importare archivi costituiti da centinaia di migliaia di file 
è quello di importare la cartella madre contenente tutte le sottocartelle. Photos-
hop Lightroom riconosce automaticamente tutta la ramificazione e importa si-
multaneamente tutti i file compatibili che rintraccia all’interno di tutte le sottocar-
telle, senza alcuna necessità di importarli cartella per cartella o di creare ad 
esempio divisioni per tipologie di file. 
Tuttavia, va tenuto conto che un’operazione di questo tipo richiede molto tempo 
e una notevole performance da parte del computer, per cui è bene valutare ac-
curatamente i requisiti della propria macchina ed eventualmente importare le 
immagini in diversi step.

Come si possono importare immagini scattate in doppio formato RAW e 
JPG?

Quando si importano immagini salvate in fase di scatto nel doppio formato 
RAW e JPG Photoshop Lightroom identifica questi file come un duplicato e ignora 
il JPG importando solo il RAW. In questo caso l’attivazione o meno della funzio-
ne Ignore Suspected Duplicates disponibile nella finestra Import non modifica il 
comportamento del software.

A partire dalla versione 1.1 di Photoshop Lightroom è stata inserita una nuova 
opzione nel menu Preferences > Import > Treat JPG files next to raw 
files as separate photos. Se viene attivata i file in formato JPG vengono im-
portati insieme ai file in formato RAW.
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importano salvandoli nella cartella indi-

cata.  Se, in fase di importazione compa-

re il messaggio di errore An error occur-

red while converting file image.raw è 

molto probabile che le immagini che si 

stanno importando siano localizzate su 

un volume bloccato (locked) o protetto 

da scrittura (read only).

Se si sceglie una di queste ultime 

tre opzioni (Copy/Move) si può anche:

• Specificare la nuova cartella nella 

quale copiare i file utilizzando il coman-

do Copy to (copia in);

• Effettuare un Backup di sicurezza 

delle immagini (Backup to);

• Rinominare le foto (File Naming). 

Don’t re-import suspected dupli-

cates: questa opzione evita che venga-

no importate due volte foto identiche. 

Photoshop Lightroom verifica le caratte-

ristiche delle foto durante l’importazione 

e, se qualcuna è già presente nel data-

base, la scarta. Da notare che, nel caso 

non venga spuntata questa opzione, 

Photoshop Lightroom esegue comunque 

un controllo sui nomi delle foto e, in ca-

so di duplicati sospetti, chiede se si de-

sidera sovrascrivere i file con lo stesso 

nome oppure no. E’ bene tenere presen-

te che un file con le stesse caratteri-

stiche e lo stesso nome di un’immagi-

ne già importata non può essere im-

portato due volte. E’ però possibile 

importare una stessa immagine che è 

stata rinominata così come una foto di-

versa che ha lo stesso nome di un’altra.

Eject card after importing: questa 

opzione consente di espellere automati-

camente, al temine dell’importazione, la 

card dalla quale si stanno importando le 

immagini, senza alcuna necessità di 

tornare sul proprio Desktop/Scrivania.

Le opzioni relative a Information to 

Apply offrono l’opportunità di applicare 

già in fase di importazione alcuni Presets 

relativi all’aspetto delle immagini, ai dati 

IPTC e alle parole chiave che si intendo-

no associare ai file. Ognuna di queste 

informazioni e regolazioni può essere  

successivamente modificata, integrata o 

rimossa all’interno del Modulo Library 

(Pannelli Keywording e Metadata) e del 

Modulo Develop (Pannello Presets). Tut-

tavia, soprattutto per quanto riguarda i 

metadati e le parole chiave, potrebbe 

risultare davvero molto utile acquisire la 

sana abitudine di farlo fin da subito.

Dal menu Develop Settings è pos-

sibile applicare a tutte le immagini, già in 

fase di importazione, uno dei Presets 

disponibili all’interno del Modulo Deve-

lop. Per fare in modo che tutte le im-

magini vengano importate senza subi-

re alcuna modifica automatica da par-

te di Photoshop Lightroom occorre 

selezionare il Preset General - Zeroed, 

in caso contrario ai file in formato RAW 

viene applicato un leggero contrasto che 

rende le immagini più brillanti e realisti-

che. 

Dal menu Metadata è possibile as-

segnare gruppi di dati IPTC. Per snellire 

le normali operazioni di routine può es-

sere molto utile creare dei Presets di 

metadati selezionando la voce New e 

compilando le informazioni assegnate 

più frequentemente, come ad esempio 

quelle relative al copyright e ai recapiti 
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Cosa sono i dati IPTC?

I dati IPTC costituiscono un metodo per archiviare informazioni testuali in un file 
immagine. Questi metadati aggiuntivi sono di norma compilati dall’autore del-
l’immagine.
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del fotografo. 

Infine è possibile attribuire specifi-

che parole chiave (Keywords) al gruppo 

di foto che si stanno importando, in 

modo da poterle ritrovare più veloce-

mente all’interno del proprio archivio. 

Ogni parola chiave o insieme di parole 

chiave deve essere separato da una 

virgola.

L’opzione Render standard-sized 

previews crea, già in fase di importazio-

ne, un’anteprima ad alta risoluzione 

delle immagini che ne velocizza la visua-

lizzazione all’interno di Adobe Photos-

hop Lightroom e permette di visualizzar-

le anche quando il supporto di memoria 

nel quale sono archiviati gli originali è 

temporaneamente scollegato. Questa 

anteprima in formato JPG viene conser-

vata in memoria all’interno del database 

nella cartella Immagini > Lightroom. Il 

peso e le dimensioni di queste antepri-

me sono personalizzabili dal menu File 

> Catalog Settings > File Handling > 

Preview Cache.

L’opzione Show Preview mostra le 

miniature delle immagini che si intendo-

no importare consentendo l'eventuale 

esclusioni di quelle da scartare, prima 

che inizi l'importazione.

Importazione di nuove immagini in 

un Folder preesistente

A volte, dopo che una cartella di 

immagini è stata importata all’interno di 

Photoshop Lightroom, può capitare di 

aggiungere nuove immagini in quella 

stessa cartella o di effettuare modifiche 

ad alcuni dei file importati utilizzando 

applicazioni diverse. In casi come questi 

per aggiornare rapidamente tali modifi-

che anche all’interno del software si può 

fare clic con il tasto destro (CTRL + clic 

su Mac) sul nome del Folder e scegliere 

la funzione Synchronize Folder. Con 

questo comando vengono importate 

tutte le immagini mancanti e vengono 

aggiornate le immagini modificate. Se si 

desidera importare le nuove immagini 

così come sono, senza verificarne le 

anteprime o specificare informazioni 

come quelle relative alle keywords o al 

copyright, basta disattivare l’opzione 

Show Import Dialog Before Importing.

Importazione dalla fotocamera 

in fase di scatto

Se la propria fotocamera può essere  

messa in connessione diretta con un 

computer, Photoshop Lightroom può 

importare le foto simultaneamente e 

automaticamente mentre vengono 

catturate.

Questa funzione può essere molto 

utile perché consente di visualizzare 

istantaneamente le immagini in un moni-

tor e di esaminarle accuratamente ad 

alta risoluzione, se necessario anche 

insieme al committente o ai propri colla-

boratori. Inoltre questa funzione può 

essere molto comoda per assegnare 

subito parole chiave ai file in tutti quei 

casi nei quali il flusso di lavoro è com-

plesso e impone un rigore particolare. 

Un esempio di questo tipo sono i servizi 

fotografici per consistenti quantità di 

prodotti, come quelli per cataloghi o ad 

esempio foto di archivio per casting di 

modelle. In casi come questi, Photoshop 

Lightroom risulta molto utile perché il 

nome o il codice del prodotto, piuttosto 

che il nome della modella o altre infor-

mazioni importanti possono essere as-

sociate istantaneamente al file rendendo 

facile e snella un’operazione che invece, 

svolta successivamente, può richiedere 

molto tempo e scrupolosità, oltre che 

esporre il lavoro a possibili errori.

Per utilizzare questa procedura è 

innanzitutto necessario configurare la 

propria fotocamera affinché possa 

essere collegata al computer in  mo-

dalità FTP. Per questo si rimanda al 

manuale d’uso della propria fotocamera. 

In generale è bene tenera conto che le 

connessioni via cavo FireWire (IEE 1394) 

o USB 2.0 permettono di scattare ed 

eseguire il download su un computer ad 

una velocità molto simile a quella delle 

memory card. Alcune fotocamere offrono 

anche la libertà di una connessione wi-

reless (senza fili) tra fotocamera e com-

puter (entro un centro raggio di metri), 

ma attualmente il trasferimento è signifi-

cativamente più lento delle connessioni 

via cavo.

Una volta eseguita tale configura-

zione si può impostare Lightroom come 

segue in modo da importare le immagi-

ni, in tempo reale, direttamente all’inter-

no della Library:
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1 - Specificare una cartella del 

computer nella quale eseguire i l 

download delle immagini. Questa con-

figurazione può essere fatta sulla foto-

camera (attraverso i menu interni) o at-

traverso il software fornito per scattare in 

tethered mode (consultare il manuale di 

istruzioni della propria fotocamera);

2 - Configurare Photoshop Li-

ghtroom in modo da importare auto-

maticamente ogni immagine che arri-

va nella cartella specificata chiamata 

Watched Folder. Questa funzione di 

Adobe Photoshop Lightroom si attiva 

attraverso il menu File > Auto Import > 

Enable Auto Import. Le opzioni di im-

portazione si personalizzano dal menu 

File > Auto Import > Auto Import Set-

tings. Dalla finestra di dialogo dedicata è 

possibile specificare di volta in volta il 

Watched Folder. Photoshop Lightroom 

provvede automaticamente a spostare i 

file dalla cartella nella quale la fotocame-

ra scarica le immagini in una nuova de-

stinazione e li importa nella Library. Le 

altre opzioni disponibili nella finestra di 

dialogo sono analoghe a quelle presenti 

nella finestra Import Photos.

Importare un catalogo da Photos-

hop Elements 5

Prima di importare i cataloghi di 

Photoshop Elements 5 in Photoshop 

Lightroom eseguire la seguente opera-

zione, all’interno di Photoshop Elements, 

dal menu File > Catalog -> Recover.
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Esportare le immagini 
elaborate

E’ durante la fase di esportazione 

che tutte le correzioni effettuate sulle 

foto vengono definitivamente applicate 

ad una copia dei file originali. Se si mo-

dificano le immagini all’interno di Pho-

toshop Lightroom, ma non si esegue 

alcun tipo di esportazione, gli originali 

rimangono a tutti gli effetti inalterati e 

se vengono aperti utilizzando un qua-

lunque altro software questi appaiono 

come in origine, ovvero privi di modifi-

che (a meno di aver esportato i dati 

XMP).

L’esportazione può avvenire in 

vari modi, a seconda dell’utilizzo cui 

le immagini sono destinate:

• Tramite il comando dal menu File 

> Export (vd. paragrafo seguente) si può 

effettuare una sorta di “Salva con Nome” 

avanzato in batch che permette il sal-

vataggio di uno o più file simultanea-

mente nei formati JPG, PSD, TIFF o 

DNG, consentendo di specificarne la 

localizzazione, il nome, la dimensione in 

pixel, la risoluzione, lo spazio colore, il 

Watermark del copyright e alcune speci-

fiche sulla gestione dei metadati e delle 

parole chiave;

• Si può creare un file PDF, con 

una o più immagini impaginate, dai 

Moduli Slideshow (pulsante Export) e 

Print (pulsante Print > Salva come PDF, 

funzione questa disponibile con i sistemi 

operativi Apple o con il software Acrobat 

Professional);

• Si possono mandare direttamen-

te in stampa i file impaginati all’interno 

del Modulo Print tramite i l pulsante 

Print);

• Si può esportare, o caricare diret-

tamente su Internet, una photogallery 

per il web in HTML o animata in Flash 

tramite i pulsanti Export e Upload dispo-

nibili nel Modulo Web;

• Si possono masterizzare le foto 

direttamente su CD o DVD tramite il 

comando dal menu File > Export > After 

Export: Burn the exported images to a 

disc;

• Si possono aprire una o più im-

magini direttamente in Adobe Photos-

hop quando si ha la necessità di esegui-

re operazioni accurate di fotoritocco, 

applicare correzioni avanzate, filtri, lavo-

rare con livelli multipli, con le maschere, 

su singoli canali o con funzioni comun-

que non disponibili in Photoshop Li-

ghtroom. Il comando dal menu per pas-

sare a Photoshop è Photo > Edit in 

Adobe Photoshop ed è disponibile solo 

all’interno dei moduli Library e Develop;

• Si può esportare solo il codice 

XMP in modo da poter ad esempio 

trasferire i file originali integri corredati 

delle modifiche applicate;

• Si può esportare un Catalog in 

modo da integrare tra loro due o più 

database di correzioni eseguite con di-

versi computer.

Infine si può tenere conto che gli 

utenti Mac possono anche esportare le 
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In quali casi le modifiche eseguite con Adobe Photoshop Lightroom po-
trebbero non essere visualizzate in Bridge o in Adobe Photoshop?

In generale, in tutti i flussi di lavoro che prevedono l’utilizzo sia di Lightroom sia 
di Camera RAW è necessario verificare che le Preferenze di Camera RAW siano 
impostate nel seguente modo: Salva Impostazioni immagine in > File col-
laterali “.xmp”. Se alcuni file importati in Photoshop Lightroom vengono suc-
cessivamente editati in Camera RAW, Lightroom non aggiorna automaticamente 
l’anteprima delle nuove versioni. Per farlo basta utilizzare la funzione del menu  
Metadata > Read Metadata from Files disponibile all’interno del modulo Library.

Se in Bridge (o negli altri programmi compatibili con il plug-in Camera RAW) le 
immagini appaiono prive di modifiche malgrado siano state elabo-
rate in Photoshop Lightroom verificare se:
• E’ stata eseguita correttamente l’esportazione dei dati XMP;
• La versione di Camera RAW che si sta utilizzando è stata aggiornata alla ver-
sione 3.7 o successiva. 

Se in Adobe Bridge o negli altri programmi compatibili con Camera RAW solo 
alcune modifiche eseguite in Photoshop Lightroom non vengono vi-
sualizzate correttamente è possibile che:
• La versione di Camera RAW che si sta utilizzando non contempla tutte le fun-
zioni disponibili all’interno di Photoshop Lightroom. Ad esempio in Adobe Pho-
toshop CS2 non sono disponibili funzioni nuove come Recovery, Fill Light, Spot 
Removal Tool, Red Eye Tool, Vibrance...;
• La versione del software utilizzato per aprire i file elaborati in Photoshop Li-
ghtroom è in una lingua diversa. Ad esempio, in alcuni computer potrebbe esse-
re installata la licenza in lingua inglese di Photoshop Lightroom e una in lingua 
italiana di Bridge. In questi casi alcune informazioni assegnate ai file (come ad 
esempio il colore delle etichette) non possono essere visualizzate correttamente 
perché il metadato viene scritto sul file in una lingua e viene poi letto in un’altra. 
L’informazione nel file tuttavia rimane memorizzata, per cui può essere visualiz-
zata con le versioni nella stessa lingua o eseguendo le ricerche utilizzando termi-
ni inglesi. Ad esempio, per ritrovare con Bridge in lingua italiana tutte le imma-
gini alle quali con Photoshop Lightroom si è assegnata l’etichetta rossa si può 
effettuare una ricerca dal menu Modifica > Trova > Criteri > Etichetta > Con-
tiene > Red.

Quali software della famiglia Adobe assicurano massima compatibilità 
con la versione 1.2 di Adobe Photoshop Lightroom?

Sia Lightroom sia Camera RAW condividono la stessa tecnologia proprio per 
garantire la massima coerenza di risultati e compatibilità tra le applicazioni 
Adobe che supportano il RAW processing. Per questa ragione, se si desidera 
avere la massima compatibilità con il Modulo Develop della versione 1.2 di 
Photoshop Lightroom è necessario aggiornare il plug-in Camera RAW alla ver-
sione 4.2.
Al momento i software Adobe che lo supportano sono: Photoshop CS3, Pho-
toshop Elements 4.01 per Mac, Photoshop Elements 5.0 e Premiere Elements 
3.0 per Windows.
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immagini trascinandole dalla Grid della  

Library direttamente sulla propria Scriva-

nia, ma in questo modo si ottiene una 

copia del file prima delle correzioni ese-

guite in Lightroom. 

Nelle prossime pagine sono illustrati 

alcuni dei metodi di esportazione sopra 

menzionati. Tutte le altre procedure sono 

spiegate nei successivi capitoli dedicati 

ai singoli Moduli.

Il comando Export

Il comando Export è disponibile sia 

come pulsante all’interno del Modulo 

Library sia dal menu Edit > Export Pho-

tos.

Questa tipologia di esportazione 

può essere considerata a tutti gli effetti 

una sorta di “Salva con Nome avanzato 

in batch” che permette di eseguire, si-

multaneamente su uno o più file, tutta 

una serie di operazioni relative al nome, 

al ridimensionamento, allo spazio colo-

re, alla masterizzazione, ecc.

In pratica questo comando lascia 

intatti gli originali e crea una copia delle 

singole immagini alle quali va ad appli-

care, in una sola fase, tutti gli interventi 

che sono stati eseguiti all’interno di Pho-

toshop Lightroom sia sui metadati (stel-

le, etichette colorate, bandiere, parole 

chiave, ecc) sia sui pixel (regolazioni del 

Modulo Develop).

Dalla finestra di dialogo è possibile 

specificare diverse opzioni.

Preset: offre alcuni gruppi di impo-

stazioni predefinite per un’esportazione 

veloce e di routine dei file. E’ possibile 

salvare nuovi Presets di esportazione 

personalizzati in base alle proprie esi-

genze utilizzando il comando Save Cur-

rent Settings as New Preset. 

Export Location: consente di speci-

ficare la posizione, e l’eventuale sotto-

cartella, nella quale si intendono salvare 

i file.

File Naming: permette di rinominare 

i file in modo articolato e accurato.

File Settings: offre opzioni relative al 

formato di salvataggio e all’eventuale 

tipo di compressione.

Image Settings: si utilizza per attri-

buire lo spazio colore, la profondità di 
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Come si ritagliano le immagini ad una certa dimensione?

Nella finestra di dialogo dell’esportazione c’è l’opzione Constrain Maximum 
Size che permette di ridimensionare le immagini automaticamente du-
rante l’esportazione. 
I valori numerici che si inseriscono nei campi Width/Height ricampionano, alla 
dimensione specificata il lato più lungo della foto, sia esso orizzontale o vertica-
le. 
Se ad esempio si devono esportare alcune immagini da stampare in formato 
10x15 cm è sufficiente specificare:
• Units: Centimeters;
• Width: 15;
• Height: 15. 
In questo modo, anche se la cartella esportata contiene scatti sia orizzontali sia 
verticali, tutti vengono ridimensionati alla stessa grandezza e il lato più corto 
viene adattato proporzionalmente.

Per modificare invece il rapporto di proporzione tra l’altezza e la lar-
ghezza dell’immagine si deve utilizzare lo strumento Crop Overlay disponibile 
all’interno del Modulo Develop.
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bit, la risoluzione ed eventualmente an-

che per ridimensionare le immagini (vd. 

box nella pagina precedente). L’opzione 

Add Copyright Watermark scrive diretta-

mente sul bordo dell’immagine le infor-

mazioni contenute nel metadato Copy-

right.

Metadata: l’opzione Minimize Em-

bedded Metadata esporta i file cancel-

lando tutti i metadati ad eccezione del 

Copyright. La funzione Write Keywords 

as Lightroom Hierarchy, esporta le paro-

le chiave associate alle immagini sepa-

rando con il carattere pipe (|) keywords 

della stesso gruppo.

Post-processing: permette di lan-

ciare automaticamente altri applicativi in 

modo da applicare un’azione in batch a 

tutte le immagini che si stanno espor-

tando. Ad esempio si possono lanciare 

droplet di Adobe Photoshop oppure 

masterizzare le foto direttamente su CD 

o DVD tramite il comando Burn the ex-

ported images to a disc.

 

Esportare il solo codice XMP

Spesso può capitare che ci sia la 

necessità di visualizzare o elaborare con 

Photoshop, Bridge o altri software che 

supportano il plug-in Camera RAW (co-

me Adobe Photoshop Elements o Pre-

miere), alcune foto che sono state pre-

cedentemente post-prodotte con Pho-

toshop Lightroom.

Una situazione come questa si veri-

fica spesso quando si desidera visua-

lizzare con Adobe Bridge le etichette 

colorate o le stelle precedentemente 

assegnate alle immagini utilizzando 

Photoshop Lightroom.

Oppure può succedere di voler 

masterizzare le immagini originali su 

un CD o DVD, conservando però an-

che tutte le eventuali modifiche che si 

sono eseguite con Lightroom.

In casi come questi è fondamentale 

tenere presente che, in generale, tutte le 

modifiche che si eseguono sulle imma-

gini con Photoshop Lightroom (siano 

esse regolazioni come il bilanciamento 

del bianco, o alterazioni di altro tipo co-

me l’inserimento di parole chiave) ven-

gono salvate di norma soltanto nel suo 

database chiamato Catalog. Se si desi-

dera salvare queste istruzioni sulle modi-

fiche, anche direttamente sulle immagi-

ni, senza però alterarne irreversibilmente 

i pixel, si può eseguire l’esportazione dei 

dati XMP. 

Questo genere di esportazione non 

crea una copia delle immagini e non 

modifica i file originali, le cui informazioni 

restano a tutti gli effetti intatte, ma fa sì 

che Photoshop Lightroom registri le mo-

difiche in formato XMP direttamente sul 

file, oltre a memorizzarle nel proprio 
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database. In questo modo i file originali, 

lasciati integri, preservano la massima 

qualità e modularità per qualunque 

eventuale ulteriore modifica. 

Questo tipo di esportazione può 

essere eseguita di volta in volta, su una 

o più foto selezionate, oppure, automati-

camente su tutte le immagini del proprio 

archivio.

Per eseguire l’esportazione dei 

dati XMP manualmente:

1 - selezionare uno o più file dal 

Modulo Library;

2 - esportare i dati XMP sui singoli 

file attraverso il comando dal menu Me-

tadata > Save Metadata to File oppure 

utilizzando la comoda scorciatoia da 

tastiera CTRL + S su Windows (Coman-

do + S su Mac) Questa funzione è di-

sponibile sia nel Modulo Library sia nel 

menu contestuale dell’immagine facen-

do clic sull’anteprima con il tasto destro 

(CTRL + clic su Mac).

La procedura appena descritta va 

ripetuta ogni volta che si desidera ag-

giornare i dati XMP dei singoli file con le 

modifiche effettuate all’interno di Pho-

toshop Lightroom.

Se si desidera eseguire l’esporta-

zione dei dati XMP sempre e in auto-

matico su tutte le immagini elaborate si 

può attivare l’opzione disponibile dal 

menu File > Catalog Settings > Meta-

data > Automatically write changes 

into XMP. Tuttavia l’attivazione di questa 

preferenza riduce le performance del 

programma. 

E’ importante sottolineare che que-

sto tipo di esportazione memorizza tutte 

le modifiche effettuate ad eccezione di 

Collections, Snapshots, History, Virtual 

Copies, Collections, Quick Collection e 

Stack. Inoltre la compatibilità delle re-

golazioni memorizzate nei file è sem-

pre vincolata alle funzioni disponibili 

nella versione di Camera RAW utilizza-

ta per la loro apertura. Ad esempio 

Photoshop CS2 è in grado di visualizzare 

stelle, etichette colorate e tutte le regola-

zioni del Modulo Develop ad eccezione 

delle regolazioni non disponibili nella 

versione 3.7 di Camera Raw come ad 

esempio Recovery e Fill Light.

Dalla versione 4.0 di Camera RAW, 

lanciata con la Creative Suite CS3, perfi-

no file in formato JPG, PSD e TIFF  pos-

sono essere aperti direttamente con il 

plug-in Adobe Camera RAW, conservan-

do tutte le modifiche compatibili esegui-

te in Photoshop Lightroom, e questi pos-

sono essere ulteriormente modificati 

attraverso i comandi offerti da Camera 

RAW.
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Dove vengono scritti i dati XMP?

Nei file in formato JPG, PSD, TIFF i dati XMP vengono scritti direttamente nei 
metadati incorporati nel file originale. 

Per tutti i formati RAW proprietari (CR2, NEF, ORF, RAF, ecc) queste informazioni 
vengono salvate nel leggero file collaterale XMP che viene automaticamente 
inserito all’interno della stessa cartella del file originale e prende lo stesso no-
me. Se questo file XMP viene rimosso o rinominato il file RAW apparirà privo di 
modifiche, ovvero, così come è stato scattato.

Se si desidera incorporare il file XMP ai file in formato RAW basta conver-
tire il file RAW originale in formato DNG.

Che fine hanno fatto i Photo Binder?

La procedura di esportazione relativa ai Photo Binder, presente nella Beta 4.1 di 
Photoshop Lightroom, non è più disponibile ed è stata sostituita dalla modalità di 
esportazione illustrata sopra.

Si possono avere diversi Catalog?

Per integrare diversi Catalog tra loro si utilizza il comando dal menu File > 
Export as Catalog  Questa funzione si utilizza quando capita ad esempio di 
lavorare su diversi computer allo stesso progetto. L’intera procedura è spiegata 
più avanti in questo capitolo.

Per creare diversi Catalog da caricare nella Library uno alla volta si utilizza 
il comando dal menu File > New Catalog. La finestra di dialogo che appare 
consente di stabilire dove si vuole archiviare il nuovo Catalog e il nome che gli si 
vuole assegnare. Una volta creato il nuovo Catalog si può caricarlo nella Library 
dal menu File > Open Catalog. Facendo clic sul pulsante Relaunch della fine-
stra di dialogo successiva Photoshop Lightroom viene automaticamente chiuso e 
riaperto con la Library aggiornata. Per riaprire velocemente un Catalog già aper-
to è disponibile il comando dal menu File > Open Recent. che consente di ese-
guire molto più rapidamente l’operazione illustrata sopra.
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Esportare un Catalog

Nel flusso di lavoro fotografico po-

trebbe a volte essere necessario trasfe-

rire tra due o più computer le corre-

zioni eseguite con Adobe Photoshop 

Lightroom su alcune immagini, oppure 

visualizzare o elaborare le stesse foto 

su diversi computer e in diverse fasi.

Una situazione di questo tipo si veri-

fica di frequente quando capita di inizia-

re una post-produzione sul set fotografi-

co con un computer portatile e la si ter-

mina nel proprio studio su una posta-

zione desktop.

La soluzione a questo problema è 

stata implementata nella versione 1.1 di 

Adobe Photoshop Lightroom.

Per esportare un Catalog basta se-

guire i seguenti passaggi:

1 - Selezionare una Collection di 

immagini, uno specifico gruppo di foto, 

o anche, se necessario, l’intera Library.

2 - Scegliere la funzione dal menu 

File> Export as Catalog. In alternativa, 

premendo il tasto ALT il pulsante Export 

in basso a sinistra nel Modulo Library si 

trasforma in Export Catalog.

Nella finestra di dialogo che si apre 

è possibile scegliere tre semplici opzio-

ni:

• Export selected photos only: 

vengono esportate solo le foto selezio-

nate in quel momento.

• Export negative files: vengono 

duplicati i file originali, organizzati in 

cartelle e sottocartelle. Questa opzione è 

necessaria quando nel secondo compu-

ter non sono già presenti le foto per le 

quali si intendono sincronizzare le modi-

fiche. Ad esempio, le foto sono state 

trasferite dalla memory card sul portatile, 

dove sono state selezionate e classifica-

te in progress durante il servizio fotogra-

fico per poi essere trasferite, complete 

delle modifiche, sul computer desktop.

• Include available previews: ven-

gono esportate in un file in formato .Irda-

ta anche le anteprime dei file create au-

tomaticamente da Photoshop Lightroom 

per fare in modo che le immagini siano 

visualizzate più velocemente (opzione 

consigliata).

Facendo clic sul pulsante Export Cata-

log viene creata automaticamente una 

cartella (con il nome assegnato in que-

sta finestra di dialogo) nella quale ven-

gono salvate tutte le foto oltre a un file in 

formato .Ircat, che contiene le modifiche 

eseguite sulle stesse da Photoshop Li-

ghtroom. 

3 - Trasferire nel secondo computer 

la cartella appena creata utilizzando un 

qualunque supporto di memoria (hard 

disk, DVD, chiave USB, ecc).

4 - Avviare Photoshop Lightroom e 

andare sul menu File > Import From 

Catalog. Sfogliare i propri documenti e 

selezionare il file in formato .Ircat che fa 

riferimento al Catalog esportato. Facen-

do clic sul pulsante Choose (Mac) o 

Open (Win) si apre una versione sempli-

ficata della finestra di dialogo Import.

In questo modo vengono aggiornate 

sul secondo computer tutte le modifiche 

effettuate sulle immagini, comprese le 

Keywords, le Collections, la History, gli 

Snapshots e le Virtual Copies proprio 

come se quelle operazioni fossero state 

eseguite su quello stesso computer.
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IL MODULO LIBRARY 

ORGANIZZARE, SELEZIONARE E ARCHIVIARE LE IMMAGINI

Il primo Modulo, chiamato Library (biblioteca), è dedicato all’organizza-
zione delle immagini: dall’importazione, alla selezione, all’archiviazio-
ne. Volendo fare un paragone, potremmo dire che si tratta del Modulo 
grazie al quale si possono svolgere quelle operazioni normalmente ese-
guite con software come Adobe Bridge, oltre a molte altre funzioni di 
nuova concezione pensate appositamente per i fotografi.

In questo Modulo è possibile eseguire le seguenti operazioni:
• importare le immagini da diverse periferiche: hard disk, CD, DVD o 
direttamente dalla memory card della propria fotocamera;
• visualizzare, raddrizzare e confrontare gli scatti attraverso diverse 
modalità di visualizzazione;
• scegliere, classificare e contrassegnare le immagini con bandierine, 
stelle, colori e parole chiave;
• ordinare, filtrare, raggruppare e catalogare l’intero archivio foto-
grafico attraverso l’uso di cartelle, raccolte, parole chiave e dati IPTC con 
la possibilità di modificare i metadati di più file simultaneamente (ad 
esempio per rinominarli o sincronizzare l’orario e la data di scatto);
• eseguire ricerche accurate di immagini presenti all’interno dell’archi-
vio, in modo rapido e preciso;
• effettuare alcune regolazioni semplici e veloci su una o più immagini 
simultaneamente.

IN QUESTO CAPITOLO:

PER INIZIARE...
• Visualizzare le foto in diverse modalità
• Ordinare gli scatti e la sequenza
• Confrontare diverse immagini
• Selezionare e classificare le foto
• Applicare le impostazioni con un clic
• Filtrare i file
• Cercare nell’archivio
• Selezionare una o più immagini
• Cancellare una o più immagini

I PANNELLI DEL MODULO LIBRARY
• Caratteristiche generali dei Pannelli
• Il Pannello Navigator
• Il Pannello Library
• Il Pannello Find
• Il Pannello Folders
• Il Pannello Collections
• Il Pannello Keyword Tags
• Il Pannello Metadata Browser
• Il Pannello Histogram
• Il Pannello Quick Develop
• Il Pannello Keywording
• Il Pannello Metadata
• La Barra degli Strumenti
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SCORCIATOIE DA TASTIERA:

Attualmente le scorciatoie da tastiera di 
Photoshop Lightroom non sono personaliz-
zabili.
Molti tasti di questo software supportano il 
long press behavior: tenendoli premuti 
prolungatamente si attiva la funzione loro 
associata per poi disattivarsi non appena si 
rilascia il pulsante. Nella modalità di visua-
lizzazione provvisoria è comunque possibile 
lavorare usando il mouse normalmente.

COMANDO* 
+ ALT +1

Per se lez ionare i l 
modulo Library.

COMANDO* 
+ ALT + 2
(OPPURE D)

Per se lez ionare i l 
modulo Develop.

COMANDO* 
+ ALT + 3

Per se lez ionare i l 
modulo Slideshow.

COMANDO*  
+ ALT + 4

Per se lez ionare i l 
modulo Print.

COMANDO* 
+ ALT + 5

Per se lez ionare i l 
modulo Web.

G Per passare alla mo-
dalità Grid del modu-
lo Library.

TAB Così come in Adobe 
Photoshop questo tasto 
nasconde i Pannelli.

TAB + SHIFT Nasconde simultanea-
mente sia i Pannelli sia 
il Filmstrip.

T Nasconde la Barra degli 
Strumenti. 

F Alterna le tre modalità 
d i v i sua l i z zaz ione : 
s che rmo s tandard , 
schermo intero, scher-
mo intero senza menu.

COMANDO* 
+ S

E’ la scorciatoia della 
funzione Metadata > 
Save Metadata to File. 
Serve a salvare i dati 
XMP direttamente sul 
file.

*Il tasto Comando su Mac equivale al tasto 

CTRL su Windows.

PER INIZIARE...

I brevi paragrafi che seguono illu-

strano sinteticamente come svolgere 

con Photoshop Lightroom le principali 

operazioni generali che ogni fotografo 

esegue quotidianamente nel proprio 

flusso di lavoro.

Molti di questi argomenti sono ulte-

riormente approfonditi nella sezione 

seguente di questo stesso capitolo de-

dicata ai Pannelli del Modulo Library.

Come si può inserire il proprio 
marchio sull’interfaccia di 
Photoshop Lightroom?

Photoshop Lightroom è persona-
lizzabile al punto che ogni foto-
grafo può sostituire il nome del 
software personalizzandolo con il 
proprio nome o marchio. Il 
comando per farlo si trova nel 
menu Edit > Identity Plate Setup 
su Windows (Lightroom > Identity 
Plate Setup su Mac). 
Dalla finestra di dialogo che 
compare è anche possibile per-
sonalizzare i pulsanti dell’in-
terfaccia determinandone font, 
dimensione e colori. Si consiglia 
tuttavia di privilegiare sempre 
tinte neutre per non viziare la 
percezione cromatica delle im-
magini. 
Per applicare le modifiche all’in-
terfaccia occorre selezionare l‘op-
zione Enable Identity Plate.

Adattare l’area di lavoro 
per VISUALIZZARE le foto 
in diverse modalità

Come in tutti i programmi Adobe 

l’interfaccia è ridimensionabile libera-

mente consentendo una ridistribuzione 

delle aree occupate dai vari elementi tale 

da conformarsi perfettamente all’utilizzo 

che si fa del software nelle varie fasi del-

la post-produzione.

Miniature

Per visualizzare e scorrere veloce-

mente molte immagini simultaneamente 

si può utilizzare il Filmstrip disponibile in 

ogni Modulo o la modalità di visualizza-

zione Grid (griglia) disponibile dal Mo-

dulo Library. 

Per variare la dimensione delle 

miniature:

• Nel Filmstrip occorre spostarsi con 

il cursore lungo il bordo del “rullino” e 

trascinare verso l’alto;

• Nella modalità Grid si utilizza inve-

ce l’apposito cursore Thumbnails posto 

sulla Barra degli Strumenti.

Da qualunque Modulo, attraverso la 

scorciatoia da tastiera G si passa velo-

cemente alla Library in modalità Grid.

[23]
Testi e immagini: © Marianna Santoni - www.mariannasantoni.biz

http://www.mariannasantoni.biz
http://www.mariannasantoni.biz


Foto grandi, una alla volta

Per osse rva re accura tamente 

un’immagine alla volta si può utilizzare la 

modalità Loupe (lente).

Per destinare il massimo spazio alle 

immagini mantenendo a disposizione i 

Pannelli laterali basta posizionarsi con il 

cursore lungo il bordo interno di un qua-

lunque Pannello, fare clic e trascinare

Zoom

Per esaminare accuratamente ele-

menti come la nitidezza, il rumore e la 

messa a fuoco è necessario zoomare su 

alcuni dettagli. Per passare velocemente 

dalla modalità Loupe alla visualizzazione 

al 100% dell’immagine si fa clic diretta-

mente sull’immagine.

Su sfondo nero, bianco o grigio

Durante la scelta delle immagini è 

particolarmente utile la visualizzazione in 

modalità “luce spenta” (attivabile con la 

scorciatoia da tastiera L) che consente 

di osservare le immagini su fondo mo-

nocromatico riducendo la distrazione 

arrecata dall’interfaccia. Questa funzione 

è disponibile in tutte le modalità di visua-

lizzazione su uno o più file selezionati. 

Attraverso il comando dal menu 

Preferences > Interface > Lights Out si 

può sostituire lo sfondo nero con altri 

toni in scala di grigio e intervenire sul-

l’opacità.

A pieno schermo

Per visualizzare le immagini a pieno 

schermo senza l’ingombro di alcuni 

elementi dell’interfaccia si può:

• Nascondere i Pannelli o il Filmstrip 

facendo clic sul triangolino bianco po-

sto ai margini dell’interfaccia;

• Nascondere tutti i Pannelli simul-

taneamente utilizzando la scorciatoia da 

tastiera TAB;

• Nascondere tutti i Pannelli e il 

Filmstrip simultaneamente utilizzando la 

scorciatoia SHIFT + TAB.

Non appena si sposta il cursore 

verso il margine laterale o inferiore del-

l’interfaccia i Pannelli il Filmstrip tornano 

nuovamente disponibili.

Inoltre si può minimizzare ulterior-

mente l’interfaccia utilizzando la scorcia-

toia da tastiera F
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ORDINARE gli scatti 
e la sequenza

Raddrizzare le foto

Per raddrizzare velocemente gli scatti 

orizzontali e verticali basta fare clic sul-

l’icona freccia che appare sulla Barra 

degli Strumenti in modalità Loupe o in 

basso a destra sulle miniature in modali-

tà Grid. 

Personalizzare la successione

degli scatti

Per modificare l’ordine di visualizzazione 

delle immagini si può utilizzare il menu 

Sort disponibile nella Barra degli Stru-

menti.

E’ anche possibile personalizzare 

l’ordine delle immagini trascinandole 

manualmente, ma solo se queste si 

trovano in una Collection o nella Quick 

Collection.

Come si possono riordinare 
velocemente le proprie imma-
gini se si è realizzato un servi-
zio fotografico con diverse fo-
tocamere e gli orari non erano 
sincronizzati?

Quando si verifica una situazione 
di questo tipo, se si organizzano 
le immagini per data di scatto, 
l’ordine delle foto non torna chia-
ramente a posto. E’ quindi neces-
sario modificare il metadato che 
memorizza questa informazione.

Per farlo si può utilizzare la fun-
zione relativa al Capture Time 
nel Pannello Metadata. 
Di seguito la procedura da segui-
re:
• Selezionare gli scatti dei quali si 
intende modificare la data e/o 
l’orario di scatto;
• Fare clic sull’icona Edit Capture 
Time posta alla destra del meta-
dato Capture Time nel Pannello 
Metadata
• Dalla finestra di dialogo che si 
apre modificare la data e l’orario.

Gli orari e le date di tutte le foto 
selezionate vengono adattati pro-
porzionalmente.

Raggruppare scatti simili

Spesso capita di avere aver effettua-

to una sequenza di scatti afferenti una 

stessa situazione. Oppure, ad esempio, 

di aver realizzato una serie di foto per 

realizzare un’immagine panoramica.

In casi come questi, per evitare che 

una ridondanza di fotogrammi affolli 

inutilmente la visione d’insieme del ser-

vizio fotografico, può risultare molto utile 

utilizzare gli Stack che consentono di 

impilare le foto le une sotto le altre rac-

chiudendole in una sorta di cartellina 

virtuale.

Per creare uno Stack manualmente:

• selezionare due o più immagini;

• fare clic su una di esse con il tasto 

destro (CTRL + clic su Mac);

• selezionare la funzione Stacking > 

Group into Stack.

Per creare Stack automaticamente 

basati sul tempo intercorso tra un foto-

gramma e l’altro fare clic su un’immagi-

ne qualunque e scegliere la funzione 

Stacking > Auto-Stack by Capture Time. 

Dalla finestra di dialogo che appare è 

possibile determinare il tempo che  deve  

intercorrere tra un fotogramma e l’altro 

affinché questi vengano raggruppati in 

uno Stack.

Uno Stack può essere contratto o 

espanso facendo clic sul piccolo rettan-

golo posto in alto a sinistra sulla miniatu-

ra. Su questo rettangolo è presente an-

che il numero di fotogrammi raggruppati 

nello Stack. Per stabilire quale foto stia a 

capo dello Stack, attivarla facendoci clic 

prima di creare o contrarre lo Stack.
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CONFRONTARE diverse 

foto simultaneamente

Confrontare più immagini tra loro

In genere, anche grazie al senso di 

libertà provocato dell’assenza del rullino, 

si tendono a scattare sempre più imma-

gini, spesso anche utilizzando la funzio-

ne dello scatto continuo. Questo fa sì 

che in fase di selezione, ci si ritrova a 

confrontare molti fotogrammi simili tra 

loro, tra i quali scegliere il migliore non è 

sempre facile.

In questi casi sono disponibili due 

diverse modalità per il confronto.

La modalità Compare View (con-

fronto) consente di visualizzare un’im-

magine, confrontandole con le altre. 

L’immagine Select posta a sinistra mo-

stra la foto che si seleziona con il curso-

re. L’immagine Candidate posta a destra 

mostra, uno alla volta, le altre immagini 

potenzialmente valide, che possono 

essere a l te rna te spos tandos i su l 

Filmstrip con le frecce della tastiera. 

Grazie allo Zoom posto in basso sulla 

Barra degli Strumenti si possono visua-

lizzare le due immagini anche al 100% 

per metterne a confronto, ad esempio, il 

punto di messa a fuoco.

La modalità Survey View (ispezione) 

mette invece a confronto due o più im-

magini simultaneamente per averne un 

punto di vista globale. 

Facendo clic sulla X posta in basso 

a destra è possibile escludere alcuni 

scatti dalla visualizzazione.

Confrontare l’immagine “prima” 

e “dopo” le regolazioni

La modalità Cycles between before 

and after views (confronta prima e do-

po) è disponibile nella Barra degli Stru-

menti del Modulo Develop e permette di 

mettere a confronto la stessa l’immagine 

prima e dopo le regolazioni effettuate.

(vd. pag. 51)

Selezionare 

e CLASSIFICARE le foto

Photoshop Lightroom offre diverse 

funzioni per selezionare le immagini 

creando una graduatoria e applicando 

dei contrassegni distintivi. Classificando 

le foto con bandiere, stelle e etichette 

colorate è possibile selezionarle rapida-

mente e, al contempo, ottimizzare al 

meglio la loro catalogazione all’interno 

del proprio archivio.

Oltre alle scorciatoie illustrate di 

seguito, il comando per assegnare ban-

diere, stelle e etichette colorate è anche 

disponibile nel menu Photo:
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> Set Rating (assegna una classifica con 

le stelle);

> Set Flag (assegna bandiera);

> Color Label (assegna etichetta colora-

ta).

Inoltre altri criteri molto validi per 

organizzare e ritrovare facilmente le pro-

prie immagini sono costituiti dall’asse-

gnazione di Keywords (parole chiave) e 

dati IPTC.

Bandiere

Le bandiere sono adatte ad una 

scelta generale di primo livello.

Pick (scorciatoia da tastiera P) as-

segna una bandiera bianca, adatta per 

le immagini che sono valide.

Rejected (scorciatoia da tastiera X) 

assegna una bandiera nera, simbolo 

adatto per gli scatti che vanno eliminati.

Unflagged (scorciatoia da tastiera 

U) si utilizza per rimuovere una delle due 

bandiere dall’immagine.

Stelle

Le stelle rappresentano uno stru-

mento più accurato di classificazione 

qualitativa delle immagini. In generale 

più alto è il numero delle stelle che si 

associano ad una foto migliore è l’im-

magine. I numeri della tastiera da 1 a 5 

consentono di assegnarle con estrema 

praticità. Oppure si può fare clic su uno 

dei 5 puntini presenti sotto l’anteprima 

dell’immagine. Per togliere qualunque 

classificazione da una o più immagini 

basta selezionarle e digitare il tasto zero 

della tastiera.

Etichette colorate

Le etichette colorate sono un livello 

di classificazione ancora più scrupoloso 

che si fonda principalmente su un con-

cetto di classificazione tipologica. 

Ognuno può assegnare ai vari colori la 

valenza che preferisce, in base alla tipo-

logia del proprio flusso di lavoro. Ad 

esempio, chi si occupa di fotografia di 

matrimonio, può assegnare un colore ad 

ogni fase della giornata: casa della spo-

sa Rosso - Red - (scorciatoia da tastiera 

5), cerimonia Giallo - Yellow - (scorcia-

toia da tastiera 6), foto in location Verde 

- Green - (scorciatoia da tastiera 8), ri-

storante Blu - Blue - (scorciatoia da ta-

stiera 9), foto di gruppo Viola - Purple - 

(per il colore viola non è attualmente 

disponibile una scorciatoia da tastiera). 

Oppure i colori possono anche essere 

molto utili per dividere le tipologie di 

soggetto, in modo da essere facilitati ad 

esempio nel ritrovare velocemente certi 

scatti o aggiornare il proprio portfolio. In 

questo senso, ad esempio, può essere 

utile pensare di assegnare un colore ai 

ritratti, un altro agli still life, un altro an-

cora ai paesaggi e così via...

Applicare le 

IMPOSTAZIONI con un clic

Questa funzione è stata introdotta 

nella versione 1.1 di Adobe Photoshop 

Lightroom grazie all’inserimento del 

nuovo Painter Tool disponibile nella 

Barra degli Strumenti. Facendo clic sul-

l’icona della bomboletta spray appare 

un menu pop-up Paint dal quale è pos-

sibile determinare le impostazioni si in-

tendono “spruzzare” sulle immagini. 

Con il Painter Tool è possibile applicare 

parole chiave (Keywords), etichette colo-

rate (Label), bandiere (Flag), classifiche 

con le stelle (Rating), metadati (Metada-

ta), Presets del Modulo Develop (Set-

tings), e perfino ruotare le immagini (Ro-

tation). 

Per applicare velocemente queste 

impostazioni su diverse immagini in po-

co tempo basta fare clic e trascinare lo 

strumento sopra le miniature, proprio 

come se si trattasse di uno spray.

VISUALIZZARE i file 

IN MODO SELETTIVO

attraverso i filtri

La funzione Filters (filtri) serve a 

visualizzare solo le immagini che ri-

spondono a certi requisiti nascondendo 

temporaneamente le altre. Facendo clic 

sui pulsanti disponibili è possibile isolare 

le foto in base alla tipologia di bandiere, 

stelle e/o colori assegnata ai file durante 

la fase di selezione e classificazione. 

Facendo clic sull’icona che riproduce un 

interruttore, posta all’estremità destra è 

possibile disabilitare temporaneamente il 

filtro lasciandone però immutate le im-

postazioni. Dalla versione 1.1 di Photos-

hop Lightroom è stato anche aggiunto 

un nuovo pulsante che permette di vi-

sualizzare con un solo clic tutte le Virtual 

Copies (copie virtuali) presenti in un 

certo gruppo di immagini. L’ultimo pa-

rametro sulla destra, Master Photos,  

(immagini principali) permette invece di 

visualizzare solo la versione mastro di 

una serie di Virtual Copies.

Altre tipologie di filtri possono esse-

re applicate anche attraverso il Pannello 

Keyword Tags e il Pannello Metadata 

Browser che consentono di visualizzare 

velocemente tutte le immagini contenen-

ti una certa parola chiave o un certo 

metadato. 
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RITROVARE uno o più file 

all’interno dell’archivio

Diverse funzioni all’interno di Pho-

toshop Lightroom permettono di esegui-

re ricerche in modo più o meno avanza-

to ed accurato in base alle caratteristi-

che dei singoli file.

Il Pannello Find offre indubbiamente 

i controlli più avanzati, basati sul nome 

del file, la data di scatto, e diverse altre 

caratteristiche. 

Il Pannello Keyword Tags rintraccia 

le foto contenenti specifiche parole chia-

ve assegnate dal fotografo.

Il Pannello Metadata Browser è una 

sistema di ricerca che si fonda sui meta-

dati incorporati nel file automaticamente  

dalla fotocamera in fase di scatto. 

La funzione Filters (vd. paragrafo 

precedente) esegue invece rapide ricer-

che per genere di foto.

In ogni caso però è essenziale tene-

re presente che ogni ricerca risulta tanto 

più efficace quanto più accurato e scru-

poloso è l’inserimento delle informazioni 

necessarie da parte del fotografo.

Ciascuna delle funzioni sopra elen-

cate esamina sempre il gruppo di foto 

che appare nel Filmstrip al momento 

della ricerca. Se si desidera ritrovare 

un’immagine all’interno dell’intero archi-

vio occorre selezionare All Photograph 

dal Pannello Library posto in alto a de-

stra nel Modulo Library.

Queste funzioni saranno meglio 

approfondite nella sezione dedicata ai 

Pannelli della Library.

Attivare o SELEZIONARE

una o più immagini

In Photoshop Lightroom esistono 

diversi gradi e modalità di attivazione/se-

lezione di una o più immagini. A secon-

da della modalità attiva in un determina-

to momento le regolazioni che si ese-

guono potrebbero agire su una o più 

immagini simultaneamente.

• Quando una miniatura non è sele-

zionata la sua cella è di colore grigio 

scuro;

• Quando si fa clic su una miniatura 

essa si seleziona e la sua cella diventa di 

colore bianco;

• Quando si selezionano una o più 

immagini, dopo averne già selezionata 

una, queste appaiono grigio chiaro;

• Quando si passa con il cursore 

sopra le miniature, il Pannello Navigator 

ne mostra un’anteprima, ma l’immagine 

non è realmente attiva.

Infine quando si selezionano più 

immagini all’interno del Modulo Library 

le modifiche agiscono su tutti i file simul-

taneamente, ad esclusione delle regola-

zione del Pannello Quick Develop, che 

vanno sincronizzate con il pulsante 

Sync.

All’interno del Modulo Develop, in-

vece, tutte le modifiche vengono sempre 

applicate solo alla prima immagine sele-

zionata. Per applicare le stesse regola-

zioni a più foto simultaneamente, evitan-

do la sincronizzazione attraverso il pul-

sante Sync, occorre premere il tasto 

CTRL (Comando su Mac) e fare clic sul 

pulsante Auto Sync che prende il posto 

del comando Sync.

Inoltre, la selezione di una o più 

immagini sul Filmstrip ha validità solo nei 

Moduli Library, Develop e Print. All’inter-

no dei Moduli Slideshow e Web la pre-

sentazione o la photogallery vengono 

sempre e comunque create con tutte le 

immagini che appaiono sul Filmstrip.

CANCELLARE 

una o più immagini

Per rimuovere le immagini da Pho-

toshop Lightroom basta selezionare uno 

o più file e premere il tasto Backspace/

Canc della tastiera. Appare quindi una 

finestra di dialogo che consente di spe-

cificare se si intendono rimuovere (Re-

move) le immagini dalla Library, la-

sciando gli originali intatti nella loro po-

sizione, oppure cancellarle definitiva-

mente (Delete from Disk) spostandole 

nel cestino. Scegliendo il pulsante Can-

cel l’operazione viene annullata.

Se invece si intende rimuovere un 

intero Folder (clic con il tasto destro - o 

CTRL + clic per gli utenti Mac - sul no-

me della cartella e scegliere l’opzione 

Delete) le immagini vengono rimosse 

dalla Library, ma rimangono archiviate 

nel loro supporto di memoria.

Se si rimuove una Collection, una 

Quick Collection o alcune delle foto in 

esse contenute le immagini rimangono 

sia nel supporto di memoria sia all’inter-

no della Library, localizzate nel Folder 

cui appartengono.
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I Pannelli del 

Modulo Library

Caratteristiche generali dei Pan-

nelli

Per espandere o contrarre i Pan-

nelli si fa clic sulla barra che contiene il 

nome del Pannello.

Per nascondere alcuni Pannelli dal-

l’interfaccia si fa clic con il tasto destro 

(CTRL + clic su Mac) sul nome del Pan-

nello e si scelgono i Pannelli da nascon-

dere sul menu pop-up.

Per visualizzare un solo Pannello 

alla volta in modo che tutti gli altri si 

chiudano automaticamente e simulta-

neamente: fare clic sopra il nome del 

Pannello (una sola volta) tenendo pre-

muto il tasto ALT. Questa modalità è mol-

to utile per evitare di affollare l’interfac-

cia. Ripetendo l’operazione la visualizza-

zione ritorna come di default. La stessa 

funzione è comunque disponibile dal 

menu contestuale di ciascun Pannello 

scegliendo l’opzione Solo Mode.

All’interno dei Pannelli (siano essi 

Folders, Collections, Keyword Tags, Pre-

sets, Snapshots, ecc) posso essere 

creati o eliminati diversi elementi (come i 

singoli Folder o Template) utilizzando i 

pulsanti +/–. Inoltre tutti, ad eccezione 

di quelli relativi agli Snapshots e alla 

History, possono essere organizzati in 

modo gerarchico trascinando gli  uni 

dentro gli altri. I Templates (dei Moduli 

Slideshow, Print e Web) vengono invece 

aggiunti o rimossi utilizzando i pulsanti 

Add e Remove.

Il Pannello NAVIGATOR

Il Pannello Navigator posto in alto a 

sinistra è molto simile al Navigatore di 

Photoshop anche se presenta caratteri-

stiche più evolute. Questo pannello è 

disponibile anche nel Modulo Develop. 

Negli altri tre Moduli invece prende il suo 

posto il Pannello Preview.

I piccoli pulsanti in alto a destra 

consentono di visualizzare l’immagine 

con diversi rapporti di ingrandimento 

predefiniti:

• Fit (adatta allo schermo) visualizza 

l’immagine nella sua interezza adattan-

done la dimensione in rapporto allo spa-

zio disponibile nell’area del contenuto 

(vd. immagine a pag. 4);

• Fill (adatta all’area del contenuto) 

permette all’anteprima di riempire com-

pletamente l’area  disponibile per la vi-

sualizzazione dell’immagine;

• 1:1 visualizza la foto al 100%. Se ne 

consiglia l’utilizzo per una verifica imme-

diata e precisa di nitidezza, punto di 

messa a fuoco, rumore digitale, artefatti, 

aberrazioni cromatiche, ecc;

• 3:1 visualizza l’immagine al 300% per 

interventi particolarmente mirati e accu-

rati;

Nel piccolo menu contestuale sono di-

sponibili altre 8 modalità diverse di 

visualizzazione. I rapporti di ingrandi-

mento sono calcolati in multipli pari (es.: 

100%, 50%, 25%) per evitare gli artefatti 

visivi derivanti dall’uso di decimali in fase 

di zoom.

Facendo clic sull’immagine si alter-

nano le modalità di visualizzazione Fit o 

Fill con l’ultima modalità utilizzata. 

L’anteprima del Navigator offre inol-

tre una previsualizzazione per:

• L’effetto dei Presets sull’immagine nel 

Modulo Develop;

• L’anteprima di alcune funzioni, stru-

menti e regolazioni come ad esempio il 

White Balance Selector (strumento bi-

lanciamento del bianco), il Crop Overlay 

Tool (strumento taglierina) e i vari stadi 

dei Pannelli Snapshots e History nel Mo-

dulo Develop;

• L ’antepr ima de l la min ia tura de l 

Filmstrip sopra la quale si trova il curso-

re.

Il Pannello LIBRARY

Il pannello Library è una sorta di 

riepilogo generale dal quale è possibile 

monitorare lo stato attuale dell’archivio.

 All Photographs (tutte le foto): 

permette di accedere a tutte le foto im-

portate nella Library.

Quick Collection (collezione Velo-

ce): permette di creare e visualizzare 

velocemente una raccolta temporanea di 

immagini concepita per un utilizzo prov-

visorio. E’ il caso ad esempio di quando 

si devono produrre alcune ristampe di 

immagini facenti parte di progetti diversi: 

il gruppo di foto che viene creato in que-

ste situazioni ha un’utilità momentanea 

perché, una volta stampate, non hanno 

ragione di rimanere in memoria come 

criterio organizzativo. 

I file possono essere aggiunti alla 

Quick Collection in diversi modi: 

• Per trascinamento;

• Utilizzando la scorciatoia da tastie-

ra “B”;

• Facendo clic sul pallino posto in 

alto a destra sulle miniature delle imma-

gini. 

Non si possono creare simultanea-
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mente diverse Quick Collection: data la 

sua valenza provvisoria può esisterne 

soltanto una alla volta. Non appena svol-

ta la sua funzione la si può svuotare 

cancellandone i file (le immagini rimar-

ranno comunque nei Folder e nelle 

eventuali Collections). Se necessario, 

può essere trasformata in una normale 

Collection selezionando le immagini in 

essa contenute e trascinandole sopra il 

nome di una Collection.

Previous Import (ultima importazio-

ne): visualizza l’ultimo gruppo di foto 

importate.

Already in Library (già nella Libra-

ry): mostra i file che erano già presenti 

nella Library quando si è cercato di im-

portarli nuovamente durante l’ultima 

importazione. E’ bene ricordare che 

Photoshop Lightroom non consente di 

importare più volte uno stesso file.

Previous Export as Catalog (pre-

cedente importazione come Catalog): 

mostra le ultime immagini importate co-

me Catalog.

Missing Files (file mancanti): mostra 

tutti i file nella Library dei quali si è perso 

il collegamento all’originale. Solitamente 

si tratta di immagini che sono state can-

cellate fuori dall’interfaccia di Photoshop 

Lightroom utilizzando il sistema operati-

vo (delle quali Photoshop Lightroom 

continua a tenere in memoria l’antepri-

ma e le modifiche applicate ad esse) 

oppure di immagini presenti su un hard 

disk esterno momentaneamente scolle-

gato.

Il Pannello FIND 

Il Pannello Find (trova) permette di 

eseguire una ricerca avanzata sull’intera 

Library utilizzando i metadati contenuti 

nelle immagini. La ricerca può essere 

eseguita digitando nel campo Text una o 

più informazioni testuali oppure attivan-

do l’opzione Date che consente di sele-

zionare le foto trascinando i cursori lun-

go la linea temporale, in modo da re-

stringere il lasso di tempo cui la data di 

creazione delle immagini si riferisce.

Il Pannello FOLDERS 

Il Pannello Folders (cartelle) è una 

rappresentazione fedele della posi-

zione esatta che le immagini importa-

te nella Library occupano all’interno 

del supporto di memoria nel quale 

sono archiviate, sia esso l’hard disk del 

computer, un hard disk esterno, un CD, 

un DVD o altro (ad esclusione dei ser-

ver). Facendo clic sul nome di una car-

tella appaiono tutte le foto contenute in 

essa e all’interno delle relative sottocar-

telle.

Il Pannello Folders visualizza sol-

tanto le cartelle delle immagini importa-

te, quindi, all’interno dell’hard disk po-

trebbero essere presenti altre che non 

sono mai state importate nella Library. 

Inoltre può avvenire che Photoshop Li-

ghtroom mostri l’anteprima di file che 

non risiedono più su alcun supporto di 

memoria. In questo caso sulle miniature 

compare un piccolo punto interrogativo 

e il programma non trovando il file origi-

nale, non consente di eseguire regola-

zioni di sviluppo su questo tipo di im-

magini, sebbene ne conservi in memoria 

l’anteprima e le correzioni. Visualizzando 

questo tipo di file all’interno del Modulo 

Develop compare il messaggio The file 

could not be opened. 

Uno stesso file con lo stesso nome 

non può essere presente in più Folders 

e dunque non può essere importato più 

di una volta. 

Ogni qualvolta si esegue uno spo-

stamento di file o cartelle il Pannello Fol-

ders e il supporto di memoria che con-

tiene le immagini si sincronizzano auto-

maticamente, sia che le modifiche ven-

gano eseguite all’interno del programma 

sia che vengano eseguite dal desktop 

del computer. In pratica, se in Photoshop 

Lightroom viene trascinato un Folder 

all’interno di un altro, verrà effettuato 

uno spostamento fisico anche nel sup-

porto di memoria dove risiedono le im-

magini. Se invece effettua lo spostamen-

to di una cartella direttamente su que-

st'ultimo (ove modificabile) la sua posi-

zione viene automaticamente aggiornata 

allorché si fa clic sul suo nome all’inter-

no della Library. I file contenuti nelle 

cartelle rosse non sono modificabili fino 

a quando non vengono localizzati.

 Attraverso Photoshop Lightroom i 

Folders possono essere:

• Rinominate con un doppio clic 

sul nome;

• Riorganizzate in una gerarchia 

logica di contenuti trascinando le une 

all’interno delle altre;

• Aggiunte, creandone di nuove, 

facendo clic sul pulsante “+”;

• Cancellate, facendo clic sul pul-

sante “–“. In questo modo le immagini 

vengono rimosse dalla Library, ma la 

cartella e i file originali rimangono sul 

supporto di memoria.

[30]
Testi e immagini: © Marianna Santoni - www.mariannasantoni.biz

http://www.mariannasantoni.biz
http://www.mariannasantoni.biz


Un Folder appare di colore rosso 

quando Photoshop Lightroom non è in 

grado di localizzarla. Questo può verifi-

carsi se una cartella viene spostata nel 

cestino dal desktop del computer oppu-

re quando il supporto di memoria che 

archivia gli originali è scollegato. Non 

appena un supporto, come un hard disk 

esterno, viene nuovamente collegato al 

computer, il programma localizza le car-

telle in modo automatico. Questa opera-

zione si può anche avviare manualmente 

facendo doppio clic sul nome di una 

cartella rossa.

In alternativa, la localizzazione può 

essere eseguita nei seguenti modi:

• Fare clic con il tasto destro (CTRL 

+ clic su Mac) sul nome della cartella e 

scegliere l’opzione Locate Missing Fol-

der;

• Fare clic sul piccolo punto interro-

gativo che compare sulla sua miniatura. 

In questo caso Photoshop Lightroom 

mostra la posizione nella quale si trova-

vano le immagini al momento dell’impor-

tazione e offre l’opportunità di localizzar-

le manualmente. 

Quando un Folder appare di colore 

grigio nessuna immagine è presente al 

suo interno.

All’interno di un Folder non è possi-

bile personalizzare l’ordine delle imma-

gini trascinandole. Per farlo è necessario 

creare una Collection.

Quante foto ci sono in un Fol-
der?

Il numero posto sulla destra del 
nome dei Folder indica il numero 
delle foto in esso contenute. Se le 
immagini sono state raggruppate 
in Stacks il contatore considera 
una singola foto e affianco al 
numero appare il simbolo del + 
che lo segnala. Non appena si 
espande lo Stack il contatore 
ricalcola il numero effettivo degli 
scatti.

Il Pannello COLLECTIONS

Questo Pannello consente di creare 

raccolte virtuali di immagini, chiamate 

Collections (collezioni) che, diversamen-

te dai Folders, offrono un’organizzazio-

ne trasversale delle foto. In questo 

modo una stessa immagine può essere 

presente in diverse Collections senza 

venire fisicamente duplicata o spostata 

dalla sua posizione originale. 

I nomi o la gerarchia delle Collec-

tions viene memorizzata solo all’interno 

del database di Photoshop Lightroom 

senza modificare la posizione o il nome 

delle cartelle che contengono i file origi-

nali.

Creare una Collection può tornare 

utile quando si devono raggruppare tra 

loro foto appartenenti a diversi progetti. 

Ad esempio le Collections sono un otti-

mo sistema per tenere sempre aggiorna-

to il proprio portfolio: un fotografo può 

infatti crearne diverse in base ai generi 

fotografici nell’ambito dei quali lavora 

(ritratto, paesaggio, still life, reportage, 

ecc) e di volta in volta può trascinarvi le 

immagini migliori (ad esempio classifica-

te con 4 o 5 stelline) relative ad un de-

terminato genere, evitando di occupare 

spazio sull’hard disk con superflue du-

plicazioni. Oppure può essere utile crea-

re una Collection quando si vuole per-

sonalizzare l’ordine delle immagini o 

quando si vogliono creare slideshow o 

photogallery.

Per aggiungere una o più foto ad 

una Collection basta selezionarle e tra-

scinarle sopra il nome di quest’ultima. 

Se si rimuove un’intera Collection o i file 

in essa contenuti le immagini rimangono 

comunque all’interno del Folder di origi-

ne.

Anche le Collections così come i 

Folders possono essere create o elimi-

nate attraverso i tasti +/– e possono 

essere organizzate in modo gerarchico 

trascinandole le une sopra le altre.

Cosa accade se si modifica 
un’immagine che è presente 
nella Quick Collection o in di-
verse Collections?

Quando si esegue una qualun-
que modifica (parole chiave, bi-
lanciamento del bianco...) su un 
file presente in diverse Collections 
o nella Quick Collection questo 
file risulta automaticamete modi-
ficato ovunque esso si trovi all’in-
terno della Library.
Se si desidera però avere una 
stessa foto interpretata in vari 
modi in diverse collezioni (ad 
esempio a colori in una Collection 
e in bianco e nero in un’altra) si 
può utilizzare la funzione Virtual 
Copies.

Il Pannello KEYWORD TAGS

Il Pannello Keywords (parole chiave) 

visualizza in ordine alfabetico tutte le 

parole chiave che nel tempo sono state 

associate alle immagini, sia in fase di 

importazione sia direttamente dal Pan-
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nello Keywording.

Anche in questo caso è possibile 

creare una struttura gerarchica trasci-

nando le parole chiave le une sulle altre 

in modo da creare un’organizzazione 

logica e fruibile. Ad esempio, per un 

fotografo naturalista, anziché affollare il 

primo livello con parole chiave relative a 

diverse specie di fiori sarà più utile inse-

rirle all’interno di una chiamata “fiori” 

collocata all’interno di un’altra chiamata 

“natura” la quale magari potrebbe ospi-

tare anche un altro sottogruppo di paro-

le chiave chiamato “animali”.

Per assegnare una parola chiave ad 

una o più immagini basta selezionarle e 

trascinarle su quest’ultima.

Facendo clic su una delle parole 

chiave vengono visualizzate automati-

camente tutte le immagini dell’intera 

Library cui questa è stata associata. Fa-

cendo clic su una o più immagini all’in-

terno della Library vengono segnalati 

con un segno di spunta tutti i Keyword 

Tags associati alle immagini selezionate. 

Con il segno “–”, invece, vengono se-

gnalate tutte le parole associate solo ad 

alcune delle immagini selezionate in 

quel momento.

Anche i Keyword Tags come i Fol-

ders e le Collections possono essere 

creati o eliminati attraverso i tasti +/–. 

Rimuovendo o rinominando una parola 

chiave, questa sarà automaticamente 

rimossa o rinominata nei metadati di 

tutte le immagini.

Il Pannello METADATA BROWSER

Questo Pannello consente di ese-

guire ricerche veloci sull’intera Library 

sfruttando principalmente i metadati 

che la fotocamera inserisce nei file al 

momento dello scatto. In questo modo, 

anche coloro che non sono soliti utilizza-

re criteri avanzati e scrupolosi di catalo-

gazione, come le parole chiave e i dati 

IPTC, possono comunque eseguire ri-

cerche avanzate sfruttando i metadati 

già incorporati.

Da questo pannello è possibile ese-

guire ricerche in base a:

• Camera: il tipo di fotocamera con 

la quale è stata realizzata la foto. Questo 

parametro, può risultare molto utile an-

che per avere un riscontro fedele ed 

oggettivo dell’effettivo utilizzo di certe 

attrezzature rispetto ad altre.

• Lens: il tipo di ottica utilizzata per 

lo scatto. Spesso, quando un fotografo 

cerca una certa immagine, può non ri-

cordare dove o quando ha realizzato la 

foto, ma è facile che abbia bene in men-

te se si tratta di uno scatto eseguito con 

un grandangolo o con un teleobiettivo.

• File Type: il tipo di file, a scelta tra 

quelli importati (e importabili): JPG, 

RAW, DNG, PSD, TIFF.

• Aperture: l’apertura del diafram-

ma utilizzata per realizzare la foto.

• Shutter Speed: il tempo di posa 

impostato sulla fotocamera al momento 

dello scatto.

• ISO Speed Rating: il valore ISO.

• Date: la data di creazione delle 

immagini, con il richiamo all’anno, al 

mese e al giorno.

• Location: il luogo nel quale sono 

state scattate le foto. Questo parametro 

prende in considerazione sia l’informa-

zione presente nel dato IPTC Location 

sia le coordinate GPS (qualora la foto-

camera ne sia dotata) che vengono as-

segnate automaticamente in fase di 

scatto.

• Creator: l’autore delle foto. Que-

sto parametro prende in considerazione 

il metadato Creator, che viene assegnato 

direttamente dalla fotocamera opportu-

namente configurata (consultare il ma-

nuale d’uso) o compilato manualmente 

in post-produzione anche dal Pannello 

Metadata. Particolarmente utile per le 

agenzie e gli studi nei quali collaborano 

diversi fotografi.

• Label: l’etichetta colorata asse-

gnata ai file in fase di selezione.

Nel Pannello Metadata Brow-
ser si possono selezionare di-
versi parametri simultanea-
mente?

Per selezionare diversi parametri 
simultaneamente, ad esempio per 
cercare tutte le foto scattate con 
una certa fotocamera in un de-
terminato arco di tempo, basta 
selezionare un parametro e poi 
selezionare i successivi facendo 
clic tenendo premuto premuto il 
tasto CTRL (Comando su Mac).
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Il Pannello HISTOGRAM

Questo Pannello visualizza in modo 

dinamico l’istogramma dell’immagine 

selezionata e alcuni dei più significativi 

dati EXIF relativi allo scatto.

Il Pannello QUICK DEVELOP

Il Pannello Quick Develop (sviluppo 

veloce) è, a tutti gli effetti, una versione 

ridotta e semplificata di alcune delle 

principali regolazioni disponibili all’inter-

no del Modulo Develop.

Se si esegue una modifica da que-

sto Pannello la si ritrova anche nel Mo-

dulo Develop, dal quale, se necessario, 

può essere ancora perfezionata oppure 

annullata.

L’utilità di questi pratici comandi 

risiede nella possibilità da un lato di per-

fezionare molto velocemente immagini 

già buone, dall’altro di intervenire su 

problematiche legate alla luminosità e al 

colore già al momento della scelta, in 

modo da visualizzale correttamente e, 

volendo, sondarne già in fase di selezio-

ne gli eventuali margini di correzione. 

Può capitare ad esempio che proprio la 

foto dove il soggetto ha un’espressione 

migliore sia venuta più scura delle altre, 

per cui può essere utile poter valutare da 

subito, già in fase di selezione, se il re-

cupero dell’esposizione di quello scatto 

darà comunque un risultato soddisfa-

cente.

Queste regolazioni, essendo in tutto 

e per tutto analoghe a quelle presenti 

nel Modulo Develop, sono trattate e ap-

profondite nel capitolo dedicato a que-

sto Modulo.

Come si possono utilizzare in 
modalità Quick Develop altre 
regolazioni utili come Sharpen 
e Saturation?

Tenendo premuto il tasto ALT la 
regolazione dedicata a Clarity si 
trasforma in Sharpness e quella 
dedicata a Vibrance diventa Sa-
turation.

Il Pannello KEYWORDING

Il campo di testo disponibile in que-

sto Pannello mostra le parole chiave 

associate ad una o più immagini sele-

zionate e permette l’inserimento, la can-

cellazione o la sostituzione manuale di 

una o più parole chiave separandole con 

una virgola. Questo tipo di modifiche 

aggiorna automaticamente l’elenco di-

sponibile nel Pannello Keyword Tags. 

Quando si selezionano più immagini un 

asterisco appare affianco alle parole 

chiave che sono associate solo ad alcu-

ne di queste. Mentre si digita una parola 

chiave appare un menu contestuale che 

visualizza le parole chiave con la stessa 

radice già presenti nel database del pro-

gramma.

Anche in questo caso è possibile 

creare e salvare comodi Keyword Set 

(gruppi di parole chiave) che rimangono 

poi sempre disponibili per essere nuo-

vamente associati a servizi fotografici 

della stessa tipologia.

Come si rinominano i file?

All’interno di Lightroom è possibi-
le rinominare i f i le in diversi 
modi:
1 - In fase di importazione e di 
esportazione, all’interno delle 
finestre di dialogo dedicate, utiliz-
zando il comando File Naming 
che consente di rinominare uno o 
più file simultaneamente. Nella 
Finestra Import questa funzione 
appare solo con le opzioni File 
Handling > Copy/Move.
2- Nella Library si può invece 
modificare il metadato File Na-
me disponibile nel Pannello Me-
tadata. Per rinominare un singolo 
file basta digitare il nuovo nome 
nel campo di testo. Per rinomina-
re diversi file in batch si fa invece 
clic sull’icona posta sulla destra. 
Attraverso il menu File Naming > 
Edit è possibile personalizzare il 
nome dei file con la massima 
accuratezza.
Attenzione! Modificando il nome 
dei file all’interno della Library va 
a modificarsi anche il nome dei 
file originali. Se si rinominano i 
file utilizzando un altro software 
Photoshop Lightroom aggiorna 
automaticamente il nome delle 
immagini all’interno della Library.
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Il Pannello METADATA

Questo Pannello, molto simile al suo 

omonimo già presente in Adobe Bridge, 

consente di visualizzare i metadati 

dell’immagine e di eseguire diverse ope-

razioni legate ad essi.

I metadati caratterizzati da un cam-

po di testo consentono di inserire o 

modificare le informazioni manualmente. 

La freccia bianca, posta sulla de-

stra di alcuni metadati, permette invece 

di eseguire alcune operazioni consen-

tendo di utilizzare i metadati come crite-

rio di ricerca. Ad esempio facendo clic 

sulla freccia a destra del valore ISO 

Speed Rating vengono automaticamente 

selezionate tutte le foto scattate alla 

stessa velocità ISO, tra le immagini pre-

se in esame.

Inoltre altri metadati possono essere 

modificati in batch attraverso una fine-

stra di dialogo dedicata, come ad esem-

pio quella relativa al File Name.

Cosa sono i metadati?

I metadati sono informazioni sul 
file e contengono informazioni 
come la dimensione del file, lo 
spazio colore, le impostazione 
della fotocamera al momento 
dello scatto, il copyright, il softwa-
re con il quale è stato manipolato 
e molto altro ancora.
Alcuni di questi dati vengono 
salvati sul file già al momento 
dello scatto dalla fotocamera 
stessa.
Adobe Photoshop Lightroom con-
sente di sfruttare i metadati dei 
file per:
• Eseguire ricerche avanzate at-
traverso il Pannello Metadata 
Browser;
• Visualizzare, modificare o ag-
giungere metadati attraverso il 
Pannello Metadata;
• Registrare tutti gli interventi 
eseguiti nel Modulo Develop, 
tramite l'esportazione delle istru-
zioni XMP.

Inoltre consente di rimuovere dal 
file tutti i metadati sensibili (come 
l'orario di scatto, la fotocamera 
utilizzata ecc.) in fase di esporta-
zione attraverso la funzione Mi-
nimize Embedded Metadata. In 
questo modo vengono registrate 
solo le informazioni relative al 
copyright.

Inoltre dal menu Preset > Edit Pre-

sets è possibile creare Presets di dati 

IPTC che possono essere salvati  grazie 

al comando Save Current Settings as a 

New Preset. In questo modo rimangono 

sempre disponibili nel relativo menu 

contestuale e, una volta selezionati, ap-

plicano automaticamente interi gruppi di 

metadati su una o più immagini selezio-

nate. Gli stessi Presets compaiono an-

che nel relativo menu a comparsa di-

sponibile nella finestra di dialogo del-

l’importazione.

Come si elimina dalla lista un 
Metadata Preset?

Quando un Preset o un qualun-
que Template personalizzabile 
non è eliminabile dall’interfaccia 
del programma si può rimuovere 
manualmente.
 
• Su Mac: utente/Libreria/Appli-
cation Support/Adobe/Lightroom.

• Su Windows: C:\Documents 
and setting\utente\Dati applica-
zioni\Adobe\Lightroom.

Se il percorso indicato sopra non 
corrisponde a quello del proprio 
computer si consiglia di utilizzare 
il sistema operativo per eseguire 
la ricerca di uno qualunque dei 
Presets, in modo da rintracciarne 
il percorso.
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Come si proteggono le 
immagini con il copyright?

Come ha avuto più volte modo di 
ribadire lo stesso Roberto Tome-
sani, Presidente dell’Associazione 
Nazionale Fotografi Professionisti 
Tau Visual, non occorre effettuare 
alcun deposito di immagini, né 
essere iscritti in elenchi, albi o 
associazioni. In effetti, il solo esse-
re autori di un'immagine fa già 
godere del diritto d’autore, che 
è previsto per legge. Tuttavia è 
sempre buona norma salvare nei 
metadati dell’immagine il proprio 
nome accompagnato dall’anno 
di produzione dell’immagine e 
dal simbolo del copyright.

In Photoshop Lightroom è possibi-
le inserire tali informazioni sul 
campo di testo chiamato Copy-
right.
Inoltre, dalla versione 1.1 è stata 
inserita all’interno del Pannello 
Metadata una nuova funzione 
chiamata Copyright Status che 
permette di “marchiare” la pro-
pria foto scegliendo l’opzione 
Copyrighted. In questo modo il 
simbolo del copyright viene salva-
to nei metadati e, aprendo l’im-
magine in Photoshop, compare il 
simbolo copyright sulla barra 
superiore dell'immagine, accanto 
al nome del file.

Come si fa il simbolo del copy-
right © ?

Su Macintosh: ALT + C.
Su Windows: ALT+0169 (in caso 
di necessità verificare in Accessori 
> Utilità di sistema > Mappa 
caratteri).

    

Adobe Photoshop Lightroom 
e Google Maps 

Alcune tra le fotocamere digitali 
più evolute e recenti consentono 
di registrare nei metadati del-
l’immagine le coordinate GPS 
relative al luogo in cui è avvenuto 
lo scatto. Questa informazione, 
quando presente nel file, compa-
re automaticamente nella lista dei 
metadati. Se si fa clic sulle coor-
dinate da un computer connesso 
a Internet, Photoshop Lightroom è 
in grado di lanciare automatica-
mente Google Maps visualiz-
zando la foto satellitare del punto 
esatto del globo in cui è stato 
realizzato lo scatto! 
Questa funzione, indubbiamente 
avveniristica e divertente, trova in 
realtà la sua maggiore utilità nel-
l’ambito della fotografia scientifi-
ca e di documentazione.

La Barra degli 

Barra degli STRUMENTI

Le funzioni relative alla Barra degli 

Strumenti sono state trattate nella sezio-

ne iniziale di questo capitolo dal titolo 

“PER INIZIARE...” (vd. pag. 23).
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IL MODULO DEVELOP 
“SVILUPPARE” LE FOTO IN UNA “CAMERA CHIARA”

Il Modulo Develop è il vero cuore del programma: un’autentica camera 
oscura, anzi “chiara”, con tutto ciò che si potrebbe sognare per l’ottimiz-
zazione delle immagini digitali.
In questo Modulo è integrata l’ultima versione del plug-in Adobe 
Camera RAW, qui riorganizzato e corredato di nuove funzioni, per of-
frire un controllo semplice ma accurato senza distinzioni di formato. In 
Photoshop Lightroom infatti i file in formato RAW, JPG, TIF e PSD vengono 
gestiti allo stesso modo e con le stesse funzioni, e possono essere modifi-
cati simultaneamente, perfino se di formati diversi tra loro.
Da un punto di vista qualitativo Adobe Photoshop Lightroom si fonda 
sugli stessi algoritmi del plug-in Adobe Camera RAW, per cui i risultati che 
si ottengono con l’utilizzo dei due software sono praticamente identici. 
Se si esegue l’esportazione dei dati XMP da Photoshop Lightroom, è pos-
sibile visualizzare le modifiche eseguite con il Modulo Develop anche su 
tutti gli altri software Adobe che sfruttano il plug-in Camera RAW 3.7 e 
successive versioni. Attualmente la massima compatibilità si ha con la 
versione 4.1.
Nel Modulo Develop è possibile eseguire le seguenti operazioni:
• Ottimizzare la luminosità, il contrasto e i colori delle foto grazie a 
controlli molto avanzati, intuitivi e veloci;
• Convertire un’immagine in bianco e nero e applicare viraggi;
• Controllare la nitidezza dell’immagine attraverso controlli sulla resa 
dei dettagli, l’attenuazione del rumore, le aberrazioni cromatiche e 
la vignettatura;
• Raddrizzare e ritagliare le immagini;
• Eseguire alcune operazioni basilari di fotoritocco relative alla rimozio-
ne di macchie e occhi rossi;
• Creare un profilo colore per la propria fotocamera.

IN QUESTO CAPITOLO:

I PANNELLI DEL MODULO DEVELOP 
• Il Pannello Navigator
• Il Pannello Presets
• Il Pannello Snapshots
• Il Pannello History
• Il Pannello Histogram
• Il Pannello Basic
• Il Pannello Tone Curve
• I Pannelli HSL / Color / Grayscale
• Il Pannello Split Toning
• Il Pannello Detail
• Il Pannello Lens Corrections
• Il Pannello Camera Calibration

LA BARRA DEGLI STRUMENTI
• Visualizzare il “prima” e il “dopo”
• Tagliare e raddrizzare
• Correggere gli occhi rossi
• Rimuovere le imperfezioni
• Sincronizzare più immagini

INTEGRAZIONE TRA LIGHTROOM E 
PHOTOSHOP
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SCORCIATOIE DA TASTIERA:

Attualmente le scorciatoie da tastiera di 
Photoshop Lightroom non sono personaliz-
zabili.
Molti tasti di questo software supportano il 
long press behavior: tenendoli premuti 
prolungatamente si attiva la funzione loro 
associata per poi disattivarsi non appena si 
rilascia il pulsante. Nella modalità di visua-
lizzazione provvisoria è comunque possibile 
lavorare usando il mouse normalmente.

COMANDO* 
+ E

Equivale al comando 
Edit in Photoshop.

1-5 Assegnano un nume-
ro equ i va len te d i  
Stelle.

6-9 Assegnano etichette 
di colore rosso, gial-
lo, verde, blu.

R Visualizza l’immagine 
in Crop Mode, atti-
vando lo strumento 
per il ritaglio.

N Attiva lo strumento  
Remove Spots.

D Attiva la modalità di 
visualizzazione stan-
dard Loupe View.

*Il tasto CTRL su Windows equivale al tasto 

Comando su Mac. 

I Pannelli del 

Modulo Develop

L’interfaccia di Photoshop Lightroom 

presenta i comandi nell’ordine ideale in 

cui le regolazioni andrebbero eseguite, 

ed è in questo modo che si consiglia 

quindi di esplorarli ed utilizzarli.

In questo Modulo tanti piccoli ac-

corgimenti sono stati implementati con il 

solo scopo di rendere l’utilizzo di Pho-

toshop Lightroom il più semplice possi-

bile, anche per i fotografi meno esperti 

di post-produzione digitale. Un esempio 

di questo approccio è offerto dalla colo-

razione di tutti i cursori, così come la 

riprogettazione in maniera più intuitiva di 

comandi “storici” come le Curve.

I Pannelli posti sulla sinistra del 

Modulo Develop sono destinati all’appli-

cazione (Presets), al salvataggio (Sna-

pshots) e alla visualizzazione (History) di 

gruppi di regolazioni o stadi di lavora-

zione dell’immagine.

I Pannelli posti invece sulla destra 

offrono controlli molto accurati per ese-

guire regolazioni mirate e impeccabili in 

modo manuale, attraverso specifici cur-

sori.

Perchè a volte sull’immagi-
ne appare il messaggio The 
file could not be opened e le 
funzioni sono disattivate?

Quando nel Modulo Develop, 
sulla parte superiore dell’imma-
gine, compare questo messaggio, 
tutte le funzioni del Modulo Deve-
lop sono disattivate, i cursori ap-
paiono in grigio e sulla miniatura 
appare un punto interrogativo.
Questo avvertimento indica che il 
programma non riesce a loca-
lizzare il file originale. In que-
sti casi il software visualizza l’an-
teprima dell’immagine alla risolu-
zione e qualità conservata in 
memoria, ma non è in grado di 
eseguire modifiche su di essa.

Il Pannello NAVIGATOR

E’ analogo a quello descritto nel 

Modulo Library.

In quali casi le immagini pos-
sono apparire già modificate 
malgrado non siano ancora 
state eseguite regolazioni?
Come si può evitare?

I cursori del Modulo Develop pos-
sono apparire modificati prima 
ancora che il fotografo abbia 
eseguito le sue regolazioni se:
• L’immagine è stata preceden-
temente aperta in Adobe Photos-
hop, con Bridge o con altre appli-
cazioni che utilizzano il plug-in 
Camera RAW;
• All’immagine è stato applicato 
un Preset automaticamente, in 
fase di importazione, dal menu 
Develop Settings. Da questo me-
nu, anche scegliendo il Preset 
None all’immagine viene comun-
que applicato un leggero contra-
sto che la rende più brillante e 
piacevole.
• All’immagine è stato applicato 
un Preset tramite il relativo Pan-
nello di sinistra.
In fase di importazione o all’in-
terno del Modulo Develop basta 
selezionare il Adobe Adobe Pho-
toshop Lightroom Presets > Gene-
ral - Zeroed per annullare qua-
lunque regolazione.
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Il Pannello PRESETS

I Presets (gruppi di impostazioni 

preconfigurate) servono a salvare gruppi 

di impostazioni in modo da poterli appli-

care ad altre immagini.

Alcuni Presets predefiniti (Lightroom 

Presets) sono già disponibili con l’instal-

lazione del programma ed offrono di per 

sé risultati soddisfacenti. E’ possibile 

eliminarli o aggiungerne altri personaliz-

zati facendo clic sui pulsanti “+” e “-” in 

alto a destra del pannello. Come impo-

stazione predefinita ogni nuovo Preset 

viene aggiunto al gruppo User Presets, 

in ordine alfabetico, ma è anche possibi-

le creare nuovi gruppi tematici di Preset 

personalizzati in modo da ritrovarli più 

velocemente (vd. figura in alto). Ogni 

nuovo Preset rimane nella lista fino a 

quando non viene rimosso manualmen-

te utilizzando il pulsante “-”. L’organizza-

zione dei Presets e dei Templates in 

gruppi è stata introdotta nella versione di 

Photoshop Lightroom 1.1 e offre il van-

taggio di poter accede rapidamente alle 

proprie impostazioni personali senza 

affollare inutilmente l’interfaccia con Pre-

sets dei quali temporaneamente non si 

ha bisogno.

Muovendo il cursore sopra i nomi 

dei Presets la miniatura del Pannello 

Navigator si aggiorna, mostrando un’an-

teprima dell’effetto.

Paragonabili per certi versi alle pelli-

cole usate nella fotografia analogica, i 

Presets consentono in pratica di caratte-

rizzare una o più immagini con una serie 

di effetti o regolazioni ottenibili usando i 

Pannelli di destra. 

I Presets sono ideali per snellire 

flussi di lavoro con centinaia di immagi-

ni. In molti casi, se l’immagine non pre-

senta particolari problematiche, il suo 

“sviluppo” può tranquillamente conside-

rarsi concluso con la semplice assegna-

zione di uno dei Presets. In altre situa-

zioni più complesse si può scegliere di 

considerare i Presets come una comoda 

base dalla quale partire per andare poi 

ad intervenire manualmente sull’imma-

gine, regolazione dopo regolazione, 

grazie ai Pannelli posti sulla destra. Per 

questa ragione tutti i Presets disponibili 

nel Modulo Develop possono essere 

applicati, anche in fase di importazione 

con il comando Develop Settings dispo-

nibile sulla finestra di dialogo Import 

Photos.

A tale scopo può essere molto utile 

creare alcuni Presets per le curve di con-

trasto o di viraggio usate più frequente-

mente, per il bianco e nero, o per la ca-

librazione della fotocamera. In qualun-

que momento è comunque possibile 

riportare l’immagine al suo aspetto ori-

ginale selezionando Lightroom Presets 

> General - Zeroed.

Dove vengono salvati i Pre-
sets e come si possono con-
dividere tra diversi computer 
o con altri utenti?

Per installare Presets su altri com-
puter o condividerli con altri utenti 
occorre spostare manualmente il 
file relativo (identificato dall'esten-
sione .lrtemplate) nella cartella 
predefinita.
Per localizzare la posizione dei 
Presets nel proprio computer ba-
sta fare clic con il tasto destro su 
Windows (CTRL su Mac) sul nome 
del Preset all’interno del relativo 
Modulo e scegliere l’opzione 
Show in Explorer su Windows 
(Show in Finder su Mac).

Come si annullano rapida-
mente le regolazioni svolte su 
una o più immagini?

Per annullare tutte le rego-
lazioni applicate alle imma-
gini e tornare alle impostazioni 
predef in i te d i Photoshop L i-
ghtroom selezionare il pulsante 
Reset.

Per tornare all’immagine 
originale così come è stata ge-
nerata dalla fotocamera e senza 
alcun tipo di regolazione selezio-
nare Lightroom Presets > Ge-
neral - Zeroed.

Per annullare solo alcuni tipi 
di regolazioni premere il tasto 
ALT e fare clic sopra il nome del 
gruppo di regolazioni, ad esem-
pio su Tone, che diventa Reset 
Tone.

Per annullare i singoli cursori fare 
doppio clic sul nome della 
regolazione o sul cursore.

Per annullare l’ultima operazione 
utilizzare la scorciatoia da tastiera 
CTRL + Z (Comando + Z su 
Mac).

Per risalire ad un certo stadio di 
lavorazione utilizzare il Pannello 
History del modulo Develop.

Per disattivare tempora-
neamente gruppi di impo-
stazioni utilizzare l’icona che 
rappresenta un interruttore di-
sponibile in alto a sinistra sulla 
maggior parte dei Pannelli.
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Il Pannello SNAPSHOTS

Il Pannello Snapshots (istantanee) 

serve a salvare un certo stadio di lavora-

zione dell’immagine. Questa funzione 

può essere utile per salvare diverse 

versioni della stessa foto o anche per 

salvare le fasi principali di lavorazione 

di un’immagine (vd. figura in alto). In 

questo modo è possibile risalire ad esse 

velocemente evitando di ripercorrere 

tutte le singole operazioni elencate nel 

Pannello History. Gli Snapshots sono 

simili alle Istantanee presenti nel Pannel-

lo Storia di Photoshop, ma, a differenza 

di questo, rimangono in memoria per 

sempre, fino a quando non vengono 

rimosse manualmente utilizzando il pul-

sante “-” in alto a destra sul Pannello.

Passando con il cursore sopra i no-

mi degli Snapshots, il Pannello Navigator 

ne mostra un'anteprima.

Come si creano diverse ver-
sioni di una stessa foto?

Per creare diverse versioni della 
stessa immagine, variando ad 
esempio, i colori, il taglio o il 
contrasto, si possono creare Sna-
pshots o Virtual Copies.

Gli Snapshots equivalgono alle 
istantanee già note agli utenti di 
Photoshop e si possono creare e 
visualizzare solo nel Modulo De-
velop con il relativo Pannello.

Le Virtual Copies sono invece 
delle copie virtuali dei file che si 
gestiscono in maniera indipen-
dente e compaiono nel Filmstrip 
all’interno di ogni Modulo. Si 
possono creare facendo clic con il 
tasto destro (CTRL + clic su Mac) 
sulle miniature del Filmstrip oppu-
re in modalità Grid o anche in 
modalità Loupe. In alternativa si 
può utilizzare la scorciatoia da 
tastiera CTRL + ‘ (Comando + ‘ 
su Mac).
Tutte le Virtual Copies possono poi 
essere velocemente visualizzate 
grazie all’apposito pulsante di-
sponibile nella Barra dei Filters.

Entrambe queste funzioni offrono 
il grande vantaggio di non dupli-
care il file originale e quindi oc-
cupano pochissima memoria.

Infine c’è la funzione dal menu 
Photo > Edit in che consente di 
creare una copia del file originale 
o di sovrascriverlo aprendolo 
direttamente in Photoshop o con 
altre applicazioni.

Il Pannello HISTORY

Il Pannello History (storia), molto 

simile al suo omonimo presente in 

Adobe Photoshop, tiene traccia delle 

operazioni che si eseguono sull’im-

magine aggiungendo un nuovo stadio 

ad ogni modifica apportata. La prima 

informazione memorizzata è sempre 

quella relativa alla data e all’ora dell’im-

portazione dell’immagine, oppure della 

creazione della Virtual Copy, oppure 

ancora della creazione del file in seguito 

ad un'esportazione verso altre applica-

zioni (Edit in External Application). L’or-

dine di visualizzazione degli stadi è cro-

nologico, ma è invertito rispetto a quello 

cui Adobe Photoshop ci ha abituati.

Passando con il cursore sopra ai 

vari stadi il Pannello Navigator ne mostra 

un'anteprima.

Anche nel Modulo Develop emergo-

no evidenti i vantaggi offerti dalla logica 

dei Catalogs. Infatti oltre all’editing non 

distruttivo il Pannello History ne trae in-

dubbi vantaggi conservando tutti - ma 

proprio tutti - gli stadi di lavorazione del-
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l’immagine durante le diverse sessioni di 

lavoro. In effetti, la History rimane 

sempre in memoria, anche dopo che il 

programma è stato riavviato.

La Storia è “infinita”... 
gli Undo no!

Photoshop Lightroom consente 
virtualmente una quantità infinita 
di Undo (CTRL + Z su Windows / 
Comando + Z su Mac). E’ bene 
però ricordare che questi, a diffe-
renza della History, non sono più 
disponibili dopo che il program-
ma è stato chiuso e riavviato.

Come si evita che il Pannello 
History si affolli oltre misura?

Proprio perché la History, oltre ad 
essere eterna, è anche virtual-
mente infinita, va considerato il 
fatto che, nel caso di post-produ-
zioni complesse, potrebbe affol-
larsi oltre misura risultando diffici-
le da consultare. Per questa ra-
gione può essere strategico utiliz-
zare gli Snapshots. Ogni volta che 
si arriva ad un certo stadio di 
lavorazione dell’immagine  si può 
creare uno Snapshot in modo da 
conservare quella fase di lavoro 
e, volendo, cancellare la History 
(Clear) per ripartire da capo.

Il Pannello HISTOGRAM

L’istogramma è un grafico che rap-

presenta la distribuzione dei toni nel-

l’immagine correntemente selezionata. 

A sinistra ci sono le ombre, al centro i 

mezzitoni, a destra le luci. Se una foto 

non presenta un istogramma “pieno” 

(che sfrutta cioè tutta la gamma dai neri 

ai bianchi), l’immagine potrebbe risultare 

sottoesposta, sovraesposta oppure priva 

di bianchi puliti e neri profondi. Natural-

mente l’aspetto dell’istogramma è sem-

pre fortemente legato ai toni e ai colori 

propri degli elementi rappresentati nel-

l’ immagine, per cui ad esempio, un 

sfondo completamente nero oppure 

bianco condiziona sensibilmente il modo 

in cui va interpretato.

Il Pannello Histogram offre un isto-

gramma di ultima generazione dinamico 

e interattivo: appena viene effettuata una 

qualunque regolazione si aggiorna in 

tempo reale. Inoltre può perfino essere 

manipolato manualmente: muovendo il 

cursore sopra l’istogramma appare infat-

ti una segnalazione relativa alle quattro 

aree tonali cui corrispondono i comandi 

delle regolazioni del gruppo Tone. Basta 

fare clic e trascinare il cursore verso 

destra o sinistra per modificare la distri-

buzione dei toni dell’immagine in modo 

assolutamente visivo!

I due triangoli posti negli angoli in 

alto visualizzano sull’immagine l’avver-

timento delle alte luci e delle ombre pro-

fonde (vd. pag 43).

Sotto l’istogramma sono sempre 

disponibili alcuni dei dati EXIF più signifi-

cativi relativi allo scatto.

Il Pannello BASIC

Nel Pannello Basic (base) si trovano 

raggruppati tutti i cursori destinati alle 

regolazioni complessive di toni e colori.

Se un’immagine non presenta parti-

colari problematiche questo Pannello è 

spesso sufficiente ad ottimizzarne al 

meglio l’aspetto generale senza alcuna 

necessità di ricorrere ad ulteriori regola-

zioni.

La prima opzione Treatment (trat-

tamento) consente di stabilire da subito 

se si intende trattare l’immagine come 

una foto a colori (Color) o in bianco e 

nero (Grayscale). A seconda della mo-

dalità selezionata vengono attivati Pan-

nelli e regolazioni specifiche.
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WB - Bilanciamento del Bianco

In prima posizione si trovano i co-

mandi per il White Balance (bilancia-

mento del bianco) che può essere ese-

guito in vari modi a seconda delle carat-

teristiche dell’immagine. Ben in vista c’è 

lo strumento White Balance Selector  

(selettore del bilanciamento del bianco) 

che si attiva come un normale pulsante. 

Spostandosi sull’immagine e facendo 

clic su un pixel appartenente ad un ele-

mento di colore neutro (preferibilmente 

grigio chiaro) la foto viene automatica-

mente bilanciata. Passando con il mou-

se sull’immagine si può vedere sul Pan-

nello Navigator un’anteprima del risul-

tato. La visione ingrandita dei singoli 

pixel offerta da questo strumento per-

mette di selezionare con precisione il 

pixel più adatto. In alcuni casi infatti, se 

la foto è stata scattata con valori ISO 

elevati o l’unico elemento sul quale fare 

clic è un’area piuttosto scura questa 

potrebbe presentare del disturbo digita-

le. Grazie a questo ingrandimento è 

possibile evitare quei pixel cangianti di 

colorazione verde, rosso o blu intenso il 

cui colore è influenzato dal disturbo di 

croma (causato da sottoesposizioni o da 

ISO elevati) e non da una dominate uni-

forme provocata da una specifica fonte 

di luce. 

Dal menu a comparsa si può inoltre 

bilanciare il bianco automaticamente 

scegliendo Auto o una delle diverse 

temperature colore (associate alle diver-

se fonti di luce) disponibili dal menu a 

comparsa dedicato. Infine è possibile 

inserire il valore numerico dei gradi 

Kelvin nella casella oppure intervenire 

sulla regolazione delle dominanti attra-

verso i cursori osservando l’immagine 

nelle sue mutazioni. L’opportunità di 

usare gli strumenti del bilanciamento del 

bianco anche su formati di file diversi dal 

RAW (come ad esempio i file JPG) è 

molto utile anche se va tenuto conto del 

fatto che l’efficacia delle regolazioni è 

limitata per i vincoli intrinseci che li carat-

terizzano.

Perché a volte i cursori del 
bilanciamento del bianco 
non visualizzano i gradi 
Kelvin?

I cursori del bilanciamento del 
bianco funzionano in modo di-
verso a seconda che l’immagine 
selezionata sia o meno un file in 
formato RAW. 
Per tutti i file di formato diverso 
dal RAW, come ad esempio i JPG, 
i cursori forniscono valori generici 
(da -100 a +100) e il menu a 
comparsa offre soltanto tre op-
zioni (As Shot, Auto e Custom).

TONE - Interventi tonali

Il secondo gruppo di cursori chia-

mato Tone offre il massimo controllo 

sulla regolazione della gamma, della 

luminosità e del contrasto, consentendo 

di ottenere un istogramma “pieno” e un 

equilibrio ottimale nella distribuzione dei 

toni. I comandi Exposure (esposizione) 

e Blacks (neri), già presenti nelle prece-

denti versioni di Camera RAW con i nomi 

di Exposure (esposizione) e Shadows 

(ombre), regolano rispettivamente il pun-

to di bianco e di nero dell’immagine. I 

valori numerici indicano l’equivalente in 

stop fotografici (+1 corrisponde esatta-

mente a +1 stop impostato in fase di 

scatto).

I cursori Recovery (recupero) e Fill 

Light (luce di schiarita) sono una novità 

lanciata fin dalle Beta di Photoshop Li-

ghtroom, ma risultano familiari agli utenti 

che già utilizzano il comando ombre/luci 

di Adobe Photoshop. Queste regolazioni 

consentono in pratica il ripristino mirato 

solo delle alte luci e delle ombre profon-

de, senza alterare la luminosità di tutti gli 

altri toni dell’immagine. I cursori permet-

tono infatti di riequilibrare i contrasti del-

l’immagine controllando le tonalità ta-

gliate (luci bruciate e ombre troppo 

compatte) segnalate dell’avvertimento 

luci e ombre.

Naturalmente, la capacità di ripristi-

no di questi cursori è fortemente vincola-

ta dall’ampiezza tonale del sensore con 

cui è stata scattata la foto e dal formato 

di salvataggio con il quale la foto è stata 

salvata, tuttavia dai molti test che ho 

personalmente eseguito ho riscontrato 

che la qualità dell’intervento di questi 

cursori è così elevata da poterne trarre 

giovamento nella quasi totalità delle im-

magini. Infatti, soprattutto nel caso di 

immagini sovraesposte, l’uso del curso-

re Recovery può essere una valida alter-
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nativa alla diffusa consuetudine di inibire 

il cursore esposizione (evitando di bru-

ciare le luci), per poi schiarire i mezzitoni 

dell’immagine con la regolazione Bright-

ness. 

Occorre tenere presente però che 

se la scena fotografata presenta un’ec-

cessiva differenza di stop tra le luci e 

le ombre nessun sensore è attualmente 

in grado di catturarne tutti i toni e alcune 

informazioni andranno irreparabilmente 

perdute già in fase di scatto. Indubbia-

mente, scattare in formato RAW, aiuta a 

sfruttare al massimo le reali potenzialità 

della gamma del proprio sensore. Per 

tutti i casi “impossibili” si può utilizzare la 

preziosa funzione HDR integrata in 

Adobe Photoshop già dalla versione 

CS2.

Se si t iene premuto il tasto ALT 

mentre si regolano i cursori Exposure, 

Recovery e Blacks appare una visualiz-

zazione canale per canale, relativa alle 

zone dell’immagine che stanno perden-

do dettaglio, raggiungendo il bianco 255 

(bianco carta) o il nero 0 (nero compat-

to).

La regolazione Brightness (lumino-

sità) corrisponde all’omonimo cursore in 

Camera RAW e consente di regolare i 

mezzitoni dell’immagine, agendo in 

modo molto simile al cursore centrale 

della regolazione Livelli presente in Pho-

toshop. Il cursore Contrast regola inve-

ce il contrasto generale dell’immagine.
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PRESENCE - Vivacità alle immagini

I tre cursori della sezione Presence 

(presenza) intervengono sulla profondità 

e la saturazione dell’immagine resti-

tuendole un rinnovato vigore.

La prima regolazione Clarity (chia-

rezza) è progettata per conferire mor-

dente alle immagini rendendone i detta-

gli più limpidi e “croccanti”. Si tratta di 

una funzione decisamente innovativa, 

molto utile per conferire un certo volume 

e profondità agli elementi della foto. Per 

utilizzare questa regolazione al meglio si 

consiglia di muovere il cursore alternan-

do la visualizzazione dell’immagine da 

Fit a 1:1.

Il cursore Vibrance (brillantezza), 

ereditato dal software RawShooter, ac-

quisito da Adobe nel 2005,  consente di 

ridare vivacità ai colori saturando l’im-

magine in un modo molto simile al con-

cetto di saturazione esperito nella foto-

grafia analogica.

In pratica mentre il comando Satu-

ration satura in modo lineare tutti i colori 

indipendentemente dal loro stato natura-

le di saturazione, il comando Vibrance 

r iempie di vita i colori dando brio e 

energia - in perfetto stile Stock Photo - 

limitando però gli artefatti e senza esa-

sperare gli incarnati.

Perché Photoshop Lightroom 
non visualizza correttamente 
le impostazioni selezionate 
sulla fotocamera in fase di 
scatto?

In generale i RAW Converter si 
possono dividere in due grandi 
categorie: 
• I software prodotti dalle 
case produttrici delle foto-
camere (Digital Photo Professio-
nal della Canon, Nikon Campture, 
Capture One Pro della Phase 
One...)
• I programmi trasversali 
prodotti da software houses 
(Adobe Camera RAW, Adobe 
Photoshop Lightroom, Pixmantec 
RawShooter, Apple Aperture...). 

I software appartenenti alla prima 
tipologia hanno il grande pregio 
di riconoscere tutte le impostazio-
ni assegnate in fase di scatto sulla 
fotocamera, consentendo un flus-
so di lavoro facile e veloce. Di 
contro però sono generalmente 
poveri di funzioni e possono apri-
re un numero limitato di formati 
RAW, spesso ristretto a quelli pro-
dotti dalle proprie fotocamere. 
I software RAW Converter appar-
tenenti alla seconda tipologia 
hanno invece una valenza più 
trasversale consentendo di lavo-
rare in modo più fluido, gestendo 
simultaneamente anche file pro-
dotti da diverse fotocamere. Que-
sti tuttavia non sono in grado di 
riconoscere le impostazioni asse-
gnate alla fotocamera in fase di 
scatto (temperatura colore, con-
trasto, nitidezza, saturazione e 
tonalità colore, stili...).

Quale sia il software migliore con 
cui aprire i propri file RAW è frutto 
quindi di una scelta personale 
basata sulla valutazione accurata 
di fattori importanti quali la quali-
tà dell’immagine che si ottiene, la 
facilità e velocità d’uso, l’ottimiz-
zazione del flusso di lavoro, la 
ricchezza e versatilità di funzioni 
offerte...
Non esiste il software perfetto, ma 
è sicuramente facile trovare quel-
lo che meglio si adatta alle pro-
prie esigenze.
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Perché aprendo lo stesso file 
RAW con Photoshop Lightroom 
e con un altro software si ot-
tengono due immagini diver-
se?

Quando si parla di RAW bisogna 
sempre tenere presente che que-
sto tipo di file “non si apre”, come 
qualunque altro formato, ma “si 
costruisce” al momento dell’aper-
tura.
Per questa ragione va concepito 
come un’immagine latente che 
deve ancora essere “sviluppata”. 
Un po’ come avviene in camera 
oscura con una pellicola impres-
sionata.
Quindi, così come nella fotogra-
fia analogica, al variare degli 
acidi, varia il risultato sull’imma-
gine, così per i file RAW al variare 
del software che li apre varia 
l’immagine che ne risulta. Se si 
prova ad aprire lo stesso file in 
formato RAW con 10 RAW Con-
verter diversi si ottengono 10 
immagini diverse.

Il Pannello TONE CURVE

Il Pannello Tone Curve dedicato alle 

“storiche” Curve sfoggia un’interfaccia 

del tutto nuova, particolarmente intuitiva 

e pratica da usare.

Molti fotografi “freschi di pellicola”, 

non si trovano ancora del tutto a proprio 

agio con comandi “astratti e matematici” 

come le curve. Per questa ragione, in 

Photoshop Lightroom, le curve sono 

state ripensate in chiave parametrica 

offrendo un approccio molto più intuiti-

vo.

Una delle novità più consistenti è 

rappresentata dalla possibilità di mani-

polare la curva usufruendo di punti di 

ancoraggio precostituiti che ne circo-

scrivono e influenzano il comportamen-

to. Passando il cursore sopra la curva 

appare un avvertimento che mostra la 

sezione modificata e la forma che assu-

me in base alla tonalità sulla quale si va 

ad agire. Grazie a queste “briglie invi-

sibili” che dividono la curva in quattro 

sezioni, anche i fotografi meno esperti 

possono intervenire sui mezzitoni del-

l’immagine senza correre il rischio di 

danneggiarla con curve troppo esaspe-

rate. 
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Selezionando lo strumento Targeted 

Adjustment Tool, posto in alto a sinistra 

(vd. figura nella pagina precedente) e 

spostandosi con il cursore sopra l’im-

magine è inoltre possibile:

• Visualizzare sulla curva la segna-

lazione del punto tonale esatto cui ap-

partiene quell’area della foto;

• Fare clic direttamente sull’imma-

gine e, trascinando il cursore in alto o in 

basso, plasmare la curva in modo da 

schiarire o scurire le diverse aree tonali 

dell’immagine.

Infine, per quei fotografi che proprio 

non amano le curve, sono disponibili 4 

cursori che dividono la gamma in 4 re-

gioni (Region): Highlights (luci), Lights 

(colori chiari) , Darks (colori scuri), 

Shadows (ombre).

Grazie a queste implementazioni le 

Curve possono continuare a svolgere la 

loro classica funzione ma in una veste 

ancora più semplice da utilizzare, per-

mettendo di eseguire le regolazioni ne-

cessarie concentrandosi sull’immagine, 

senza preoccuparsi della forma che la 

curva dovrà assumere: sarà Photoshop 

Lightroom a crearla automaticamente. 

I 3 cursori triangolari posti sotto le 

curve sono destinati agli utenti più 

esperti che desiderano personalizzare la 

forma della curva ampliando o restrin-

gendo il campo di intervento dei singoli 

cursori sulle 4 sezioni tonali. 

Infine, come in Camera RAW, anche 

in Photoshop Lightroom sono disponibili 

due curve di contrasto predefinite 

(Point Curve: Medium Contrast / Strong 

Contrast) che possono però essere ap-

plicate anche alla curva che si è appena 

personalizzata.

I Pannelli 

HSL / COLOR / GRAYSCALE

HSL - Affinamenti veloci dei colori

Il Pannello HSL consente di interve-

nire sui singoli colori dell’immagine in 

termini di Hue (tonalità), Saturation (sa-

turazione) e Luminance (luminanza). 

Questo Pannello, simile alla regolazione 

Tonalità/Saturazione di Photoshop, è 

molto utile per eseguire interventi cro-

matici mirati, soprattutto quando il bilan-

ciamento del bianco non è sufficiente a 

soddisfare i nostri intenti.

Anche in questo Pannello, così co-

me nelle curve, è disponibile in alto a 

s i n i s t r a l o s t r u m e n t o Ta r g e t e d 

Adjustment Tool che consente di affina-

re i diversi colori in maniera visiva. 
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COLOR - Interventi mirati sui colori

Il Pannello Color permette di svolge-

re le stesse funzioni di Pannello HSL 

raggruppate per colori.

GRAYSCALE - Conversioni accurate dal 

colore al bianco e nero

Il Pannello Grayscale (scala di gri-

gio) grazie a controlli separati per i sin-

goli colori dell’immagine consente di 

convertire immagini a colori in bianco 

e nero con il massimo controllo, simu-

lando l’uso che si fa dei filtri colorati con 

la pellicola in bianco e nero. Anche in 

questo Pannello è disponibile in alto a 

s i n i s t r a l o s t r u m e n t o Ta r g e t e d 

Adjustment Tool che consente di modi-

ficare i toni del bianco e nero in maniera 

visiva.

La comodità ed efficacia di questo 

nuovo modo di convertire il colore in 

bianco e nero è tale da essere stata im-

plementata anche all’interno di Adobe 

Photoshop CS3 nella funzione Black & 

White (bianco e nero).

Perché su alcune immagini 
elaborate con le regolazioni 
dei Pannelli HSL, Color o 
Grayscale appaiono vistosi 
artefatti?

Questo fenomeno può verificarsi 
quando le regolazioni che si effet-
tuano portano a trasformazioni 
troppo radicali rispetto alle carat-
teristiche del file di partenza. Cer-
care ad esempio di ottenere cieli 
neri “alla Ansel Adams” su file 
con cieli lattiginosi o con un ca-
nale del blu ricco di disturbo, può 
portare a risultati molto scadenti.
Non bisogna mai dimenticare 
che, al di la delle funzioni offerte 
da un programma, la qualità del 
risultato è sempre fortemente 
vincolata dalla gamma e dalla 
qualità del file di partenza. 
Utilizzando file in formato RAW 
molti problemi di questo tipo si 
riducono. Tuttavia, per elabora-
zioni complesse e radicali è sem-
pre consigliabile l’utilizzo di Pho-
toshop che consente interventi più 
mirati grazie all’utilizzo di  sele-
zioni, livelli, canali, regolazioni di 
livello, maschere e molto altro 
ancora.
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Il Pannello SPLIT TONING

Il Pannello Split Toning (divisione 

toni) permette di virare in modo separato 

l e l u c i ( H i g h l i g h t s ) e l e o m b r e 

(Shadows) dell’immagine sia su foto a 

colori sia su immagini in bianco e nero.

Con la regolazione Hue (tonalità) si 

stabilisce il colore verso cui virare l’im-

magine. Con la regolazione Saturation 

(saturazione) se ne determina l’intensità. 

Il cursore Balance (bilanciamento) serve 

invece a modulare il peso di un colore 

rispetto all’altro.

Tenendo premuto il tasto ALT men-

tre si regola il cursore Hue si ha un’an-

teprima istantanea della tinta a piena 

saturazione.

Lo Split Toning può invece essere 

interpretato come una comoda rivisita-

zione del comando Bilanciamento colore 

che in Adobe Photoshop consente di 

ottenere risultati molto simili.

Il Pannello DETAIL

Completamente rinnovato a partire 

dalla versione 1.1 il Pannello Detail (det-

tagli), offre controlli molto accurati per 

l’attenuazione del disturbo digitale (Noi-

se Reduction) e per l’incremento della 

nitidezza dell’immagine (Sharpening).

NOISE REDUCTION - Ridurre il disturbo 

digitale

Anche se l’aspetto e l’intensità del di-

sturbo possono variare a seconda della  
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fotocamera util izzata, va comunque 

considerato che tale fenomeno si mani-

festa principalmente in foto sottoesposte 

e in immagini scattate con valori ISO 

elevati.

I cursori presenti in questo pannello 

consentono di rimuovere il disturbo af-

frontando in modo separato i due feno-

meni che lo caratterizzano: la grana, 

riconducibile alla luminanza (Luminan-

ce) e il problema del rumore di croma 

(Color) che si manifesta attraverso pic-

cole macchie rosse, verdi e blu partico-

larmente vistose nelle aree più scure 

dell’ immagine. L’icona con il punto 

esclamativo che compare in alto a sini-

stra segnala che si sta visualizzando 

l’immagine ad un grado di zoom non 

adatto a queste regolazioni. Un clic su 

questa icona e la visualizzazione del-

l’immagine passa automaticamente al 

100%.

SHARPENING - Enfatizzare i dettagli

Una leggera sfocatura è presente 

nella maggior parte delle immagini digi-

tali a causa del filtro anti-alias presente 

nelle fotocamere digitali.

Il cursore Amount (fattore) controlla 

l’intensità del contrasto sull’immagine.

Il cursore Radius (raggio) stabilisce 

lo spessore in pixel dell’effetto di contra-

sto sulle aree di bordo. A differenza della 

Maschera di Contrasto disponibile in 

Photoshop, il massimo raggio applicabi-

le è di soli 3 pixel. Ancora una volta i 

cursori sono progettati per un utilizzo 

esclusivamente fotografico e, in effetti, 

raramente occorre un raggio superiore a 

1. In effetti, nella maggior parte dei casi, 

se si aumenta troppo il raggio, l'immagi-

ne inizia a mostrare vistosi artefatti.

Il cursore Detail (dettagli) agisce 

soltanto lungo i bordi ad alto contrasto e 

sulle texture. I maggiori beneficiari di 

questa regolazione sono soggetti come i 

paesaggi e le architetture.

Il cursore Masking (mascheratura)  

limita l’effetto dello sharpening alle sole 

aree di bordo, lasciando morbidi e sfu-

mati tutti gli altri dettagli dell’immagine. 

Questa funzione può risultare davvero 

preziosa sulla maggior parte dei ritratti e 

non solo.

Infatti, premendo il tasto ALT mentre 

si regolano i cursori si può monitorare 

con estrema precisione l’effetto reale e il 

tipo di intervento applicato all’immagine.

Il Pannello LENS CORRECTIONS

Il Pannello Lens Corrections (corre-

zioni lente) è simile a quello presente da 

diverse versioni nel plug-in Camera RAW.

CHROMATIC ABERRATION - Ridurre le 

aberrazioni cromatiche

I cursori legati alla funzione Chro-

matic Aberration (aberrazione cromati-

ca) servono a ridurre i sottili aloni di co-

lore cangiante che spesso si manifesta-

no lontano dal centro del fotogramma, 

lungo i bordi ad alto contrasto.
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I cursori Red/Cyan (rosso/ciano) e 

Blue/Yellow (blu/giallo) servono a cor-

reggere il problema manualmente. Le 

opzioni offerte dal menu Defringe (eli-

mina margine) aiutano invece ad inter-

venire in casi particolari. L’opzione Hi-

ghlight Edges riesce ad intervenire sugli 

artefatti di colore magenta che spesso 

compaiono lungo i bordi di aree ecces-

sivamente luminose. L’opzione All Ed-

ges estende invece all’intera immagine 

la correzione dell’aberrazione cromatica 

che, normalmente, esclude l’area centra-

le del fotogramma. Inoltre può essere 

utilizzata con successo anche in tutti 

quei casi in cui l’aberrazione è davvero 

forte e l’intervento con i cursori non offre 

risultati pienamente soddisfacenti.

LENS VIGNETTING - Controllo della vi-

gnettatura

La vignettatura è la perdita di lumi-

nosità che si può verificare ai bordi di 

un’immagine.

Con il cursore Amount (quantità) si 

può regolare il fattore di scurimento, 

mentre con il cursore Midpoint (punto 

medio) si stabilisce se estendere questo 

effetto verso il centro del fotogramma o 

comprimerlo verso gli angoli.

Il Pannello 

CAMERA CALIBRATION

Il Pannello Camera Calibration (cali-

brazione fotocamera) fornisce i cursori 

necessari per profilare la propria foto-

camera digitale a specifiche condizioni 

di luce, tuttavia può anche essere utiliz-

zato per scopi creativi. 

L’utilizzo di questo strumento si 

consiglia solo in casi specifici ed esclu-

sivamente da parte di utenti esperti.
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La Barra degli 

STRUMENTI 

del Modulo Develop

Modalità di VISUALIZZAZIONE e 

confronto PRIMA/DOPO

La prima icona sulla sinistra nella 

Barra degli Strumenti è relativa all’opzio-

ni di visualizzazione standard - Loupe 

( lente). La seconda icona (Cycles 

between before and after views) attiva 

invece un’interessante modalità di visua-

lizzazione che mette a confronto, affian-

cate, le due versioni dell’immagine “pri-

ma e dopo” l’editing, sia orizzontalmente 

sia verticalmente. Facendo clic una se-

conda volta sulla stessa icona l’antepri-

ma si divide a metà mostrando la parte 

trattata e quella originale. Questa opzio-

ne può essere molto utile anche pas-

sando alla visualizzazione 1:1.

Quando si attiva questa funzione 

compaiono sulla Barra degli Strumenti 

altre tre icone che permettono di appli-

care le impostazioni del “prima” alla 

visualizzazione del “dopo” e viceversa, 

oppure di invertirle.
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TAGLIARE e RADDRIZZARE

Il terzo pulsante da sinistra è il Crop 

Overlay (taglierina), dedicato al ritaglio e 

alla rotazione dell’immagine. 

Questo strumento mostra il rettan-

golo di ritaglio sovrapposto all’immagine 

originale. Agganciando con il cursore 

uno dei suoi angoli è possibile modifica-

re la grandezza e la proporzione del 

ritaglio. Posizionandosi invece al di fuori 

dell’area di ritaglio è possibile effettuare 

la rotazione dell’immagine, che può co-

munque essere eseguita anche con il 

cursore Straighten (raddrizza). In alter-

nativa è possibile selezionare l’apposito 

strumento che permette di raddrizzare la 

foto tracciando una retta lungo una linea 

orizzontale (come l’orizzonte) o verticale 

(ad esempio lungo la parete di un edifi-

cio). 

Dal menu a comparsa Aspect Cu-

stom (personalizza la proporzione) è 

possibile impostare diverse proporzioni 

disponibili dal menu o personalizzarle 

selezionando la voce Enter Custom 

(stabilisci la proporzione). L’icona che 

rappresenta il lucchetto serve a blocca-

re o sbloccare la proporzione attuale 

dell’area di ritaglio.

Reset (ripristina) annulla tutte le 

impostazioni di ritaglio riportando l’im-

magine al formato originale.

Da apprezzare infine il fatto che an-

che una funzione semplice come il rita-

glio sia stata reinterpretata in chiave 

fotografica rendendo disponibile in over-

lay, durante il ritaglio, il noto schema 

compositivo della “regola dei terzi”.

 

Per visualizzare l’immagine già ta-

gliata basta tornare alla modalità Loupe 

facendo clic sulla prima icona a sinistra 

sulla Barra degli Strumenti. Naturalmen-

te anche il ritaglio, così come tutti gli altri 

comandi di Photoshop Lightroom, non 

altera in alcun modo l’im-

magine originale e per-

tanto può essere modifi-

cato più volte e anche in 

diverse sessioni di lavoro.

Come si ritagliano le immagini 
ad una specifica dimensione in 
pixel o centimetri?

Con Lightroom è possibile:
• Tagliare un’immagine con una 
specifica proporzione attraverso 
il menu a comparsa Aspect Cu-
stom presente tra le opzioni dello 
strumento Crop Overlay;
• Ricampionare l’immagine ad 
una certa dimensione attraverso 
l’opzione Constrain Maximum 
Size disponibile nella finestra di 
esportazione dei file.

Questo approccio al ritaglio è 
molto utile perché consente di 
concepire la foto come una vera 
e propria matrice svincolata dai 
diversi utilizzi cui nel tempo può 
essere destinata. Una stessa im-
magine infatti, potrebbe essere 
utilizzata per una stampa molto 
grande, per varie ristampe di 
piccolo formato o, magari, anche 
su Internet. In tutti questi casi la 
proporzione cui è stata tagliata 
può essere adattata rapidamente 
a diverse dimensioni, senza alte-
rare la composizione.

Correggere gli OCCHI ROSSI

Il quarto pulsante da sinistra è lo 

strumento Remove Red Eye (rimuovi 

occhi rossi). Il suo utilizzo è semplice, 

basta fare clic al centro della pupilla. 

oppure, partendo dal centro della pupil-

la, trascinare il cursore in modo da trac-

ciare l’area di intervento. In entrambi i 

casi non è necessario essere molto pre-

cisi, infatti, non appena si lascia il clic lo 

strumento si adatta automaticamente 

sull’area da correggere. 

Così come in Photoshop, le opzioni 

Pupil Size (dimensione pupilla) e Dar-

ken (scurisci) consentono di perfeziona-

re l’aspetto della pupilla intervenendo 

rispettivamente sulla tolleranza al rosso 

della pupilla, e sul suo fattore di scuri-

mento.

Per visualizzare l’immagine corretta 

senza la distrazione delle aree di corre-

zione basta tornare alla modalità Loupe 

facendo clic sulla prima icona da sinistra 

sulla Barra degli Strumenti.
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Rimuovere le IMPERFEZIONI

Il quinto pulsante da sinistra è lo 

strumento Remove Spots (rimuovi mac-

chie) ideale per rimuovere velocemente 

piccole imperfezioni di routine come lo 

sporco del sensore o le imperfezioni 

della pelle senza passare a Photoshop.

Questo strumento, tanto facile quan-

to indispensabile, ha una doppia valenza 

che lo rende un ibrido tra il Timbro Clone 

(Clone) e il Pennello Correttivo (Heal) di 

Photoshop. La sua modalità di utilizzo 

evoca invece lo strumento Toppa.

In pratica, con il cursore Cursor Size 

(dimensione del cursore) si determina la 

dimensione dell’area da correggere e 

con lo strumento attivo si fa clic sopra 

l’imperfezione. 

Dopo il clic appaiono due cerchi: uno 

indica l’area da correggere sulla quale si 

è fatto clic, il secondo indica l’area “sa-

na” campionata automaticamente dal-

l’area circostante. Il primo cerchio può 

essere ridimensionato trascinando il 

cursore lungo il bordo della sua circon-

ferenza, mentre l’area di campionamen-

to può essere modificata trascinando il 

secondo cerchio.

Questa funzione è particolarmente 

comoda anche per correggere rapida-

mente lo sporco del sensore su diversi 

fotogrammi simultaneamente. Infatti, una 

volta rimosse le imperfezioni ricorrenti, è 

possibile sincronizzare la rimozione del-

le stesse aree di sporco su decine e 

decine di fotogrammi, selezionandoli e 

sincronizzandoli con il pulsante Sync e 

specificando dalla finestra di dialogo 

Synchronize Settings l’opzione Spot 

Removal. Se il soggetto e l’inquadratura 

dei fotogrammi sincronizzati varia molto, 

potrebbero essere necessarie alcuni 

piccoli aggiustamenti sulle aree prese a 

campione, ma si tratta comunque di un 

grosso aiuto nella velocizzazione del 

proprio flusso di lavoro.

Per rimuovere la visualizzazione dei 

cerchi che indicano le aree corrette ba-

sta tornare alla modalità Loupe facendo 

clic sulla prima icona da sinistra sulla 

Barra degli Strumenti.

SINCRONIZZARE le

regolazioni su più immagini

Per velocizzare al massimo il flusso 

di lavoro Photoshop Lightroom offre la 

possibilità di sincronizzare tutte le re-

golazioni tra due o più immagini sele-

zionate. Ad esempio si può sincronizza-

re il bilanciamento del bianco in gruppi 

di foto scattate sotto la stessa fonte di 

luce, oppure s i può s incronizzare 

l’esposizione su piccoli gruppi di foto 

che presentano la stessa luminosità, 

oppure, come già visto, si possono sin-

cronizzare su più foto le correzioni relati-

ve alle macchie del sensore. 

Una volta eseguita l’elaborazione di 

un’immagine, se si desidera applicare gli 

stessi interventi a più foto basta selezio-

nare dal Filmstrip (o dalla modalità Grid) 

le foto che si intendono uniformare – 

anche centinaia simultaneamente – e poi 

fare clic sul pulsante Sync (nel Modulo 

Develop) o Sync Settings (nel Modulo 

Library) posto in fondo ai Pannelli di 

destra. Questo pulsante apre una fine-

stra di dialogo dalla quale è possibile 

scegliere le impostazioni che si intendo-

no sincronizzare. 

Scegliendo invece il pulsante Pre-

vious (precedente), in fondo ai Pannelli 

di destra nel Modulo Develop, si appli-

cano al fotogramma selezionato le rego-

lazioni eseguite sull’ultimo fotogramma.

Il pulsante Reset (ripristina) riporta 

tutti i cursori alle impostazioni predefinite 

del programma.

Per applicare le stesse regolazioni a 

più foto simultaneamente, evitando la 

sincronizzazione attraverso il pulsante 
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Sync, occorre premere il tasto CTRL 

(Comando su Mac) e fare clic sul pul-

sante Auto Sync che prende il posto del 

comando Sync.

Dopo aver corretto un’imma-
gine è possibile fare in modo  
che altri scatti, eseguiti con 
impostazioni diverse tra loro, 
siano uniformati?

Questa innovativa opportunità è 
stata resa possibile grazie ad 
un’implementazione realizzata 
nella versione 1.1 di Photoshop 
Lightroom.
Questa funzionalità risulta molto 
utile quando si scatta utilizzando 
la misurazione automatica del-
l’esposizione. Infatti tutte le volte 
che si imposta la ghiera della 
fotocamera su su opzioni come P, 
A o S le foto eseguite contestual-
mente e alle stesse condizioni di 
luce possono facilmente risultare 
dissimili tra loro.
In tutti questi casi, una volta cor-
retto uno scatto è possibile uni-
formare l’esposizione delle diver-
se immagini in modo automatico. 
Basta infatti selezionare tutti gli 
scatti partendo da quello corretto 
e scegliere la funzione del menu 
Settings > Match Total Expo-
sure disponibile all’interno del 
modulo Develop. In questo modo 
l’esposizione complessiva di tutte 
le foto selezionate viene unifor-
mata alla prima grazie ad un 
algoritmo che valuta i metadati 
dei file relativi alle impostazioni 
della fotocamera. 
Questa funzione non è natural-
mente efficiente quanto gli occhi 
di un fotografo, ma può costituire 
un grosso aiuto in diverse circo-
stanze.

Come si personalizzano le im-
postazioni predefinite di 
Photoshop Lightroom?

Il pulsante Reset posiziona tutti i 
cursori e le funzioni del software 
alle loro impostazioni predefinite.

E’ possibile personalizzare 
queste impostazioni ed è perfino 
possibile creare impostazioni 
predefinite per specifiche 
fotocamere (basate sul numero 
seriale del corpo macchina) e per 
i valori ISO utilizzati con speci-
fiche fotocamere.
Una volta create queste imposta-
zioni il pulsante Reset posizionerà 
i cursori in base ad esse.

Per creare nuove impostazioni 
predefinite occorre:
• Selezionare dal Modulo Deve-
lop un’immagine alla quale sono 
state associate impostazioni che si 
desidera definire come predefini-
te;
• Tenere premuto il tasto ALT in 
modo da convertire il pulsante 
Reset nel pulsante Set Default;
• Nella finestra di dialogo dedi-
cata è possibile specificare se si 
intendono salvare le nuove impo-
stazioni predefinite (Update the 
Current Settings) o se si desidera 
ripristinare le impostazioni prede-
finite originali del software.

Se si desidera che le nuove impo-
stazioni siano specifiche per il 
modello di fotocamera utilizzato 
per lo scatto selezionato (Make 
defaults specific to camera 
serial number) e per i valori 
ISO utilizzati con quella specifica 
fotocamera (Make defaults 
specific to camera ISO set-
ting) andare sul menu Preferen-
ces > Presets dal quale è possibi-
le attivare tali opzioni.
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Integrazione tra 

Photoshop Lightroom e 

Photoshop

Photoshop Lightroom è molto ben 

integrato con il suo fratello maggiore 

Photoshop. Selezionando il menu Photo 

> Edit in Adobe Photoshop (disponibi-

le solo nei Moduli Develop e Library) si 

può esportare l’immagine all’interno di 

Photoshop per eseguire ad esempio 

operazioni di fotoritocco avanzato. La 

finestra di dialogo che si apre offre 3 

scelte:

• Edit a Copy with Lightroom 

Adjustments apre all’interno di Photos-

hop una copia della foto originale cui 

sono stati applicati gli interventi eseguiti 

in Photoshop Lightroom. Questo file vie-

ne salvato  nella stessa cartella nella 

quale si trova l’originale.

• Edit a Copy crea una copia iden-

tica all’originale (con il suo profilo colo-

re) priva delle modifiche eseguite in Pho-

toshop Lightroom e la localizza all’inter-

no della stessa cartella (non attivo se il 

file originale è in formato RAW).

• Edit Original apre il file originale 

(con il suo profilo colore), privo delle 

modifiche eseguite in Photoshop Li-

ghtroom, e va a sovrascriverlo con le 

modifiche che si eseguono in Adobe 

Photoshop (non attivo se il file originale 

è in formato RAW).

Per le prime due opzioni è disponibi-

le il menu Copy File Options dal quale è 

possibile specificare di volta in volta il 

formato, lo spazio colore e il tipo di 

compressione.

In Photoshop si possono quindi 

eseguire tutte le operazioni di fotoritocco 

necessarie per poi scegliere Salva dal 

menu File. Se si è scelta una delle prime 

due opzioni la copia dell’immagine viene 

automaticamente importata all’interno 

della Library e rinominata con il suffisso 

-Edit. Tale suffisso può essere persona-

lizzato dal menu Preferences > External 

Editing > Edit Externally File Naming.

Se necessario, si possono aprire in 

Adobe Photoshop due o più immagini 

simultaneamente selezionandole dal 

Filmstrip o in modalità Grid.

I colori di una stessa immagi-
ne appaiono diversi in Pho-
toshop Lightroom rispetto a 
Photoshop. Da cosa dipende?

Se i colori di una stessa immagine 
appaiono diversi tra Lightroom e 
Photoshop:
• Tenere presente quanto spiega-
to in questa Guida sulla gestione 
del colore in Lightroom (vd. capi-
tolo “Introduzione all’uso di Li-
ghtroom” a pag. 4).
• Verificare le Impostazioni Colore 
di Photoshop.

Come si passa un’immagine 
da Photoshop Lightroom ad un 
programma di terze parti?

Per aprire un’immagine da Pho-
toshop Lightroom direttamente in 
un altro programma basta impo-
stare l’opzione disponibile dal 
menu: da Preferences > External 
Editing > Additional External Edi-
tor.

Integrazione tra 

Photoshop Lightroom e 

Camera RAW

vd. pag. 17.
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IL MODULO SLIDESHOW 
CREARE VELOCEMENTE PRESENTAZIONI ACCATTIVANTI

Il Modulo Slideshow è interamente dedicato alla creazione di pre-
sentazioni da visualizzare sul monitor, personalizzabili con foto in 
dissolvenza e sfondo musicale.
Questo Modulo non intende sostituire i molti software progettati per 
realizzare presentazioni complesse e sofisticate, ma ha lo scopo prin-
cipale di offrire uno strumento, perfettamente integrato nel flusso di 
lavoro, che consenta di realizzare slideshow in modo semplice e 
veloce per mostrare le proprie foto in modo accattivante.

Nel Modulo Slideshow è possibile eseguire le seguenti operazioni:
• Personalizzare l’aspetto della Slide (impaginazione, colori, 
elementi grafici, ecc) inserendo anche il proprio nome o marchio 
e diverse informazioni relative ad ogni singolo scatto;
• Aggiungere testi e informazioni alle immagini, come ad esempio 
didascalie e metadati;
• Creare e salvare layout di slideshow personalizzati in modo da 
poterli riutilizzare anche successivamente;
• Mostrare la presentazione a pieno schermo o utilizzando un 
secondo monitor;
• Esportare la presentazione in formato PDF per poterla salvare e 
condividere su altri computer.

Inoltre, grazie alla funzione impromptu è possibile avviare la 
presentazione anche dai Moduli Library e Develop per poter visua-
lizzare le immagini a pieno schermo e svolgere su di esse opera-
zioni base (bandiere, stelle, etichette colorate, rotazione, elimina-
zione, ecc) utilizzando le scorciatoie da tastiera.

IN QUESTO CAPITOLO:

I PANNELLI DEL MODULO SLIDESHOW 

• I Pannelli Preview e Template Browser
• Il Pannello Options
• Il Pannello Layout
• Il Pannello Overlays
• Il Pannello Backdrop
• Il Pannello Playback
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*Il tasto CTRL su Windows equivale al tasto 

Comando su Mac.

I Pannelli del 

Modulo Slideshow

I Pannelli posti sulla sinistra del 

Modulo Slideshow sono destinati all’ap-

plicazione di layout predefiniti (Template)  

o al salvataggio di nuovi Template per-

sonalizzati.

I Pannelli posti invece sulla destra 

offrono controlli manuali per modificare 

l’impaginazione, aggiungere testi, infor-

mazioni sugli scatti, scegliere la musica 

e i tempi di dissolvenza delle immagini.

Sotto l’anteprima centrale sono pre-

senti i controlli essenziali per visualizzare 

la presentazione e alcuni strumenti di 

base per la rotazione e l’inserimento di 

testi.

L’anteprima centrale è completa-

mente interattiva e consente di spostare 

i diversi elementi trascinandoli.

Come si personalizza il nu-
mero e la sequenza delle 
immagini?

Per personalizzare l’ordine delle 
immagini trascinandole è neces-
sario che le foto facciano parte 
della Quick Collection o di una 
Collection.

Se si desidera includere solo alcu-
ne foto nella presentazione basta 
invece selezionarle nel Filmstrip.

I Pannelli PREVIEW e 

TEMPLATE BROWSER

Il Pannello Template mette a disposizio-

ne alcuni temi “pronti all’uso” per diver-

se tipologie di Slideshow. 

Analogamente a quanto avviene con 

i Presets e il Pannello Navigator del Mo-

dulo Develop, passando con il mouse 

sopra i diversi Template il Pannello Pre-

view ne visualizza un’anteprima. 

Questi Templates possono essere   

utilizzati velocemente così come sono 

oppure personalizzati trascinando i vari 

elementi sull’anteprima interattiva e uti-

lizzando i cursori disponibili sui Pannelli 

di destra. 

Così come nel Modulo Develop è 

possibile aggiungere nuovi Templates 

personalizzati o rimuovere i preesistenti 

facendo clic sui pulsanti Add e Remove 

posti in fondo ai Pannelli di sinistra.

Il Template scelto viene automati-

camente applicato a tutte le slide della 

presentazione.
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SCORCIATOIE DA TASTIERA:

Attualmente le scorciatoie da tastiera di 
Photoshop Lightroom non sono personaliz-
zabili.
Molti tasti di questo software supportano il 
long press behavior: tenendoli premuti 
prolungatamente si attiva la funzione loro 
associata per poi disattivarsi non appena si 
rilascia il pulsante. Nella modalità di visua-
lizzazione provvisoria è comunque possibile 
lavorare usando il mouse normalmente.

INVIO Avvia il Play.

SPAZIO Mette in Pause.

ESC Termina lo Slideshow.

COMANDO* 
+ J

Equivale al comando  
Export.

COMANDO* 
+ T

Per aggiungere in-
formazioni testuali 
sulle slide.
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Il Pannello OPTIONS

Il Pannello Options consente di spe-

cificare l’aspetto delle immagini nel 

layout della pagina, il bordo e l’ombra: 

caratteristiche generali legate allo stile e 

al genere di presentazione.

Zoom to Fill Frame ingrandisce 

automaticamente l’ immagine fino a 

riempire completamente il quadro sia se 

l’immagine è orizzontale sia se è vertica-

le. Per ricomporre l’inquadratura basta 

trascinare la foto con il cursore sull’an-

teprima centrale.

Stroke Border applica un bordo 

intorno all’immagine del quale è possibi-

le specificare spessore e colore.

Cast Shadow applica un’ombra 

all’immagine e ne controlla l’aspetto 

grazie ad impostazioni dedicate. Opacity 

regola l’opacità. Offset determina la di-

stanza dell’ombra dalla foto. Radius con-

trolla l’estensione rendendola netta o 

molto sfumata. Angle ruota l’angolazione 

cioè la direzione verso cui si proietta.

Il Pannello LAYOUT 

Il Pannello Layout definisce l’impa-

ginazione della presentazione, control-

lando la posizione e la grandezza delle 

immagini.

Show Guides mostra le guide entro 

le quali viene automaticamente posizio-

nata l’immagine. Left, Right, Top e Bot-

tom spostano l’immagine rispettivamen-

te verso destra, verso sinistra, in basso o 

in alto. I quadratini bianchi consentono 

di scollegare tra loro due o più cursori 

rendendoli indipendenti dagli altri.

Esportazione dello 
Slideshow

Per salvare la presentazione in 
formato PDF si utilizza il comando 
dal menu Slideshow > Export 
Slideshow dal quale si può de-
terminare:
- la dimensione (Width/Height) e 
la compressione (Quality) dei file 
in formato JPG incorporati nella 
presentazione;
- la dimensione della presentazio-
ne (Common sizes);
- il lancio automatico della pre-
sentazione a pieno schermo (Au-
tomatically show full screen).

At tualmente non è possibi le 
esportare la presentazione in altri 
formati di salvataggio.

Il Pannello OVERLAYS

Questo Pannello permette di apporre 

alla presentazione alcuni elementi grafici 

o testuali che ne personalizzano l’aspet-

to.

L’opzione Identity Plate consente di 

inserire un elemento grafico, come ad 

esempio il proprio nome, il nome del 

cliente, del progetto o anche un marchio 

su ogni slide. Per personalizzarlo basta 

fare clic sul preview rettangolare a scac-

chiera e scegliere dal menu a comparsa 

la voce Edit. L’opzione Override Color 

consente di impostare un altro colore 

per il marchio, indipendentemente dal 

suo colore originale.

I cursori Opacity e Scale regolano 

rispettivamente l’opacità e la dimensione 

dell’Identity Plate.

L’opzione Place behind image posi-

ziona la scritta sotto l’immagine. 

Per personalizzare la posizione di 

questo elemento basta spostarsi con il 

cursore sull’anteprima centrale e trasci-

narlo con il mouse: un tutore calamitato 

calamitato ne aiuta il posizionamento 

agganciandosi ai vari elementi della pa-
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gina.

L’opzione Rating Stars fa comparire 

sullo Slideshow le stelle associate alle 

singole immagini e consente di determi-

narne colore, opacità e dimensione.

Le opzioni Text Overlays e Shadow 

consentono di formattare e inserire 

un’ombra sul testo applicato alla presen-

tazione con lo strumento ABC disponibi-

le sulla Barra degli Strumenti.

Come si inserisce una dida-
scalia personalizzata?

Nella Barra degli Strumenti è pre-
sente il comando ABC che per-
mette di inserire testi personalizza-
ti.

Per inserire un testo che deve ap-
parire in ogni slide basta digitarlo 
nell’apposito campo di testo.
Per formattarlo si possono utilizza-
re le opzioni del gruppo Text 
Overlays e Shadow disponibili nel 
Pannello Overlays.
Per ruotarlo si utilizzano le frecce 
poste sulla barra degli strumenti.

Per inserire metadati specifici di 
ogni immagine scegliere una delle 
opzioni del menu dedicato Cu-
stom Text.

Per inserire un testo o una dida-
scalia specifica per ogni slide uti-
lizzare il comando del menu a 
comparsa Custom Text > Edit. Ad 
esempio, se si vuole inserire un 
titolo ad ogni immagine è suffi-
ciente compilare il campo Title nei 
dati IPTC nel Pannello Metadata 
del Modulo Library.

Il Pannello BACKDROP

Il Pannello Backdrop consente di 

personalizzare lo sfondo delle slide con 

una sfumatura (Color Wash), un colore 

uniforme (Background Color) o un’im-

magine di sfondo (Background Image), 

trascinandola dal Filmstrip sull’antepri-

ma.

Il Pannello PLAYBACK

Dal Pannello Playback è possibile 

scegliere la musica da associare alla 

presentazione (Soundtrack), la durata 

della persistenza delle immagini (Slides) 

e il tempo della loro dissolvenza  (Fa-

des).

Inoltre si può sfruttare l’opzione 

Random Order per visualizzare le foto in 

ordine causale.

Attualmente le presentazioni espor-

tate in PDF non incorporano la musica 

associata alla presentazione.

Lo Slideshow può essere visualizza-

to con la musica solo utilizzando il pul-

sante Play posto in fondo ai Pannelli di 

destra.

Come si avvia lo Slideshow 
dagli altri moduli?

Da ogni modulo è possibile avvia-
re uno Slideshow a pieno scher-
mo, chiamato Impromptu Sli-
deshow.
Per avviarlo basta premere CTRL 
+ Enter (Comando + Enter su 
Mac) oppure si può utilizzare il 
comando del menu Window > 
Impromptu > Slideshow.
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IL MODULO PRINT 
STAMPARE SEMPLICEMENTE

E’ veloce, facile ed estremamente visuale, per questo il Modulo 
Print rappresenta attualmente una delle soluzioni più valide per 
una gestione rapida ma precisa della stampa fotografica: dall’im-
postazione del layout di pagina fino alla gestione del colore.

Nel Modulo Print è possibile eseguire le seguenti operazioni:
• Impaginare migliaia di foto e provini in pochissimo tempo;
• Aggiungere testi e informazioni alle immagini, come ad esem-
pio didascalie e metadati;
• Creare e salvare layout di stampa personalizzati in modo da 
poterli riapplicare anche successivamente;
• Stampare le immagini con una stampante collegata o esportare 
un file in formato PDF con le foto impaginate.

IN QUESTO CAPITOLO:

I PANNELLI DEL MODULO PRINT 

• I Pannelli Preview e Template Browser
• Il Pannello Image Settings
• Il Pannello Layout
• Il Pannello Overlays
• Il Pannello Print Job
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*Il tasto CTRL su Windows equivale al tasto 

Comando su Mac.

Come si esportano i fogli  
impaginati in modo da 
stamparli con dispositivi non 
collegati al proprio compu-
ter?

Coloro che hanno installato sul 
proprio computer Acrobat Profes-
sional e tutti gli utenti Mac posso-
no esportare i fogli di stampa in 
formato PDF per poter stampare 
le immagini anche con altri dispo-
sitivi, ad esempio inviandoli ad un 
service esterno.
Gli utenti Mac possono inoltre 
esportare i propri fogli di stampa 
anche in altri formati (ad esempio 
.JPG) utilizzando la seguente pro-
cedura : Print > Preview > Archi-
vio > Registra col nome.

I Pannelli del 

Modulo Print

Così come nel Modulo Slideshow 

anche nel Modulo Print i Pannelli posti 

sulla sinistra sono destinati all’applica-

zione di layout predefiniti (Template) o al 

salvataggio di nuovi Template persona-

lizzati.

I Pannelli posti invece sulla destra 

offrono controlli manuali per modificare il 

layout, aggiungere testi, informazioni 

sugli scatti, scegliere il dispositivo di 

output e le opzioni legate alla gestione 

del colore.

Le frecce poste sulla sinistra sotto 

l’anteprima centrale offrono invece una 

rapida vista d’insieme delle stampe. La 

scritta Page 1 of ... segnala il numero 

totale di pagine che andranno in stampa 

in base al numero di file selezionati e al 

Template Browser impostato.

L’anteprima centrale è completa-

mente interattiva. Per personalizzare 

l’impaginazione basta infatti fare clic sui 

bordi della cella trascinandoli. Per cen-

trare un’immagine nello spazio di ritaglio 

basta invece fare clic direttamente sul-

l’immagine, il cursore si trasforma in una 

mano, come quando si preme la barra 

spaziatrice in Adobe Photoshop.

Una volta pronta l’anteprima si pos-

sono impostare le opzioni della stam-

pante dal menu Print Setting o avviare 

la stampa con il pulsante Print.

Gli utenti Mac o coloro che hanno 

installato sul proprio computer Acrobat 

Professional possono anche esportare i 

fogli di stampa in formato PDF per poter 

stampare le immagini anche con altri 

dispositivi.

Come si determina il forma-
to di pagina?

Per impostare il formato di pagina 
e molte altre opzioni di stampa si 
utilizza il pulsante Page Setup 
posto in basso sulla destra, sotto 
l’anteprima.

I Pannelli PREVIEW e 

TEMPLATE BROWSER

I Pannelli Preview e Template Brow-

ser funzionano in modo analogo a quelli 

già descritti nel Modulo Slideshow.

Così come negli altri Moduli, anche 

qui i Templates a disposizione sono vari 

e personalizzabili. Le performance del 

programma sono ancora una volta en-

comiabili: selezionando migliaia di file 

simultaneamente Photoshop Lightroom 

è in grado di generare, in tempo reale, 

un’anteprima di stampa di centinaia o 

migliaia di immagini!
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SCORCIATOIE DA TASTIERA:

Attualmente le scorciatoie da tastiera di 
Photoshop Lightroom non sono personaliz-
zabili.
Molti tasti di questo software supportano il 
long press behavior: tenendoli premuti 
prolungatamente si attiva la funzione loro 
associata per poi disattivarsi non appena si 
rilascia il pulsante. Nella modalità di visua-
lizzazione provvisoria è comunque possibile 
lavorare usando il mouse normalmente.

COMANDO* 
+ P

Equivale al comando 
Print.

COMANDO* 
+ SHIFT + 
P

Equivale al comando 
Page Setup.

COMANDO* 
+ SHIFT + 
H

Mostra le Guides.

COMANDO* 
+ SHIFT + 
T

Mostra le Cells.
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Il Pannello IMAGE SETTINGS

Il Pannello Image Settings consente 

di impostare alcune opzioni legate al 

tagl io del l ’ immagine (Zoom to Fil l 

Frame), alla rotazione automatica (Auto 

- Rotate to Fit), alla stampa di diverse 

copie della stessa foto sullo stesso fo-

glio (Repeat One Photo per Page) e al 

bordo delle foto (Stroke Border).

 

Come si personalizza il nu-
mero e la sequenza delle 
immagini?

In modo analogo a quanto già 
visto nel modulo Slideshow, per 
personalizzare l’ordine delle im-
magini trascinandole è necessario 
che le foto facciano parte della 
Quick Collection o di una Collec-
tion.

Se si desidera stampare solo al-
cune foto invece vanno seleziona-
te dal Filmstrip.

Il Pannello LAYOUT

Questo Pannello offre tutti gli stru-

menti necessari per personalizzare il 

layout di stampa: margini (Margins), 

righe e colonne (Grid), spaziatura tra le 

celle (Cell Spacing), dimensione delle 

celle (Cell Size), forma quadrata delle 

celle (Keep Square) visualizzazione del-

le guide (Show Guides). Queste ultime 

naturalmente non vengono mai stampa-

te, ma servono solo da riferimento du-

rante la preparazione del layout.

Molte delle operazioni eseguibili con 

i cursori possono essere svolte diretta-

mente sull’anteprima centrale di stampa 

completamente interattiva. 

Il Pannello OVERLAYS

Questo Pannello, in modo simile a 

quello del Modulo Slideshow, consente 

l’inserimento di elementi grafici o testuali 

da aggiungere alle immagini. Oltre alla 

funzione Identity Plate è possibile ag-

giungere utili informazioni sulla pagina 

(Page Options) quali la numerazione 

delle pagine (Page Number), alcune 

informazioni a fondo pagina relative alle 

opzioni di output (Page Info) e i segni di 

taglio (Crop Marks). 

Inoltre è possibile inserire dettagliate 

informazioni testuali selezionandole dal 

menu Photo Info. Questo tipo di dati 

risultano particolarmente preziosi quan-

do si stampano provini a contatto o fogli 

di archivio. Font Size determina infine la 

grandezza della font.
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Come si applica il proprio 
marchio sopra ad ogni im-
magine?

Per evitare che le proprie immagi-
ni vengano utilizzate in modo 
improprio o senza autorizzazione 
può essere buona norma porre il 
proprio nome e il copyright su 
ogni provino. E’ sufficiente attivare 
l ’opzione Render on every 
image presente nel Pannello 
Overlays tra le opzioni dedicate 
alla funzione Identity Plate.

Per ruotare la scritta si può utiliz-
zare il menu -90° in alto a destra, 
nello stesso pannello.

La risoluzione dell’Identity 
Plate

Se nell’Identity Plate si seleziona 
l’opzione Use a styled text Identity 
Plate la scritta può essere stampa-
ta con qualsiasi risoluzione o for-
mato di stampa selezionati dal 
Modulo Print.

Il Pannello PRINT JOB

Questo Pannello consente di con-

trollare le opzioni di output.

Draft Mode Printing è un’opzione 

molto utile che permette di rasterizzare i 

file per la stampa utilizzando l’anteprima 

ad alta risoluzione generata da Photos-

hop Lightroom (anziché il file originale). 

A dispetto del suo nome questa opzione 

non inficia la qualità finale della stampa 

(se si rimane entro dimensioni di stampa 

contenute), ma accorcia in modo im-

pressionante i tempi di elaborazione 

della stampa.

Print Resolution consente di speci-

ficare la risoluzione di stampa.

Print Sharpening applica una ma-

schera di contrasto con 3 diversi livelli di 

intensità.

Color Management consente di 

specificare il profilo della stampante 

(Profile) e l’intento di rendering (Rende-

ring Intent). Dal menu Profile selezio-

nando Other compare una lista comple-

ta dei profili di stampa installati nel pro-

prio computer. I profili dei quali si è 

spuntata la casellina saranno sempre 

disponibili come voci del menu a com-

parsa Profile. 

Salvando queste impostazioni in un 

nuovo Template Browser non sarà ne-

cessario riconfigurarle ad ogni nuovo 

progetto.

Come si installa un Profilo 
Colore?

Per gli utenti Windows

Fare clic con il tasto destro sul 
profilo e scegliere Installa Profilo.

Oppure copiare i profili in:
WINDOWS\system32\spool\dri-
vers\color (Windows XP).

Per gli utenti Mac

Copiare i profili in:
/Libreria/Colorsync/Profiles 

oppure in:
/Utente/Libreria/Colorsync/Profi-
les.

Dopo aver installato profili colore 
è necessario riavviare le applica-
zioni Adobe.
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IL MODULO WEB 

CREARE ELEGANTI FOTOGALLERY DA PUBBLICARE SU INTERNET

Il Modulo Web chiude in bellezza il flusso di lavoro fotografico con-
sentendo di pubblicare su Internet, con pochi clic, una accattivante 
galleria delle foto appena selezionate e/o elaborate.
Questo Modulo può essere utilizzato per creare gallerie dove 
promuovere i propri lavori, ma soprattutto è particolarmente 
utile per fare in modo che i propri clienti possano consultare i 
provini, o anche il lavoro finito, comodamente dal proprio com-
puter collegandosi ad Internet.

Nel Modulo Web è possibile eseguire le seguenti operazioni:
• Creare velocemente photogallery in HTML o animate in FLASH 
scegliendo uno gli accattivanti Tamplate forniti con il programma;
• Creare e salvare Tamplates personalizzandone il layout, i colori 
e i testi;
• Aggiungere testi e informazioni alle immagini, come ad esem-
pio didascalie e metadati;
• Fare l’upload delle proprie fotogallery direttamente da Photoshop 
Lightroom senza alcuna necessità di utilizzare software specifici;
• Esportare la propria fotogallery per masterizzarla su un CD, 
trsferirla in un altro computer o aprirla con un altro software.

IN QUESTO CAPITOLO:

I PANNELLI DEL MODULO WEB 

• I Pannelli Preview e Template Browser
• Il Pannello Gallery Style
• Il Pannello Site Info
• Il Pannello Color Palette
• Il Pannello Appearance
• Il Pannello Image Info
• Il Pannello Output Settings
• Il Pannello Upload Settings
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*Il tasto CTRL su Windows equivale al tasto 

Comando su Mac. 

I Pannelli del 

Modulo Web

I Pannelli PREVIEW e 

TEMPLATE BROWSER

Lo scopo e il funzionamento di que-

sti due Pannelli è analogo a quello già 

descritto nei Moduli Slideshow e Print.

Il ricco gruppo di Templates predefi-

niti, realizzati in FLASH o in HTML offro-

no grande libertà di utilizzo per le inten-

zioni e gli stili più diversi: dal classico, al 

minimalista, dal creativo al rigoroso.

Il Pannello GALLERY STYLE

Il Pannello Gallery Style consente di 

selezionare i l Templates di base in 

FLASH o in HTML.

La scelta di uno di questi due Tem-

plates, particolarmente neutri, può esse-

re un’alternativa a quelli più creativi di-

sponibili nel Pannello di sinistra.

A seconda che la galleria sia in 

FLASH o in HTML si accede ad alcune 

funzioni specifiche.
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SCORCIATOIE DA TASTIERA:

Attualmente le scorciatoie da tastiera di 
Photoshop Lightroom non sono personaliz-
zabili.
Molti tasti di questo software supportano il 
long press behavior: tenendoli premuti 
prolungatamente si attiva la funzione loro 
associata per poi disattivarsi non appena si 
rilascia il pulsante. Nella modalità di visua-
lizzazione provvisoria è comunque possibile 
lavorare usando il mouse normalmente.

COMANDO* 
+ J

Equivale al comando 
Export.

COMANDO* 
+ R

Assegna la fotogalle-
ry con le nuove im-
postazioni.
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Il Pannello SITE INFO

Il Pannello Site Info consente di per-

sonalizzare il Template con informazioni 

testuali relative al nome del progetto, 

all’autore degli scatti, al sito Internet del 

fotografo e altri dati utili. Inoltre è possi-

bile inserire il proprio indirizzo e-mail per 

essere contattati direttamente dalle pa-

gine della galleria fotografica on-line.

Il Pannello COLOR PALETTE

Il Pannello Color Palette offre gli 

strumenti necessari a personalizzare i 

colori di ogni singolo elemento dell’inter-

faccia per armonizzare i colori con lo 

stile delle immagini o del proprio mar-

chio.

[66]
Testi e immagini: © Marianna Santoni - www.mariannasantoni.biz

http://www.mariannasantoni.biz
http://www.mariannasantoni.biz


Il Pannello APPEARANCE

Il Pannello Appearance consente di 

personalizzare il layout della pagina e il 

l’aspetto dei suoi elementi.

APPEARANCE 

relativo ai Templates in HTML

Le opzioni Common Settings con-

sentono di inserire un’ombra alle celle 

delle immagini (Add Drop Shadow to 

Photos) e un sottile bordo sotto il titolo 

del sito (Section Borders).

Nella sezione Grid Pages si stabili-

sce il numero di miniature da visualizza-

re in una singola pagina, con la possibili-

tà di numerare le singole celle (Show 

Cell Numbers) e di personalizzare il co-

lore del bordo delle immagini (Photo 

Borders).

Con il cursore Image Pages è pos-

sibile specificare la dimensione in pixel 

del lato più lungo delle immagini.

APPEARANCE 

relativo ai Templates in FLASH

Il menu a comparsa Layout permet-

te di scegliere tra 4 diversi tipi di layout 

(vd. fig. pagina precedente).

La funzione Identity Plate è analoga 

a quella già illustrata nei Moduli Sli-

deshow e Print.

L e o p z i o n i L a r g e I m a g e s e 

Thumbnail Images consentono di spe-

cificare le dimensioni dell’immagine  

grande e quelle della miniatura.
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Il Pannello IMAGE INFO

Il Pannello Image Info consente di 

specificare alcuni dati da visualizzare 

sotto l’immagine, come ad esempio il 

nome del file o i dati IPTC, in modo da 

facilitarne l’identificazione, soprattutto 

nel caso di provini a contatto.

Il Pannello OUTPUT SETTINGS

Le funzioni del Pannello Output Set-

tings sono utili in tutti quei casi in cui si de-

sidera che la galleria fotografica si carichi 

velocemente e quando si devono proteg-

gere le immagini da possibili utilizzi non 

autorizzati. 

Il cursore Quality serve a determinare 

il grado di compressione dei file in formato 

JPG, inseriti nella photogallery.

L’opzione Metadata consente invece 

di scegliere se pubblicare le immagini cor-

redate di tutti i metadati (All) o si desidera 

cancellarli tutti lasciando solo l’informazione 

relativa al copyright (Copyright Only).

La funzione Add Copyright Water-

mark scrive direttamente sulle immagini le 

informazioni relative al metadato Copyright.

Il Pannello UPLOAD SETTINGS

Questo Pannello serve ad inserire i dati 

FTP del proprio web server per poter ese-

guire il caricamento on line delle photogal-

lery appena realizzate, senza alcuna ne-

cessità di aprire un software dedicato alla 

creazione o all’upload di pagine web. Nella 

casella di testo Put in Subfolder si specifica 

l’indirizzo Internet nel quale saranno visibili 

le immagini.

Una volta impostati tutti i parametri la 

funzione si avvia facendo clic sul pulsante 

Upload.

Se si desidera invece esportare la gal-

leria di immagini per poterla trasferire in un 

altro computer, aprirla con un altro software 

o masterizzarla in un CD si può utilizzare il 

Pulsante Export.
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